Dyalog for Microsoft Windows
Ul Guide

Dyalog version 16.0

JYALOG

The tool of thought for software solutions



Dyalog is a trademark of Dyalog Limited

Copyright © 1982-2017 by Dyalog Limited

All rights reserved.

Version: 16.0

Revision: 2972 dated 20230217

Please note that unless otherwise stated, all the examples in this document assume that[JIOis 1, and ML is 1.

No part of this publication may be reproduced in any form by any means without the prior written

permission of Dyalog Limited.

Dyalog Limited makes no representations or warranties with respect to the contents hereof and
specifically disclaims any implied warranties of merchantability or fitness for any particular purpose.

Dyalog Limited reserves the right to revise this publication without notification.

email: support@dyalog.com
http://www.dyalog.com

TRADEMARKS:

SQAPL is copyright of Insight Systems ApsS.

UNIX is a registered trademark of The Open Group.

Windows, Windows Vista, Visual Basic and Excel are trademarks of Microsoft Corporation.
Oracle and Java are registered trademarks of Oracle and/or its affiliates.

macOS®, Mac OS® and OS X® (operating system software) are trademarks of Apple Inc., registered in

the U.S. and other countries.
Array Editor is copyright of davidliebtag.com

All other trademarks and copyrights are acknowledged.



Contents

Chapter1: The APLEnvironment .. . 1
IntroduCtion ... 1
APL Keyboards ... ... .. 1
Session Manager - .. ...l 3
Unicode Edition Keyboard . ... .. . .. 6
Classic Edition Keyboard .. ... .. 10
Keyboard ShortCuts . ... ... . 10
The Session Colour Scheme . ... ... il 16
The Session Window ... il 18
Entering and Executing EXpressions ... ... 25
ValUe TIPS - oL 29
Array Editor .. 35
The Session GUI Hierarchy ... ... . . i 38
The Session MenuBar .. il 39
Session Pop-Up Menu ... il 53
The Session Toolbars ... ... . 56
The Session Status Bar .. ... 61
Status WindoOW i 63
The Workspace Explorer Tool ..l 64
Browsing Classes . ... ool 74
Browsing Type Libraries ... ... ... .. 79
Browsing NET Classes .. ... ... 90
Find Objects Tool ...l 98
Object Properties Dialog Box .. ... .. . .. 102
The EditOr 107
Editing Scripts and Text Files ... ... ... ... 141
The TraCer il 145
The Threads Tool ... ... e 157
Debugging Threads .. ... ... . 161
The Event Viewer .. ... o . 165
The Session ObJeCt ... 172

AT F X . 177

| 178

Format il 179

SesSION PIINt il 180

WorkspaceLoaded ... ... . 181
Configuring the Session ... ... ... . 182
User Commands ... ... ..o 187
File Explorer Integration ... ... . 188






Chapter 1: The APL Environment

Chapter 1:

The APL Environment

Introduction

The Dyalog APL Development Environment includes a Session Manager, an Editor,
and a Tracer all of which operate in windows on the screen. The session window is
created when you start APL and is present until you terminate your APL session. In
addition there may be a number of edit and/or trace Windows, which are created and
destroyed dynamically as required. All APL windows are under the control of
Windows and may be selected, moved, resized, maximised and minimised using the
standard facilities that Windows provides.

APL Keyboards

The Classic and Unicode Editions of Dyalog APL for Windows use different
techniques for mapping keystrokes to APL characters and to special command
shortcuts.

The Classic Edition uses a proprietary technique for these mappings. The Unicode
Edition uses Microsoft's IME (Input Method Editor) technology. Many other
applications use the same technology, which means that the Dyalog Unicode IME
may be used not only with Dyalog APL for Windows Unicode Edition, but also with
word processing applications, spreadsheets, terminal emulators etc. Therefore with
the Dyalog Unicode IME installed, and with a suitable font selected, APL characters
can be entered and viewed in many other applications.

In both Classic and Unicode Editions APL characters are generated when the user
presses certain combinations of meta keys in conjunction with the normal character
keys. Meta keys include Shift, Ctrl and Alt.

For both input techniques it is possible to alter the mapping of keystrokes to APL
characters, and to add support for new languages. It is also possible to alter the
keystrokes which define special command keyboard shortcuts. For further details, see
Unicode Edition Keyboard on page 6 or Classic Edition Keyboard on page 10




Chapter 1: The APL Environment

Unicode Edition and the Dyalog Unicode IME

The Dyalog Unicode IME is the input mechanism for generating APL characters for
Unicode editions of Dyalog APL. The version of the IME supplied with version 16.0
can be used with version 12.1 and later, provided that they are patched to a version
created on or after 15t April 2011.

The Dyalog Unicode IME defines the mapping of keystrokes to Unicode characters.
Only keystrokes which resolve to characters that either do not appear on the standard
keyboard or which differ from those that appear on the standard keyboard are
included in the selectable translate table. In effect the Dyalog Unicode IME can be
regarded as an overlay of the standard keyboard which contains just APL characters.

The Dyalog Unicode IME supplied with Version 16.0 includes support for Belgian,
Danish, Finnish, French, German, Italian, Spanish Swedish and British and American
English keyboards, based on the Dyalog hardware keyboard layout; these keyboard
layouts are described at http://dfns.dyalog.com/n_keyboards.htm. Note that for
Danish, British and American English keyboards the older layouts, based on the
Dyalog APL Ctrl Keyboard, are included in the UnicodeIME\aplkeys directory.

The default keyboard mapping for unsupported languages is American English.

The IME translate tables include mappings for the special command keystrokes used
by Dyalog APL.

These command keystroke mappings are ignored by applications unless the
application is explicitly named in the Dyalog Unicode IME configuration. It is
expected that only terminal emulators used for running UNIX-based versions of
Dyalog APL will use this feature.

In particular, Dyalog APL for Windows Unicode Edition does not use the mappings
in the translate tables; the mappings are defined under Options/Configure/Keyboard
Shortcuts (see Installation & Configuration Guide: Configuration Dialog:
Keyboard Shortcut Tab).

Note that the Dyalog Unicode IME replaces any previous IME, as well as the Dyalog
Ctrl and Dyalog AltGr keyboards.

Classic Edition

The mapping for each of the [JAV positions and its associated keystroke is defined by
a selectable translate table. JAV includes all the APL symbols used by Dyalog APL
as well as all the (non-APL) characters which appear on a standard keyboard. This
mapping only works with Classic Edition.

The Classic Edition installation also includes the Dyalog Unicode IME (described
below) so that users may enter APL characters into other applications; the Dyalog
Unicode IME is however not used by the Classic Edition itself.
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The Classic Edition includes support for Danish, Finnish, French, German, Italian,
Swedish, and both British and American English keyboards. The default keyboard
mapping for unsupported languages is American English.

Session Manager

The Dyalog APL/W session is fully configurable. Not only can you change the
appearance of the menus, tool bars and status bars, but you can add new objects of
your choice and attach your own APL functions and expressions to them. Functions
and variables can be stored in the session namespace. This is independent of the
active workspace; so there is no conflict with workspace names, and your utilities
remain permanently accessible for the duration of the session. Finally, you may set up
different session configurations for different purposes which can be saved and loaded
as required.

The session window is defined by an object called SE. This is very similar to a
Form object, but has certain special properties. The menu bar, tool bar and status bars
on the session window are in fact MenuBar, ToolControl and StatusBar objects
owned by [OSE. All of the other components such as menu items and tool buttons are
also standard GUI objects. You may use [JWC to create new session objects and you
may use OWS to change the properties of existing ones. WG and OWN may also be
used with [JSE and its children.
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Components of the session that perform actions (Menultem and Button objects) do so
because their Event properties are defined to execute system operations or APL
expressions. System operations comprise a pre-defined set of actions that can be
performed by Dyalog APL/W. These are coded as keywords within square brackets.
For example, the system operation [WSClear ] producesa clear ws, after first
displaying a dialog box for confirmation. You may customise your session by adding
or deleting objects and by attaching system operations or APL expressions to them.

Like any other object, [SE is a namespace that may contain functions and variables.
Furthermore, JSE is independent of the active workspace and is unaffected by

)LOAD and ) CLEAR. It is therefore sensible to store commonly used utilities,
particularly those utilities that are invoked by events on session objects, in JSE
itself, rather than in each of your application workspaces.

The possibility of configuring your APL session so extensively leads to the
requirement to have different sessions for different purposes. To meet this need,
sessions are stored in special files with a .DSE (Dyalog Session) extension. The
default session (i.e. the one loaded when you start APL) is specified by the session_
file parameter. Y ou may customise this session and then save it over the default one
orin a separate file. You can load a new session from file at any stage without
affecting your active workspace.

Positioning the Cursor

The cursor may be positioned within the current APL window by moving the mouse
pointer to the desired location and then clicking the Left Button. The APL cursor
will then move to the character under the pointer.

Selection

Dragging the mouse selects the text from the point where the mouse button is
depressed to the point where the button is released. When you select multiple lines,
the use of the left mouse button always selects text from the start of the line. A
contiguous block of text can be selected by dragging with the right mouse button.

Double-clicking the left mouse button to the left of a line selects the whole line,
including the end-of-line character.

Scrolling

Data can be scrolled in a window using the mouse in conjunction with the scrollbar.
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Invoking the Editor

The Editor can be invoked by placing the mouse pointer over the name of an editable
object and double-clicking the left button on the mouse. If you double-click on the
empty Input Line it acts as "Naked Edit" and opens an edit window for the suspended
function (if any) on the APL stack. For further details, see Invoking the Editor on
page 107. See also "Installation and Configuration Guide: DoubleClickEdit".

The Current Object

If you position the input cursor over the name of an object in the session window,
that object becomes the current object. This name is stored in the CurObj property of
the Session object and may be used by an application or a utility program. This
means that you can click the mouse over a name and then select a menu item or click
a button that executes code that accesses the name.

The Session Pop-up Menu

Clicking the right mouse button brings up the Session pop-up menu. This is
described later in this chapter.

Drag-and-Drop Editing

Drag-and-Drop editing is the easiest way to move or copy a selection a short distance
within an edit window or between edit windows.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse
button. When the drag-and-drop pointer appears, drag the cursor to a new
location.

3. Release the mouse button to drop the text into place.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

If you drag-and-drop text within the Session window, the text is copied and not
moved whether or not you use the Ctrl key.
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Interrupts

To generate an interrupt, click on the Dyalog APL icon in the Windows System
Tray; then choose Weak Interrupt or Strong Interrupt. To close the menu, click
Cancel. Altematively, to generate a weak interrupt, press Ctrl+Break, or select
Interrupt from the Action menu on the Session Window.

Unicode Edition Keybhoard

Introduction

Unicode Edition supports the use of standard Windows keyboards that have the
additional capability to generate APL characters when the user presses Ctrl, Alt,
AltGr (or some other combination of meta keys) in combination with the normal
character keys.

Dyalog APL is supplied with the Dyalog Unicode IME keyboard for a range of
different languages as listed below. The intention is that only APL characters and
characters that appear in locations different from the underlying keyboard are
defined; any other keystroke is passed through as is.

Installation

During the Installation of Dyalog APL Unicode Edition, setup installs the Dyalog
Unicode IME (IME). For any given Input Language the IME consists of an additional
service for that Input Language, and a translate table which maps keystrokes for the
appropriate keyboard to Unicode code points for APL characters

An IME service is installed for every Input Language that the user who installs
Dyalog APL has defined, as well as every Input Language for which Dyalog has
support.

The keyboard mappings are defined for the following national languages: Belgian,
Danish, Finnish, French, German, Italian, Spanish, Swedish and British and American
English

These mappings are described at http://dfns.dyalog.com/n_keyboards.htm.

For any other Input Language the American English translate table is selected. Note
that some Input Languages are defined to be substitutes for other Input Languages;
for example Australian English Input is a substitute for American English Input,
Austrian German Input a substitute for German German Input. In these cases the IME
will install the appropriate translate table. It is also possible to create support for new
languages or to modify the existing support. See the IME User Guide for further
details.
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Configuring the Dyalog APL IME

The Dyalog Unicode IME is added as an additional service to all keyboards defined
to the user and the administrator at the time that the IME was installed.

For each IME the underlying keyboard layout file will be the same as that defined for
the base keyboard. The layout file is a DLL created by Microsoft.

The language specified in the description of the IME is the name of the IME translate
table that has been associated with the IME for the specific keyboard. In the case of
languages not supported by the IME the keyboard will default to en-US.

IME Properties

To change the properties of the IME go to Options/Configure/Unicode Input tab and
select Configure Layout:

Session Log Trace/Edit Auto Cemplete SALT User Cernmands Object Syntax
General  Unicodelnput  Keyboard Shortcuts  Saved Responses  Workspace  Help / DMX  Windows

Dyalog can automatically load your selected keyboard when the session window is made visible:

Activate selected keyboard |:| Show keyboards for all languag
Keyboard:

| Dyalog APLIME (en-GB) X v
Configure Layout...

Cancel
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General  About

|nput Translate Table:

I:Z:"-.F'n:u:lrarn FileshDyalogh)nicodel ME \aplkeyvshen-GE. din Browse. .

Idze Chilx, C W for clipboard
Enable Overstrikes
[] Overstiikes do ot require the '05" intraducer key

[]Uze Overstrike popup

Cancel Apply

Input translate table:

The translate table defines the mapping between APL characters and the keystrokes
that generate those APL characters. It is possible to alter the mapping or to create
support for new keyboards by altering the translate table, or by selecting a different
translate table. See the IME User Guide for more details.

Overstrikes:

In the original implementations of APL, many of the special symbols could only be
generated by overstriking one character on top of another as is reflected in the
appearance ofthe glyphs. For example, the symbol for Grade Up (4) is actually the
symbol for delta (A) superimposed on the symbol for vertical bar (|)

In Dyalog APL such symbols can be generated either by a single keystroke, or (in
Replace mode) by overtyping one symbol with another. For example A may be
generated using Shift+Ctrl+4, or by switching to Replace mode and typing the three
keystrokes Ctrl+h, Left-Cursor, Ctrl+m.

Using the Dyalog Unicode IME the character can also be entered by pressing
Ctrl+Bksp, Ctrl+m, Ctrl+h. Note that Ctrl+Bksp is the default Overstrike Introducer
Key (key code OS).
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Use Overstrike popup:

With this option selected, when the character following the Overstrike Introducer
Key is pressed, a popup box displays all the overstrikes which contain the last
character typed: in the example below Ctrl+Bksp has been followed by Ctrl+h:

. CLEAR WS - Dyalog APL/W-64

File Edit View Windows Session Leog Action Options Tools Threads

Help

W5 % @ W % | Object (] g1 & 7 &[4 Tool  Edit |~ Session

Language Bar o x
|

l|||||IIEII|||IIIFILII|||||||||||¥||||||||||ﬁuJ

Editor

DEbUggEF ] El_| E =
Ready... Ins NUM

CurObj: A (U &:1 Oog:0  0OTRAP [0OSI:0 [OI0:=1 [OML:1

Note the fine (red) line under the A in the Session window. This indicates that an
overstrike creation operation is in progress.

The input of the symbol A can be completed by pressing Ctrl+m, or by moving the
selection up and down the pop-up list using Cursor-Up or Cursor-Down.

Overstrikes do not require the OS introducer key:

With this option selected, the IME identifies characters which are part of a valid
overstrike, and when such a character is entered into the session, begins an overstrike
creation operation.



Chapter 1: The APL Environment 10

Classic Edition Keyboard

The standard Classic Edition keyboard tables are files supplied in the aplkeys sub-
directory named cc.din where cc is the standard 2-character country code, e.g.
uk.din.

Note that the standard tables do not support the entry of APL underscored characters
AABCDEFGHIJKLMNOPQRSTUVWXYZ.

The standard table supports two modes of use; traditional (mode 0) and unified
(mode 1). The keyboard starts in mode 1 and may be switched between modes by
clicking the Uni/Apl field in the status bar or by keying * on the Numeric-Keypad.

The Classic Edition keyboard layout is close to that of the Unicode Edition, but does
not include certain symbols which are only provided in the Unicode Edition.

Keyboard Shortcuts

The terms keyboard shortcut (Unicode Edition) and command (Classic Edition) are
used herein to describe a keystroke that generates an action, rather than one that
produces a symbol.

Unicode Edition

Unicode Edition provides a number of shortcut keys that may be used to perform
actions. For compatibility with Classic Edition and with previous Versions of
Dyalog APL, these are identified by 2-character codes; for example the action to start
the Tracer is identified by the code <TC>, and mapped to user-configurable
keystrokes.

In the Unicode Edition, Keyboard Shortcuts are defined using
Options/Configure/Keyboard Shortcuts and stored in the Windows Registry. Note
that the Unicode IME translate tables have definitions for the Keyboard Shortcuts
too; these are ignored by the interpreter, and are intended for use with terminal
emulators being used in conjunction with non-GUI versions of Dyalog APL.

To the right of the last symbol in the Language Bar is the Keyboard Shortcut icon

=1y you hover the mouse over this icon, a pop-up tip is displayed to remind you of
your keyboard shortcuts as illustrated below.
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File Edit View Windows
WS B = W
Language Bar - -

Session Log  Action

Object (11 &) i # 8t (&

Options

Tools Threads
Tool P 5

Help

D F &9 @ Session

APL385 Unicode|

[ FERE

*

(SBR[ T (TP R

(L=l [

g

Dyslog APL/W-64 Version 15.0.27165

Serial No : 000042

olelsls] [T=+].]- 5] DOEER:] [o]e[ [ E'J

Unicode Edition O Keyboard Shortcuts
Beta release QT: Quit (and lose changes): Shift+Esc
Tue Apr 19 15:16:54% 2016 TB: Tab between windows: (Nene)
clear us BT: Back Tab between windows: (Nene)
I £P: Exit (and save changes): £sc
RS: Right Screen: (None)
LS: Left Screen: (None)
CT: Cut: (None)
CP: Copy: (None)
PT: Paste: (None)
RD: Reforma Num divide
DK: Delete Block: Control+Delete
FD: Forward or Redo: Control+Shift+Enter
8K: Backward or Undo: Control+Shift+Back
SC: Search: (None)
RP: Replace: (None)
Ni: Next: (None)
PV: Previous: (None)
ED: Edits Shift+Enter
TC: Trace: Control+Enter
FX: Fix the current function: (None)
LN: Toggle Line numbers: Num -
BH: Run to exit (in tracer): (None)
8P: Toggle breskpoint: (None)
RM: Resume execution (in tracer):  (None)
TL: Teggle localisation: Contrel+lp
UA: Undo all changes: (None)
AD: Add comments: (None)
DO: Del comments: (None)
Gl: Go to Line: (None)
Sa: Select all: (None)
RI: Snap window size: (None)
AC: Align Comments: (None)
Mh: Resume all threads (in tracer): (None)
OF: Open file in editor: (None)
SF: Save file in editor: (None)
SF: Save file "As” in editor: (None)
T0: Teggle outline: (None)
MO: Gote matching outline: (None)
Si: Fix script and exit editor: (Nene)
$2: Fix script but remsin in editor: (None) e
Debugger gox W
Resdy. .. Ins  NUM
CurObi: &:1  DOpQ:0 OTRAP [OsI:0 0Or0:1 [ML:t
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Classic Edition

Commands fall into four categories, namely cursor movement, selection, editing
directives and special operations, and are summarised in the following tables. The
input codes in the first column of the tables are the codes by which the commands are
identified in the Input Translate Table.

Table 1: Cursor Movement Commands

Input ..

Code Keystroke Description

LS Ctrl+PgUp Scrolls left by a page

RS Ctrl+PgDn Scrolls right by a page

uUsS PgUp Scrolls up by a page

DS PgDn Scrolls down by a page

LC Left Arrow Moves the cursor one character position to the left

RC Right Arrow Moves the cursor one character position to the
right

DC Down Arrow Moves t.he cursor to the currenF character position
on the line below the current line

uc Up Arrow Moves t.he cursor to the curren't character position
on the line above the current line

UL Ctrl-Home M'ove the cursor to the top-left position in the
window

DL Ctrl+End Move§ the cursor to the bottom-right position in
the window

RL End Moves the cursor to the end of the current line

L Home Moves the cursor to the beginning of the current
line

LW CtrltLeft Arrow Moves the cursor to the beginning of the word to
the left of the cursor

Ctrl+Right Moves the cursor to the end of the word to the
RW .
Arrow right of the cursor
TB Ctrl+Tab Switches to the next session/edit/trace window
BT Ctrl+Shift+Tab | Switches to the previous session/edit/trace window
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Table 2: Selection Commands

Input s
Code Keystroke Description
Le ShifttLeft Arrow Extends the selection one character position to
the left
Re Shift+Right Extends the selection one character position to
Arrow the right
L Ctrl+Shift+Left | Extends the selection to the beginning of the
W Arrow word to the left of the cursor
Ctrl+Shift+Right | Extends the selection to the end of the word to
Rw .
Arrow the right of the cursor
Uc Shift+Up Arrow Extf:r'lds the selec'tlon to the current chgracter
position on the line above the current line
De Shift+Down Extends the selection to the current character
Arrow position on the line below the current line
L Shift-Home Extends 'the selection to the beginning of the
current line
Rl ShifitEnd Extends the selection to the end of the current
line
Ul Ctrl-Shifi+ Home Extepds the §elect10n to the beginning of the first
line in the window
DI Ctrl-Shifi+End Extends the selection to the end of the last line in
the window
Us Shift+PgUp Extends the selection up by a page
Ds Shift+PgDn Extends the selection down by a page
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Table 3: Editing Directives

215;; Keystroke Description

DI Delete Deletes the selection

Ok [cutpue Dt st e Et
CT Shifi+Delete f:{leit;rtl)cz)\:;z the selection and copies it to the
CP Ctrl+Insert Copies the selection into the clipboard

FD Ctrl+Shifi+Enter | Reapplies the most recent undo operation
BK Ctrl+Shift+Bksp | Performs an undo operation
[t Come e oot e bt
OP Ctrl-Shifi+ Insert ir;ls:r(t:dailtgia(r)llllcl}lli)ne immediately after the current
HT Tab Indents text

TH Shift+Tab Removes indentation

RD Keypad-slash Reformats a function (editor only)

TL Ctrl+Alt+L Toggles localisation of the current name
GL Ctrl+Alt+G Go to [line]

AO Ctrl+Alt+, Add Comments

DO Ctrl+Alt+. Delete Comments

AC Align Comments
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Table 4: Special Operations

g‘(ﬁ;‘; Keystroke Description

IN Insert Insert on/off

LN Keypad-minus |Line numbers on/off
ER Enter Execute

ED Shift+Enter Edit

TC Ctrl+Enter Trace

EP Esc Exit

QT Shift+Esc Quit
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The Session Colour Scheme

Within the Development Environment, different colours are used to identify different
types of information. These colours are normally defined by registry entries and may
be changed using the Colour Configuration dialog box as described later in this
chapter.

In the Classic Edition, colours may alternatively be defined in the Output Translate
Table (normally WIN.DOT). This table recognises up to 256 foreground and 256
background colours which are referenced by colour indices 0-255. These colour
indices are mapped to physical colours in terms of their Red, Green and Blue
intensities (also 0-255). Foreground and background colours are specified
independently as Cnnn or Bnnn. For example, the following entry in the Output
Translate Table defines colour 250 to be red on magenta.

C250: 255 0 O + Red foreground
B250: 255 0 255 + Magenta background

The first table below shows the colours used for different session components. The
second table shows how different colours are used to identify different types of data
in edit windows.

Table 5: Default Colour Scheme - Session

Colour | Used for Default

249 Input and marked lines Red on White

250 Session log Black on White

252 Tracer : Suspended Function Yellow on Black

253 Tracer : Pendent Function Yellow on Dark Grey
245 Tracer : Current Line White on Red
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Table 6: Default Colour Scheme Edit windows

Colour |Array Type Editable |Default

236 Simple character matrix Yes Green on Black
239 Simple numeric No White on Dk Grey
241 Simple mixed No Cyan on Dk Grey
242 Character vector of vectors Yes Cyan on Black
243 Nested array No Cyan on Dk Grey
245 0OR object No White on Red

248 Function or Operator No White on Dk Cyan
254 Function or Operator Yes White on Blue

Syntax Colouring in the Session

As an adjunct to the overall Session Colour Scheme, you may choose to apply a

syntax colouring scheme to the current Session Input line(s). You may also extend

syntax colouring to previously entered input lines, although this only applies to

input lines in the current session; syntax colouring information is not remembered in

the Session Log.

Syntax colouring may be used to highlight the context of names and other elements

when the line was entered. For example, you can identify global names and local

names by allocating them different colours.

See Installation & Configuration Guide: Colour Selection Dialog for further details.
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The Session Window

The primary purpose of the session window is to provide a scrolling area within
which you may enter APL expressions and view results. This area is described as the
session log. Normally, the session window will have a menu bar at the top with a
tool bar below it. At the bottom of the session window is a status bar. However, these
components of the session may be extensively customised and, although this chapter
describes a typical session layout, your own session may look distinctly different. A
typical Session is illustrated below.

3 CLEARWS - Dyalog APL/W-64 - o x

File Edit View Windows Session Log Action Options Tools Threads Help

WS 9% Sl gl Ml %y | Object (1 5] @ FEIR | Tool P 1S @ Bt @ 2 9 @ | Session

Language Bar x | X

[ D[l slalel 2] [TFL[[r[=-] [els[<[-[zl=[¢] [F[] [f]¢==I00a]e] [e]u[le[ o[slelélele] 2} |-l%] DOEBIzle[s] [o]ni-julalv]a | 5
~

Dyalog APL/W-64 Version 15.0.27165
Serial No : 000042

Unicode Edition

Bets release

Tue Apr 19 15:36:42 2016

lclear ws

Editor

v
Debugger adx
Ins NUM

&:1 OpQ:0 QOTRAP [sI:0 [OI0:1 [OML:1

Ready...

CurObj:

A typical Session window

Window Management

When you start APL, the session is loaded from the file specified by the session_file
parameter. The position and size of the session window are defined by the Posn and
Size properties of the Session object JSE, which will be as they were when the
session file was last saved.

The name of the active workspace is shown in the title bar of the window, and
changes if you rename the workspace or ) LOAD another.

You can move, resize, minimise or maximise the Session Window using the standard
Windows facilities.
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In addition to the Session Window itself, there are various subsidiary windows
which are described later in the Chapter. In general, these subsidiary windows may
be docked inside the Session window, or may be stand-alone floating windows. You
may dock and undock these windows as required. The standard Session layout
illustrated above, contains docked Editor, Tracer and SIStack windows.

Note that the session window is only displayed when it is required, i.e. when APL
requests input from or output to the session. This means that end-user applications
that do not interact with the user through the session will not have an APL session
window.

Docking

Nearly all of the windows used in the Dyalog APL IDE may be docked in the
Session window or be stand-alone floating windows. When windows are docked in
the Session, the Session window is split into resizable panes, separated by splitters.
The following example, using the Status window, illustrates the principles involved.
(The use of the Status window is described later in this Chapter.)

To start with, the Status window is hidden. You may display it by selecting the
Status menu item from the Tools menu. It initially appears as a floating (undocked)
window as shown below.
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If you press the left mouse button down over the Status window title bar, and drag it,
you will find that when the mouse pointer is close to an edge of the Session window,

the drag rectangle indicates a docking zone as shown below. This indicates the
that the window will occupy if you now release the mouse button to dock it.
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The next picture shows the result of the docking operation. The Session window is
now split into 2 panes, with the Status window in the upper pane and the Session log
window in the lower pane. You can resize the panes by dragging with the mouse.

You will notice that a docked window has a title bar (in this case, the caption is
Status) and 3 buttons which are used to Minimise, Maximise and Close the docked
window.
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The next picture shows the result of minimising the Status window pane. All that
remains of it is its title bar. The Minimise button has changed to a Restore button,
which is used to restore the pane to its original size.
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You can pick up a docked window and then re-dock it along a different edge of the
Session as illustrated below.
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Docking the Status window along the left edge ofthe Session causes the Session
window to be split into two vertical panes. Notice how the title bar is now drawn
vertically.
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If you click the right mouse button over any window, its context menu is displayed.
Ifthe window is dockable, the context menu contains the following options:

Undock Undocks the docked window. The window is displayed at
whatever position and size it occupied prior to being docked
Hlde. Hides the title bar of the docked window
Caption
Specifies whether the window is currently dockable or is locked
Dockable | in its current state. You can use this to prevent the window from
being docked or undocked accidentally

The last picture shows the effect of using Hide Caption to remove the title bar. In this
state, you can resize the pane with the mouse, but the Minimise, Maximise and Close
buttons are not available. However, you can restore the object's title bar using its

context menu.
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Entering and Executing Expressions

Introduction

The session contains the input line and the session log. The input line is the last line
in the session, and is (normally) the line into which you type an expression to be
evaluated.

The session log is a history of previously entered expressions and the results they
produced.

Ifyou are using a log file, the Session log is loaded into memory when APL is started
from the file specified by the log_file parameter. When you close your APL session,
the Session log is written back out to the log file, replacing its previous contents.

In general you type an expression into the input line, then press Enter (ER) to run it.
After execution, the expression and any displayed results become part of the session
log.

You can move around in the session using the scrollbar, the cursor keys, and the
PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the
beginning of the top-line in the Log and Ctrl+End (DL) moves the cursor to the end
of'the last (i.e. the current) line in the session log. Home (LL) and End (RL) move the
cursor to the beginning and end respectively of the line containing the cursor.

Deleting Lines

Y ou may delete one or more lines from the Session using the DK command
(Ctrl+Delete). This action removes the current line or the selected block of lines from
the Session window and from the Session log. The removal is permanent and you
will be prompted to confirm:

Medify Session Log

This will permanently modify the session log
i l % Areyou sure you want to do this?
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Language Bar

The Language Bar is an optional window which is initially docked to the Session
Window, to make it easy to pick APL symbols without using the keyboard.

If you hover the mouse pointer over a symbol in the APL Language Bar, a pop-up tip
is displayed to remind you of'its usage. If you click on a symbol in the Language Bar,
that symbol is inserted at the cursor in the current line in the Session.
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As you start to enter characters in an APL expression, the Auto Complete suggestions
pop-up window (AC for short) offers you a choice based upon the characters you
have already entered and the current context.

For example, if you enter a [, AC displays a list of all the system functions and
variables. If you then enter the character r, the list shrinks to those system functions
and variables beginning with the letter r, namely Orefs,dr l,0rsi,anddrt L.
Instead of entering the remaining characters, you may select the appropriate choice in
the AC list. This is done by pressing the right cursor key.

If you begin to enter a name, AC will display a list of namespaces, variables,
functions, operators that are defined in the current namespace. If you are editing a
function, AC will also include names that are localised in the function header.

If the current space is a GUI namespace, the list will also include Properties, Events
and Methods exposed by that object.
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As an additional refinement, AC remembers a certain number of previous auto
complete operations, and uses this information to highlight the most recent choice
you made.

For example, suppose that you enter the two characters ) c. AC offers you )clear
thru' ) cs, and you choose ) cs from the list. The next time you enter the two
characters ) c, AC displays the same list of choices, but this time ) cs is pre-selected.

You can disable or customise Auto Completion from the Auto Complete page in the
Configuration dialog box which is described later in this chapter.

Executing an Expression

To execute an expression, you type it into the input line, then press Enter (ER).
Alternatively, you can select Execute from the Action menu. Following execution,
the expression and any displayed results become part of the session log.

Instead of entering a new expression in the input line, you can move back through
the session log and re-execute a previous expression (or line of a result) by simply
pointing at it with the cursor and pressing Enter. Alternatively, you can select
Execute from the Action menu. You may alter the line before executing it. If you do
so, it will be displayed using colour 249 (Red on White), the same as that used for the
input line. When you press Enter the new line is copied to the input line prior to
being executed. The original line is restored and redisplayed in the normal session
log colour 250 (Black on White).

An alternative way to retrieve a previously entered expression is to use
Ctrl+Shift+Bksp (BK) and Ctrl+Shift+Enter (FD). These commands cycle backwards
and forwards through the input history, successively copying previously entered
expressions over the current line. When you reach the expression you want, simply
press Enter to re-run it. These operations may also be performed from the Edit menu
in the session window.

Executing Several Expressions

You can execute several expressions, by changing more than one line in the session
log before pressing Enter. Each line that you change will be displayed using colour
249 (Red on White). When you press Enter, these marked lines are copied down and
executed in the order they appear in the log.

Note that you don't actually have to change a line to mark it for re-execution; you
can mark it by overtyping a character with the same character, or by deleting a
leading space for instance.
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It is also possible to execute a contiguous block of lines. To do this, you must first
select the lines (by dragging the mouse or using the keyboard) and then copy them
into the clipboard using Shift+Delete (CT) or Ctrl+Insert (CP). You then paste them
back into the session using Shift+Insert (PT). Lines pasted into the session are always
marked (Red on White) and will therefore be executed when you press Enter. To
execute lines from an edit window, you use a similar procedure. First select the lines
you want to execute, then cut or copy the selection to the clipboard. Then move to
the session window and paste them in, then press Enter to execute them.

Session Print Width (PW)

Throughout its history, APL has used a system variable [JPW to specify the width of
the user's terminal or screen. Session output that is longer than [JPW is automatically
wrapped and split into multiple lines on the display. This feature of APL was
designed in the days of hard-copy terminals and has become less relevant in modern
Windows environments.

Dyalog APL continues to support the traditional use of [JPW, but also provides an
alternative option to have the system wrap Session output according to the width of
the Session Window. This behaviour may be selected by checking the Auto PW
checkbox in the Session tab of the Configuration dialog box.

Using Find/Replace in the Session

The search and replace facilities work not just in the Editor as you would expect, but
also in the Session. For example, if you have just entered a series of expressions
involving a variable called SALES and you want to perform the same calculations
using NEWSALES, the following commands will achieve it:

Enter SALES in the Find box,and NEWSALES in the Replace box. Now click the
Replace All button. You will see all occurrences of SALES change to NEWSALES.
Furthermore, each changed line in the session becomes marked (Red on White). Now
click on the session and press Enter (or select Execute from the Action menu).

Once displayed, the Find or Find/Replace dialog box remains on the screen until it is
either closed or replaced by the other. This is particularly convenient if the same
operations are to be performed over and over again, and/or in several windows. Find
and Find/Replace operations are effective in the window that previously had the
focus.
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Value Tips

If you hover the mouse pointer over a name in the Session or Debugger window, APL
will display a pop-up window containing the value of the symbol under the mouse

pointer.

For example, in the following picture the mouse pointer was moved over the name of
the variable HW in the Session window.
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The next picture illustrates the Value Tip displayed when the mouse is hovered over

the name of the variable MAT.
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Similarly, if you hover the mouse pointer over the name of a function, the system
displays the body of the function as a pop-up, as illustrated below.
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Value Tips for External Functions

Value Tips can also be used to investigate the syntax of external functions. If you

hover over the name of an external function, the Value Tip displays its Function

Signature.

For example, in the example below, the mouse is hovered over the external function

dt.AddMonths and shows that it requires a single integer as its argument.
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Should the external function provide more than one signature, they are all shown in
the Value Tip as illustrated below. Here the function ToString has four different
overloads.
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Configuring Value Tips

You may enable/disable Value Tips and select other options from the General tab of
the Configuration dialog box as shown below.

You may experiment by changing the value of the delay before which Value Tips are
displayed, until you find a comfortable setting.

Note that the colour scheme used to display the Value Tip for a function need not
necessarily be the same colour scheme as you use for the function editor.

Dyalog APL/W-64 Configuration

Log Trace/Edit Auto Complete SALT User Commands Object Syrntac
General Unicode Input Keyboard Shortcuts Worlkspace Help / DIMX Windows Session

Recently used fils list size: ~ i
1 EI Show meszage box if zearch wiaps
|Underline URLs and links

Dizplay Yalue Tips after: l:l [ma=)
Colour Scheme: Default w

Enable Mative Look and Feel

Enable DPI Scaling of the interpreter and development environment

] Enable DFI Scaling of GUI application

Configuration saved in:

| HKEY_CURRENT_USERNSOFTWARE\Dyalog\Dyalag APLAw-64 15.0 Unicode

Cancel
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Array Editor

The Array Editor! allows you to edit arbitrary arrays. It is invoked by either:

e Clicking the AT icon in the Session toolbar when the mouse pointer is over
the name of a suitable variable.

o Calling the user command Jarray.edit, specifying the name of a
suitable variable as its argument.

o Calling it directly via ONA

The Array Editor draws data using a format that is similar to the output of the
DISPLAY function. For example:

Array Editor

File Edit Actions Insert Options Help

ME&S| 4 2B ~Q|_ B|[aBC 127 a ¥ |

etcoded 123y ,['']clppw] |o= = OR BB B 2 | @
~
ICharacters IAHC apy
INumbers: |o 1 |4 5 6 |3.1q 5.6£723 |0J1
IScaLar5=
IFectors: IFour score and seven years 2go
IHatrices: 1 2 3 &
5 & 7 8
9 10 11 12
W
Type: Nested array =: 3 =/p: 5 pp: 2 p: 51 =:

I Array Editor Version 1 Release 1 © Copyright davidliebtag.com 2012, 2015
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Documentation

Full documentation for the Array Editor, including a list of the keystrokes it uses, is
available from the Help menu in the Array Editor's window.

Supported Arrays

The Array Editor supports arrays that consist solely of characters and/or numbers.
You may not use it to edit an array that contains an object reference or a [JOR.

Reject unsupported data

The way that the Arrays Editor reacts to unsupported arrays is determined by the
value of the Reject unsupported data option which is accessed by the
Options/Reject unsupported data menu item on the Array Editor menubar.

If'this is set to true (the default), and you try to edit an array containing an object
reference, the Array Editor will refuse to start and the system will generate an error
message.

[SE.NumEd.numed: Unexpected error in array editor:
DOMAIN ERROR Argument contained data that is
neither simple or nested.

Ifthis option is cleared, the Array editor will start but you will not be able to do
anything. It is therefore advisable that you leave this option set.

Notes

o The Array Editor is supplied only with Unicode Editions of Dyalog
APL/W. Please visit www.davidliebtag.com for details about availability
and support for Classic Editions of Dyalog APL/W.

Namespaces are not supported.

Internal representations returned by [JOR are not supported.

Only one instance of the Array Editor may be executed at a time.

All calls to interpreter primitives use a value of 3 for [JML.

Negative numbers must be represented using high minus signs. For example,
~3 not -3.
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Implementation

The Array Editor is implemented by a DLL named dlaedit.d11 (32-bit)or
dlaedit64.dll (64-bit).

The DLL exports two functions: DyalogEditArray and

DyalogEditArrayTitle. The latteris used when you click the W icon in the
Session toolbar (via the APL function JSE .NumEd . numed) and by the user
command Jarray.edit

Calling the Array Editor Directly
If you wish to use the Array Editor directly, you may do so as follows using ONAL.

Forboth DyalogEditArray and DyalogEditArrayTit Le the first argument
is the array to be edited, while the second argument is a place holder and should
always be 0

ForDyalogEditArrayTit le the 3rd argument is a character vector whose
contents are displayed in the caption of the array editor window.

The result is the newly altered array.

Examples

ONA'dlaedit.dll|DyalogEditArray <pp >pp' A 32-bit
ONA'dlaedit.dll|DyalogEditArrayTitle <pp >pp <0C2[]' na 32-bit

ONA'dlaedité4.dl | |DyalogEditArray <pp >pp' A 64-bit
ONA'dlaedité4.dl L |DyalogEditArrayTitle <pp >pp <0C2[]'m 64-bit

New<DyalogEditArray Old O
New<DyalogEditArrayTitle Old O Name

INote that these are not standard [JNA calls, but rather use an extension to [NA, called Direct
Workspace Access. Dyalog does not intend to make this feature generally available at present: if
you are interested in this feature please contact sales@dyalog.com.
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The Session GUI Hierarchy

As distributed, the Session object JSE contains two CoolBar objects. The first,
named [JSE . cbtop runs along the top of the Session window and contains the
toolbars. The second, named (JSE . cbbot, runs along the bottom of the Session
windows and contains the statusbars.

The menubar is implemented by a MenuBar object named [JSE . mb.

The toolbars in [JSE . cbtop are implemented by four CoolBand objects, bandtb1,
bandtb2,bandtb3 and bandtbl each containing a ToolControl named tb.

The statusbars in JSE . cbbot are implemented by two CoolBand objects,
bandtb1 and bandtb2, each containing a StatusBar named sb.
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The Session MenuBar

The Session MenuBar (OSE . mb) contains a set of menus as follows. Note that, unless
specified, the screen-shots are taken using Unicode Edition and the keyboard short-
cuts will be different in Classic Edition.

The File Menu

The File menu (OSE .mb . f i Le) provides a means to execute those APL System
Commands that are concerned with the active and saved workspaces. The contents of
a typical File menu and the operations they perform are illustrated below.

Mew

Open...

Save

Save As...

Export...

Export to Memory

Close AppDomain
Drop...
Edit Text File...

Print...
Print Setup...

Continue

Exit

1 CAProgram Files\DyaloghDyalog APL-84 15.0 Unicodelws\buildse.dws
2 ChUsersh\Pete\Documents\Filoshuseful. WS
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Table 7: File Menu Operations

Item Action Description
New [WSClear] Prompts for confirmation, then clears
the workspace
Prompts for a workspace file name,
Open [WSLoad] then loads it
Prompts for a workspace file name,
Copy [WSCopy] then copies it
Save [WSSave] Saves the active workspace
Save As [WSSaveas ] Prompts for. a workspace file name,
then saves it
Creates a bound executable, an OLE
Server, an ActiveX Control, or a
Export [Makeexe] NET Assembly. See Installation &
Configuration Guide: Creating
Executables and OLE Servers.
Export to [MakeMemory .
Memory Assembly] Creates an in-memory NET Assembly
Close . .
AppDomain [CloseAppDomain] [Closes NET App Domain
Prompts for a workspace file name,
Drop [WSbrop] then erases it
Edit Text . . Displays the Open Source File dialog
File [EditTextFile] to select a file to exit.
Print [PrintFnsInNS] Prints functions and operators in
current namespace
Print Setup | [PrintSetup] Invokes the print set-up dialog box
. . Saves the active workspace in
Continue | [Continue] CONTINUE.DWS and exits APL
Exit [Off] Exits APL
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Edit Text File

The Edit Text File menu item allows you to edit a Dyalog script file (.dyalog) or an
arbitrary text file. The system prompts you to choose the file as shown below:

A Open source file

&« v « OS(C) » MiServer_Alonissos » webcam v O Search webcam 2
Organize = MNew folder = [ @
MadCap15.0 * MName Date modified Type S
MadcapOutpu Admin 19/04/201517:10  Filefolder
MiServer Code /2015 17:10 File folder
MiServer_Aloni Config 20151710 File folder
confreg Data File folder
Core Examples File folder
Docurmentati images File folder
jbgames 19/04/201517:10 File folder
ErrorP
rerragEs MiCart File folder
Extensions Scripts 14/2015 17:10 File folder
Intro Styles 19/04/201517:10 File folder
Pluglns @ index.dyalog 27/12/2014 16:47 Dyalog APL Script File
ServerData timelapse.dyalog 5/05/201512:31 Dyalog APL Script File
Utils @ webcam.dyalog 18/05/2015 17:00 Dyalog APL Script File
webcam
BAIC J_.._Iv < >
File name: |webcam.dya|og V| Dyalog source files (*.dyalog)

The file is then displayed in the Editor, allowing you to change it and save it. See
Editing Scripts and Text Files on page 141.

4
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The Edit Menu

The Edit menu (OSE .mb . edi t) provides a means to recall previously entered input
lines for re-execution and for copying text to and from the clipboard.

Back Control+5hift+Back
Forward Control+ Shift+Enter
Cut Control+ Delete
Copy Control+Insert
Paste Shift+Insert
Find...
Replace...

Unicode Edition
Back Ctrl+Shift+Bksp
Forward Ctrl+5hift+Enter
Cut Ctrl+Delete
Copy Ctrl+c

Paste Unicode

Paste Mon-Unicode

Find...

Replace...

Classic Edition
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Table 8: Edit menu operations

Item Action Description
Displays the previous input line. Repeated
Back [Undo] use of this command cycles back through the
input history.
Displays the next input line. Repeated use of
Forward | [Redo] this command cycles forward through the
input history.
Cut [Delete] Cuts the selected text to the clipboard
Copy [Copy] Copies the selection to the clipboard
Pastes the text contents of the clipboard into
Paste [Paste] the session log at the current location. The
new lines are marked and may be executed
by pressing Enter.
Paste Same as Paste, but gets the Unicode text from
. [PasteUnicode] [the clipboard and converts to JAV. Classic
Unicode .
Edition only
Paste Same as Paste, but gets the ANSI text from
Non- [PasteAnsi] the clipboard and converts to JAV. Classic
Unicode Edition only
Find [Find] Displays the Find dialog box
Replace | [Replace] Displays the Find/Replace dialog box
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The View Menu

The View menu (OSE .mb . view) toggles the visibility of the Session Toolbar,
StatusBar, and Language Bar.

"  Toolbar
~  Statusbar

~  languageBar

Table 9: View menu operations

Item Action Description

Toolbar Shows/Hides Session toolbars
Statusbar Shows/Hides Session statusbars
LanguageBar Shows/Hides Language Bar

The Windows Menu

This contains a single action (OSE .mb . windows) which is to close all of the Edit
and Trace windows and the Status window.

Close all windows

Language Bar
Debugger »
Editor

Table 10: Window menu operations

Item Action Description

Close all Windows |[[CloseAll] |Closes all Edit and Trace windows

Note that [CloseAl L ] removes all Trace windows but does not reset the State
Indicator.

In addition, the Window menu will contain options to switch the focus to any
subsidiary windows that are docked in the Session as illustrated above.
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The Session Menu

The Session menu (OSE .mb . session)provides access to the system operations
that allow you to load a session (JSE) from a session file and to save your current
session (SE) to a session file. If you use these facilities rarely, you may wish to
move them to (say) the Options menu or even dispense with them entirely.

Open...
Save

Save As..,

Table 11: Session menu operations

Item | Action Description

Prompts for a session file name, then loads the session
from it, replacing the current one. Sets the File
property of JSE to the name of the file from which the
session was loaded.

Open | [SELoad]

Saves the current session (as defined by SE) to the

Save | [SESave] session file specified by the File property of OSE

Prompts for a session file name, then saves the current
[SESaveAs] |session (as defined by [JSE) in it. Resets the File
property of SE.

Save
As




Chapter 1: The APL Environment 46

The Log Menu

The Log menu (OSE .mb . Log) provides access to the system operations that
manipulate Session log files.

Mew

Open...

Save

Save As,.,

Print...

Table 12: Log menu operations

Item | Action Description

Prompts for confirmation, then empties the current

New |[NewlLog] Session log

Prompts for a Session log file, then loads it into

Open | [OpenLog] memory, replacing the current Session log

Saves the current Session log in the current log file,

Save elL .. .
ve |[Savelog] replacing its previous contents

Save Prompts for a file name, then saves the current
[SavelogAs] . ..
As Session log in it

Print |[PrintLog] |Prints the contents of the Session log

The Action Menu

The Action menu (OSE .mb . act i on) may be used to perform a variety of operations
on the current object or the current line. The current object is the object whose name
contains the cursor. The current line is that line that contains the cursor. The Edit,
Copy Object, Paste Object and Print Object items operate on the current object. For
example, if the name SALES appears in the session and the cursor is placed
somewhere within it, SALES is the current object and will be copied to the clipboard
by selecting Copy object or opened up for editing by selecting Edit.
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Edit...

Trace...

Execute

Shift+Enter

Copy Object

Paste Object

Print Object...

Clear Stops

Interrupt

Rezet

Table 13: Action menu operations

Item Action Description
Edit [Edit] Edit the current object

Executes the current line under the control of the
Trace [Trace]

Tracer
Execute | [Execute] Executes the current line
Copy . Copies the contents of the current object to the
Object | LOPICOPY] | hihvard
Paste [ObjPaste] Pastes the contents of the clipboard into the
Object J current object, replacing its previous value
Print R . .
Object [ObjPrint] |Prints the current object
Clear [ClearTSM] Clegrs all JSTOP, JMONITOR and [JTRACE
Stops settings
Interrupt | [Interrupt] | Generates a weak interrupt
Reset [Reset] Performs )RESET
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The Options Menu

The Options menu (OSE .mb.options)provides configuration options.

Object Syntax

"  Line Mumbers Murm -

+»  Disable traps in session

Configure...

Colours...

Table 14: Options menu operations

~  Expose GUI| Properties
Expose Root Properties

Expose Session Properties

Item Action Description
Expose Exposes the names of
GUI [ExposeGUI] properties, methods and
Properties events in GUI objects
Expose Exposes the names of the
Root [ExposeRoot] properties, methods and
Properties events of the Root object
Expose Exposes the names of the
Session [ExposeSession] properties, methods and
Properties events of [JSE
. Toggle the display of line
Line . . .
[LineNumbers] numbers in edit and trace
Numbers .
windows on/off
Disables the error trapping
Disable mechanism used by
traps in [DisableTrapsAtSuspension]| :Trap and OTRAP. This
session can be useful in
debugging applications.
. Displays the
Configure | [Configure] Configuration dialog box
Displays the Colours
Colours |[[ChooseColors] Selection dialog box
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The values associated with the Expose GUI, Expose Root and Expose Session options
reflect the values of these settings in your current workspace and are saved in it.
When you change these values through the Options menu, you are changing them in
the current workspace only.

The default values of these items are defined by the parameters default_wx,
PropertyExposeRoot and PropertyExposeSE which may be set using the Object
Syntax tab of the Configuration dialog.

The Tools Menu

The Tools menu (OSE .mb. tools)provides access to various session tools and
dialog boxes.
Explorer...
Search...
Status...
" AutoStatus

Event Viewer

Properties..,

Table 15: Tools Menu Operations

Item Action Description

Explorer |[Explorer] Displays the Workspace Explorer tool
Search [WSSearch] Displays the Workspace Search tool
Status [Status] Displays or hides the Status window

Toggle; if checked, causes the Status
AutoStatus | [AutoStatus] [window to be displayed when a new
message is generated for it

Event

Viewer [EventViewer] |Displays or hides the Event Viewer

Displays a property sheet for the current

Properties | [ObjProps] object
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The Threads Menu

The Threads menu (OSE .mb . threads) provides access to various session tools
and dialog boxes.

Show Threads...

~  Show Stack...
Show Token Poal...
Auto Refresh

~"  Pause on Error
Pause all Threads
Resume all Threads

Restart all Threads

Table 16: Threads Menu Operations

Item Action Description

Show .

Threads [Threads] Displays the Threads Tool
Show Stack |[[Stack] Displays the SI Stack window
Show Token Displays the Token Pool

[TokenPool]

Pool window

Refreshes the Threads Tool on
every thread switch

Auto Refresh | [ThreadsAutoRefresh]

Pause on

[ThreadsPauseOnError] | Pauses all threads on error
Error

Pause all

Threads [ThreadsPauseAll] Pauses all threads

Resume all
Threads

Restart all
Threads

[ThreadsResumeAl l] Resumes all threads

[ThreadsRestartAll] Restarts all threads
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The Help Menu

The Help menu (OSE .mb . he L p) provides access to the help system which is
packaged as a single Microsoft HTML Help compiled help file named

help\dyalog.chm.

Documentation Centre

Read Me

Latest Enhancements
Language Help

Gui Help

Third Party Licences

Dyalog Web Site
Ermail Dyalog

About Dyalog APL

Table 17: Help menu operations

Label Action

Description

Documentation

Centre [DocCenter]

Opens your web browser on
help\index.html which displays
an index to the on-line PDF
documentation and selected internet
links

Read Me [ReadMe]

Opens help\dyalog readme.htm
in your default web browser. Note that
setup_readme.htm is also included in
this directory

Latest

Enhancements [RelNotes]

Opens help\dyalog.chm, starting
at the first topic in the Version 16.0
Release Notes section. Note that
previous Release Notes are also
included for your convenience.

Language Help |[LangHelp]

Opens help\dyalog.chm, starting
at the first topic in the Language
Reference section
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Label Action Description

Opens help\dyalog.chm, starting
Gui Help [GuiHelp] at the first topic in the Object

Reference section

. Opens help\dyalog.chm, starting

Thlrd Party [LicenceHelp]|at the first topic in the Licences for
Licences .

third-party components
Dyalog Web Opens your web browser on the
Site [DyalogWeb] Dyalog home page

Email Dyalog

[DyalogEmail]

Opens your email client and creates a
new message to Dyalog Support, with
information about the Version of
Dyalog APL you are running

About Dyalog
APL

[About]

Displays an About dialog box
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Session Pop-Up Menu

The Session popup menu (SE . popup) is displayed by clicking the right mouse
button anywhere in the Session window.

Edit

Chart Wizard

Cut Shift+Delete
Copy Control+Insert
Paste Shift+Insert

Paste Unicode
Paste Mon-Unicode
Copy Object

Paste Object

v Line Mumbers Mum -

Align Comments

Explorer...
Search...
Event Viewer...
Threads...
Status...

Colours...

Interrupt

If the mouse pointer is over a visible object name, the popup menu allows you to
edit, print, delete it or view its properties. Note that the name of the pop-up menu is
specified by the Popup property of [ISE.
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Table 18: Session popup menu operations

Item Action Description
Edit [Edit] Edits the current object
Chart Opens Chart Wizard on
Wizard [SE.Dyalog.Chart.DoChart current object
Print [ObjPrint] Prints the current object
Delete [ObjDelete] Erases the current object
Displays the Object
Properties [GUIHelp] Properties dialog box for
the current object
Displays the help topic
associated with the current
Help [Help] object or the APL symbol
under the cursor
Cut [Cut] Deletes selected text
Copies the selection to the
Copy [Copy] clipboard
Pastes the text contents of
the clipboard into the
session log at the current
Paste [Paste] location. The new lines
are marked and may be
executed by pressing
Enter.
Same as Paste, but gets
Paste [PasteUnicode] the Unicode text from the
Unicode ! clipboard and converts to
OAv
Paste Same as Paste, but gets
. the ANSI text from the
Non- [PasteAnsi] .
Unicode clipboard and converts to
OAv
Copy Copies the contents of the
Object [ObjCopy] current object to the

clipboard
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Item Action Description
Paste Pastes the contents of the
. [ObjPaste] clipboard into the current
Object object
Line . Toggles line numbers
Numbers [LineNumbers ] on/off
Align . Aligns Comments to
Comments [AlignComments ] current column
Explorer [Explorer] g;;l;lli}e]i the Workspace
Search [WSSearch] E)loslplays the Find Objects
Event . . .
Viewer [EventViewer] Displays the Event Viewer
Threads [Threads] Displays the Threads Tool
Status [Status] B;;%lj‘};s the Status
Colours [ChooseColors] Dlsplays th.e Colour
Selection dialog
Interrupt [Interrupt] Generates a weak interrupt
Opens the URL or link
. . using the appropriate
Open link [OpenLink] program. Unicode Edition
only.
C link Copies the URL or link to
opy [CopyLink] the Windows Clipboard.

to clipboard

Unicode Edition only.

For the last two items, see Installation & Configuration Guide: Configuration
Dialog: General Tab)
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The Session Toolbars

The Session toolbars are contained by four separate CoolBand objects, allowing you
to configure their order in whichever way you choose. The tool buttons appear
differently according to whether or not Native Look and Feel is enabled.

The bitmaps for the buttons displayed on the session tool bar are implemented by
three ImageList objects owned by the CoolBar[JSE . cbtop. These represent the
ToolButton images in their normal, highlighted and inactive states and are named
iln,ilhand ili respectively. These images derive from three bitmap resources
contained in dyalog.exe named tb_normal, tb_hot and tb_inactive.

If Native Look and Feel is enabled all three bitmap resources are mapped to a
different set of images which are capable of reflecting the Visual Styles in use.

Native Look and Feel Enabled
WS 5 & W %y =

Object [J] 7] & 7 i [A
Tool P g i=

Edit g1 & 9 T

Session (.| |APL385 Unicode  v| 16 :|

Native Look and Feel Disabled
ws DD E A S

Obect B! B 85 ¥V EH &
ool O G B O
: Edit (B v cu

- Session B |APL3ES Unicode | 1B6[=
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Workspace (WS) Operations

o U
Clear Workspace
(=

Load Workspace

¢ DF
Copy Workspace

Save Workspace

&l

Export Workspace

& &

Print Functions

Executes the system operation [WSClear] which asks
for confirmation, then clears the workspace

Executes the system operation [WSLoad] which
displays a file selection dialog box and loads the
selected workspace

Executes the system operation [WSCopy ] which
displays a file selection dialog box and copies the
(entire) selected workspace

Executes the system operation [WSSaveas] which
displays a file selection dialog box and saves the
workspace in the selected file

Executes the system operation [MakeExe] which re-
exports the workspace using the settings, parameters and
options that were previously selected using the Create
Bound File dialog

Executes the system operation [PrintFnsInNS] that
prints all the functions and operators in the current
namespace
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Object Operations
@ E

Copy Object

m) B
Paste Object

= s
Print Object

B v
Edit Object
3
Edit Array
m R
SharpPlot

Executes the system operation [Ob jCopy ] which
copies the contents of the current object to the
clipboard

Executes the system operation [Ob jPaste] which
copies the contents of the clipboard into the current
object, replacing its previous value

Executes the system operation [ObjPrint] that prints
the current object

Executes the system operation [Edit] which edits the
current object using the standard system editor

Executes a defined function in JSE that edits the
current object using the Array Editor (Unicode Edition)
or a spreadsheet-like interface based upon the Grid
object (Classic Edition). See Array Editor on page 35

Executes a defined function in [JSE that runs the Chart
Wizard to plot the current object using the Jchart
User Command.
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Tools

H @

Explorer

et

Search

=

Line Numbers

8 ¥

Clear all Stops

Edit Operations
0!

Copy Selection

a &

Paste Selection

2w
Recall Last

¢
Recall Next

Executes the system operation [Explorer] which
displays the Workspace Explorer tool

Executes the system operation [WSSearch] which
displays the Workspace Search tool

Executes the system operation [LineNumbers] which
toggles the display of line numbers in edit and trace
windows on and off

Executes the system operation [ClearTSM] which
clears all JSTOP, [IMONITOR and OTRACE settings

Executes the system operation [Copy ] which copies
the selected text to the clipboard

Executes the system operation [Paste] which pastes
the text in the clipboard into the current window at the
insertion point

Executes the system operation [Undo] which recalls
the previous input line from the input history stack

Executes the system operation [Redo] which recalls
the next input line from the input history stack
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Session Operations

u

=

Load Session

APL3E5 Unicode W

Select Font

162

b

Select Font Size

Executes the system operation [ SELoad] which
displays a file selection dialog box and loads the
selected Session File

Selects the font to be used in the Session window

Selects the size of the font to be used in the Session
window
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The Session Status Bar

The session status bar is represented by two CoolBands each of which contains a
StatusBar object. There are a number of StatusFields as illustrated below. Your own
status bar may be configured differently.

Ready...

CurObj:

Classic Edition

Ready...

CurObj:

Unicode Edition

Ins NUM Uni
&%:1 OpQ:0 OTRAP [sI:0 [OI0:1 [OML:1

Ins NUM

B:1 Opo:0 OTRAP [OsI:0 DI0:1 [OML:1

The StatusField objects owned by the session StatusBar may have special values of
Style, which are used for operations relevant only to the Session. These styles are
summarised in the tables shown below.

Table 19: Session status fields: first row

StatusField | Style Description
. Displays hints for the session objects, or "Ready..."
hint None when APL is waiting for input
insrep InsRep Displays the mode of the Insert key (Ins or Rep)
Displays the keyboard mode. This is applicable only
to a multi-mode keyboard. The text displayed is
mode KeyMode defined by the Mn= string in the Input Table.
Classic Edition Only
Indicates the state of the Num Lock key. Displays
nam NumLock | M if Num Lock is on, blank if off
Indicates the state of the Caps Lock key. Displays
caps CapsLock "Caps" if Caps Lock is on, blank if off
Ause Pause Displays a flashing red "Pause" message when the
p Pause key is used to halt session output
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Table 20: Session status fields: second row

StatusField | Style Description

curobj CurObj Displays the name of the current object (the name
last under the input cursor)

t ThreadCount D1§p}ays thp number of threads currently running
(minimum is 1)

dqlen DQLen Displays the number of events in the APL event
queue

trap Trap Turns red if JTRAP is set

si SI Displays the length of SI. Turns red if non-zero

o 0 Displays the value of JI0. Turns red if IO is not
equal to the value of the default_io parameter

ml ML Displays the value of [JML. Turns red if (DML is not
equal to the value of the default ml parameter

Toggle Status Fields

In the default Session files distributed with this release, the Statusfields used to
display the value of JI0, the state of the Insert key (Ins/Rep) and the current
keyboard mode (e.g. Apl/Uni) have callback functions attached to MouseDblClick.
This means that you can toggle the state of these fields by double-clicking with the
left mouse button.

If you dislike this behaviour, you may set the Event property of the StatusFields to 0
and re-save the Session file. Alternatively, you may modify the buildse workspace
and rebuild the Session from scratch.
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Status Window

The Status window is used to display system messages and supplementary
information. These include the operations that take place when you register an
OLEServer or ActiveXControl.

The Status window is also used to display supplementary information about errors.
For example if you attempt to use a .NET method with incorrect argument(s) you will
get a suitable error message in the Status window, in addition to the DOMAIN

ERROR message in the Session.

Example

OUSING<'System'

bd«<[INEW DateTime(2015 4) A Typo (2015 4 30)
DOMAIN ERROR

bd<[INEW DateTime(2015 4) A Typo (2015 4 30)

A

A Status

File Options

Void .ctor({Inté%, System.DateTimeKind) P
Yoid .ctor(Int32, Int32, Intd2)

Yoid .ctor(Int32, Int32, Int32, System.Globalization.
Yoid .ctor(Int32, Int32, Int32, Int32, Int32, Int32)
Yoid .ctor(Int32, Int32, Int32, Int32, Int3d2, Int32,
Yoid .ctor(Int32, Int32, Int32, Int32, Int3d2, Int32,
Yoid .ctor(Int32, Int32, Int32, Int32, Int32, Int32,
Yoid .ctor(Int32, Int32, Int32, Int32, Int3d2, Int32,
Yoid .ctor(Int32, Int32, Int32, Int32, Int3d2, Int32,
Yoid .ctor(Int32, Int32, Int32, Int32, Int32, Int32,

Close

The Status window can be explicitly displayed or hidden using the [Status]
system operation which is associated with the Tools/Status menu item. There is also
an option to have the Status window appear automatically whenever a new message
is written to it. This option is selected using the [AutoStatus] system operation
which is associated with the Tools/AutoStatus menu item.

Note that when you close the Status window, all the system messages in it are
cleared.
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The Workspace Explorer Tool

The Explorer tool is a modeless dialog box that may be toggled on and off by the
system action [ Exp lorer]. In a default Session, this is attached to a Menultem in
the Tools menu and a Button on the session toolbar.

The Explorer contains two sub-windows. The one on the left displays the namespace
structure of your workspace using a TreeView. The right-hand window is a ListView
that displays the contents of the namespace that is selected in the TreeView.

File Edit Options View Tools

mEX P E | Ea BEEEE ML

Workspace Tree Contents of #.WDesign.PropFmt {

=-al # # | Name | Type ~

Eli Hhesign FJAnimation Function

g [Fns/Ops] AABTNS Variable
f—E é'f'r:“] T BTNSCONV Function
itmaps M B .
: md Bitmap Function
BMED
= Buttons PJBrowseRox Function
i-gll Colouricker . CHOICES Variable
i Events m'__"l Calendar Function
i GridTitles m'__'l Check Function
-l GWiz FlCircle Function
&l ILWiz ) Combo Function
i PropFmt ) ComboEx Function
&Ml PropVal 5 CoolBar Function
Ml Styles B Cursor Function
Ml TabWiz fiDateTimePicker Function V¥

H-fE] OSE v |« >

75 object(s). 253.1Mb free. |-fld}9'|63 bytes used (0 bytes

The Explorer is closely modelled on the Windows Explorer in Windows and the
facilities it provides are very similar. For Windows users, the operation of this tool is
probably self-explanatory. However, other users may find the following discussion

useful.
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Exploring the Workspace

The TreeView displays the structure of your workspace. Initially it shows the root
and Session namespaces # and [JSE. The icon for # is open indicating that its
contents are those that appear in the ListView. You can expand or collapse the
TreeView of the workspace structure by clicking on the mini-buttons (labelled + and
-) or by double-clicking the icons. A single click on a closed namespace icon opens it
and causes its contents to be displayed in the ListView. Another way to open a
namespace is to double-click its icon in the ListView. Only one namespace can be
open at a time. The icons used in the display are described below.

Class

Namespace (closed)
GUI Namespace (closed)
Namespace (open)

GUI Namespace (open)
Function

Variable

Operator

Indicates an object that has been erased

I HHHHOLHBD

",'-’,‘fﬁ" Type Library
wia )
wHETH NET object

$
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Viewing and Arranging Objects

The ListView displays the contents of a namespace in one of four different ways
namely Large Icon view, Small Icon view, List view or Details view. Y ou can switch
between views using the View menu or the tool buttons that are provided. In the first
three views, the system displays the name of'the object together with an icon that
identifies its type. In Details view, the system displays several columns of additional
information. Y ou may resize the column widths by dragging or double-clicking the
lines in the header. To hide a column, drag its width to the far left. The additional
columns are:

This is the namespace containing the object. By definition, this
Location |is the same for all of the objects shown in the ListView and is
normally hidden

For a function or operator, this is the function header stripped of
localised names and comment. For a variable, the description
indicates its rank, shape and data type. For a namespace, the
description indicates the nature of the namespace; a plain
namespace is described as namespace, a GUI Form object is
described as Form, and so forth.

Description

Size The size of the object as reported by 0SIZE.

Modified | For functions and operators, this is the timestamp when the
on object was last fixed. For other objects this field is empty.

Modified | For functions and operators, this is the name of the user who last
by fixed the object. For other objects this field is empty.

In any view, you may arrange the objects in ascending order of name, size, timestamp
or class by clicking the appropriate tool button. In Details view, you may sort in
ascending or descending order by clicking on the appropriate column heading. The
first click sorts in ascending order; the second in descending order.
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Moving and Copying Objects

You can move and copy objects from one namespace to another using drag-drop or
from the Edit menu.

To move one or more objects using drag-and-drop editing:

1. Select the objects you want to move in the ListView.

2. Point to one of the selected objects and then press and hold down the left
mouse button. When the drag-and-drop pointer appears, drag the object(s) to
another namespace in the TreeView. To indicate which of the namespaces is
the current target, its name will be highlighted as you drag the selected
object(s) over the TreeView.

3. Release the mouse button to drop the objects into place. The objects will
disappear from the ListView because they have been moved to another
namespace.

To copy one or more objects using drag-and-drop editing, the procedure is the same
except that you must press and hold the Ctrl key before you release the mouse button.

Y ou may also move and copy objects using the Edit menu. To do so, select the object
(s) and then choose Move or Copy from the Edit menu. You will be prompted for the
name of the namespace into which the objects are to be moved or copied. Enter the
namespace and click OK.

Editing and Renaming Objects

You can open up an edit window for a function or variable by double-clicking its
icon, or by selecting it and choosing Edit from the Edit menu or from the popup
menu. You may rename an object by clicking its name (as opposed to its icon) and
then editing this text. You may also select the object and choose Rename from the
Edit menu or from the popup menu. Note that when you rename an object, the
original name is discarded. Unlike changing a function name in the editor, this is not
a copy operation.
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Using the Explorer as an Editor

Ifyou open the Fns/Ops item, the names of the functions and operators in the
namespace are displayed below it alphabetically in the left (tree view) pane. When
you select one of these names, the function itselfis opened in the right (list view)

pane.

File Edit Options View Tools
@y c3lu EEEEIDA G

Workspace Tree

<

) KEYPRESS
o LAST_BTN
& LIST_0BJ
¥ LOCATE

4 MAKE_BTN

#) MAKE_EXEC

o) MAKE_FMT_FN

o) MAKE_FMT_PR

43 MAKE_FN

) MAKE_FN_FOR

) MAKE_FN_GRI ¥
>

A kA A X

|68 40 @ an 3 x

[

LX;0OML
OML+0

:If 2=[INC'DESCRIBE'
tDESCRIBE
tEndIf

|Fur1ctior1

| Pos: 0/...

413 object(s). 253.1Mb free,

|‘I'.-'2'.-'312 bytes used (0 bytes selected)

.

You may use this feature to quickly cycle through the functions (or variables) in a
namespace, pressing cursor up and cursor down in the left (tree view) pane to move
from one to another.

Y ou may also edit the function directly in the right (list view) pane before moving on

to another.
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The File Menu

Print...
Print setup...

Delete
Rename F2

Properties Alt Enter

Close

The File menu, illustrated above, provides the following actions. All but Print setup
and Close act on the object or objects that are currently selected in the ListView.

Print Prints the object(s).

Print . . . .

setup Displays the Print Configuration dialog box.

Delete Erases the object(s).

Rename Renames the object. This option only applies when a single

object is selected.

Properties | Displays a property sheet; one for each object that is selected.

Close Closes the Explorer
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The Edit Menu
Edit Enter
Copy Ctrl C
Maove
Select >

Select Functions

Select Variables

Select Mone
Select All Ctrl A

Invert Selection

The Edit menu, illustrated above, provides the following actions. The Edit, Copy and
Move operations act on the object or objects that are currently selected in the
ListView.

Edit Opens an edit window for each of the objects selected.
Copy Prompts for a namespace and copies the object(s) there.
Move Prompts for a namespace and moves the object(s) there.
Select‘ Selects all of the functions and operators in the ListView.
Functions

Sele.ct Selects all of the variables in the ListView.

Variables

Select None | Deselects all of the objects in the ListView.

Select All Selects all of the objects in the ListView.

Invert Deselects the selected objects and selects all those that were
Selection not selected.
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The Options Menu

~  Toolbar

Toolbar Capticns

~"  Status Bars

Expand All

Refresh Mow F3
"  Auto Refresh

The Options menu, illustrated above, provides the following actions.

Toolbar |Displays or hides the Explorer toolbar.
Toolbar Displays or hides the button captions on the Explorer toolbar
Captions play P p '
StatusBar | Displays or hides the Explorer statusbar.
Type Enables/disables the exploring of Type Libraries
Libraries P £ M
Expands all namespaces and sub-namespaces in the TreeView,
Expand s 1 . . .
providing a complete view of the workspace structure, including
All . . .
or excluding the Session object [JSE.
Refresh Redisplays the TreeView and ListView with the current structure
and contents of the workspace. Used if Auto Refresh is not
Now
enabled.
Auto Specifies whether or not the Explorer immediately reflects
Refresh | changes in the active workspace.

If Auto Refresh is checked the Explorer is updated every time APL returns to desk-
calculator mode. This means that it is always in step with the active workspace. If
you have a large number of objects displayed in the Explorer, the update may take a
few seconds and you may wish to prevent this by un-checking this menu item Ifyou
do so, the Explorer must be explicitly updated by selecting the Refresh Now action.
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The View Menu

Columns s % Mame
Large lcons ~  Location
Small lcons v Type
List Icons v Description

® [Details ¥ Size

~  Meodified on

— > Medified by
Arrange lcons ¥

Line up lcons

~  Auto Arrange

The View menu, illustrated above, provides the following actions.

Columns | Allows you to select which columns you wish to display.
Large Selects Large Icon view in the ListView.

Icons

Small g, ects Small Ion view in the ListView.

Icons

List Icons

Selects List view in the ListView.

Arrange

Details Selects Details view in the ListView.

Allows you to choose whether the Explorer displays objects in
Scope .

local scope or in global scope.
ﬁl(‘)l;lz;nge Sorts the items in the ListView by name, type, size or date.
Line up Rearranges the icons into a regular grid.
Icons
Auto If checked, the icons are automatically re-arranged when

appropriate
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The Tools Menu

Find...
Go to..

F3
Ctrl G

Go to Sessicn Space

Set Session space

The Tools menu, illustrated above, provides the following actions.

Find Displays the Find Objects Tool

Go to Prompts for a namespace and then opens that namespace in the
TreeView, displaying its contents in the ListView

Go to . . .

Session Opens the namespace in the TreeView control corresponding to
the current space in the Session.

Space

Set Session | Sets the current space in the Session to be the namespace that is

Space currently open in the TreeView.
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Browsing Classes

Classes are represented by lj icons. The picture below shows 3 classes: Bird,
Parrot and DomesticParrot.

B C\Dyalog15.0\Core\ws\Parrots.dws Explering [#]

File Edit Options View Tools

A BXQE »|ED@E| Y8l

Workspace Tree Contents of # (Global Scope)

Qi o
OsE - -
'ﬁil Typelibs Bird LA SNE Parrot
&%t MetaData Parrot

3 object(s). 62.83Mb free. 92312 bytes used (47408 bytes selected)

Ifyou open the # node in the left-hand pane, you see the contents of # as a tree.

B C:\Dyalog15.0\Core\ws\Parrots.dws Exploring [#]

File Edit Options View Tools

PRXQE ¢|EEEE| 4 el

Workspace Tree Contents of # (Global Scope)

--Ej DomesticParrot Bird DLILVIARES Parrot
Ej Parrot Parrot

=] 0sE

EEI--HiI Typelibs

Ea--]i'?t MetalData

3 object(s). 62.83Mb free. 92312 bytes used (47408 bytes selected)
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Browsing Class Scripts

Selecting DomesticParrot in the left-hand pane brings up its Class Script in the
right-hand pane.

alog15.0\Core\wshParrots.dws Exploring [#.DomesticParrot]

File Edit Options View Tools

TERXQE| | EEmE| 4ol e
Workspace Tree Contents of #.DomesticParrot
ézﬁﬁgHSearch... vl "paA|"“+p
:Class DomesticParrot: Parrot
[ iField Public name
[o] =] v egglname species)
[1] :hccess Public
fidt MetaData [2] :Implements Constructor :Base species
[3] ODF Name+name
[4] L v
[0] =] v eggl
[1] :hccess Public
[2] tImplements Constructor :Base 'Generic’
[3] OOF MName~'Polly’
[4] L v
[o] =] v Speak
[1] :hccess Public
[2] R+[IBASE,Speak ‘Who''s a pretty boy then!’
[3] v

:EndClass A DomesticParrot

Modified Class Pos: 19/21,4
3 object(s). 62.83Mb free. 92312 bytes used (47408 bytes selected)




Chapter 1: The APL Environment 76

... and selecting Parrot in the left-hand pane brings up the Class Script for
Parrot.

yalogl3.0\Core\ws\Parrots.dws Exploring [#.Parrot]

File Edit Options View Tools

T BXQE| > DEDE|Haelu

Workspace Tree Contents of #.Parrot
=-E ¥ =0 @ Q|[search. .. V% % maal ) e i1
- wmElsird -
:Class Parrot: Bird
[0 DomesticParrot
E:l [0] Gl ¥V egg species
=g OsE [1] :hccess Public Instance
ﬁilTYPEL"IhS [2] :Implements Constructor :Base 'Parrot: ', species
w-fét MetaData [3] ODF Name+name
[+] L v
[0] =] v Speak
[1] :Access Public
[21] R+'Squark!’
[3] L v
[0] =] v kill
[1] :Implements Destructor
[2] 'This Parrot is dead'
[3] v

T :EndClass & Parrot

Class Pos: 0/18,0
3 object(s). 62.82Mb free. 92312 bytes used (47408 bytes selected)
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... and finally, selecting B i rd in the left-hand pane brings up the Class Script for
Bird.

tn C\Dyalog15.00Core\ws\Parrots.dws Exploring [#.Bird]

File Edit Options View Tools

P BXQE| r|EEEE| el

Workspace Tree Contents of #.Bird
=0 P Q@ |[seerch... v S Eaalh et
:Class Bird
& :Field Public Species

[o] =] v egg spec

[1] thccess Public Instance
w-Jiét MetaData [2] :Implements Constructor

[3] Species~'spec’

[4] B v

[o] = v Speak

[1] :hccess Public

[2] R+'Tweet, tweet!’

[3] v

:EndClass A Bird

Modified Class Pos: 13/154

3 object(s). 62.82Mb free. 92312 bytes used (47408 bytes selected)
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If you open a Class node, a tree appears to help you to navigate within the Class
script. In the picture below, the user has opened the [Methods ] node and then
clicked on Speak. The system has responded by scrolling to (if necessary) and
highlighting the appropriate section of the script.

Br C\Dyalog15.00Core\ws\Parrots.dws Exploring [#.DomesticParrot]

File Edit Options View Tools

TBRXQHE| | EEEE| 4 el

Workspace Tree Contents of #.DomesticParrot
=@ # =0 @ |[search... vl % maal e il
Elsird —
&0 ticp ¢ :Class DomesticParrot: Parrot
’ vomes lcharra & :Field Public name
#71 [Constructor
#% [Fields] [0l =] v egg(name species)
=-#% [Methods] [1] :Access Public
. a [2] :Implements Constructor :Base species
w8 Parrot [3] ODF Mame+name
-2 OSE [+] L v
2 -
[]--?{?l Typelibs [0 = v egg0
w-fist MetaData [1] :Access Public
[2] iImplements Constructor :Base 'Generic’
[3] [ODF Name+'Polly’
[%] L v
(o] | [T
[1] :Access Public
[2] R+[JBASE,Speak 'Who''s a pretty boy then!'
[3] L v
:EndClass A DomesticParrot

< » | Class Pos: 15/21,0

3 object(s). 62.82Mb free. 92312 bytes used (47408 bytes selected)

78
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Browsing Type Libraries

When the View/Type Libraries option is enabled, the Workspace Explorer allows
you to:

o Browse the Type Libraries for all the COM server objects that are installed
on your computer, whether or not they are loaded in your workspace.

o Load Type Libraries for COM objects

o Browse the Type Library associated with an OLEClient object that is
already instantiated in the workspace.

If the Microsoft NET Framework is installed, you may in addition:

o Load Metadata for specific NET classes
o Browse the loaded Metadata, viewing information about classes, methods,
properties and so forth.

Ifthe Type Libraries option is enabled, the Workspace Explorer displays a folder
labelled TypeLibs which, when opened, displays two others labelled Loaded
Libraries and Registered Libraries as shown below.

BT CLEAR WS Exploring [#]

File Edit Options View Tools

TBXQE | QR E | H e

Workspace Tree Contents of # (Global Scc
. =1k Mame Type
(g OSE

EI--ﬁil Typelibs

ﬁil Loaded Libraries

: -Biil Registered Libraries
JE"[ MetaDats

£ >
0 object(s). 62.84Mb free. 0 bytes used (0 bytes selected)
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Browsing Registered Libraries

If you open the Registered Libraries folder, the Workspace Explorer will display in
the tree view pane the names of all the Type Libraries associated with the COM
Server objects that are installed on your computer.

If you select one of these Library names, some summary information is displayed in
the list view pane.

For example, the result of selecting the Microsoft Excel 12.0 Object Library is
illustrated below.

B CLEAR WS Exploring [Registered Libraries]

File Edit Options View Tools
TR XQE| | DEEE s

Workspace Tree Contents of Registered Libraries

@I Microsoft DirectX Al Attribute Yalue ~

Cl - -
~# Microsoft Disk Quc fLETIn I1ANN2 081 2=ANAN=OANA=CANA=0)] ()
----B{i‘H‘lcrosoft Excel 12.0 Object Library. (\'ersion:i.ﬁ,LocaLe:O)E
o
=

g Microsoft Excel 5.

4% Microsoft Fax Sers HelpDir C:\Program Files (x86)\Micros
a4 Microsoft Feeds 2. HelpFile C:\Program Files (x86)\Micres
@ Microsoft Forms 2.,,|| HelpID Ox0000Ffff v
< ) > £ >
0 object(s). 62.834Mb free. 0 bytes used (0 bytes selected)

Ifinstead, you select the Registered Libraries folder itself, the list of Registered Type
Libraries is displayed in the list view pane

B CLEAR WS Exploring [Registered Libraries]

File Edit Options View Tools

TRXQE| | REEE e

Workspace Tree Contents of Registered Libraries
..... # || Name L
(2 OSE

o Lib Microsoft DirectX Transforms Image Tra...
=4 Typelibs . i

: M ft Disk ta 1.0
#% Loaded Libraries 1crose isk Quota

B--ﬁil Registered Libraries Microsoft Excel 12.0 Object Library

:1.0,Loc Microsoft Excel 5.0 Object Library

(Version
(Version:2.0,Loc Microsoft Fax Service Extended COM Typ...

(Version:3.0,Loc Microsoft Feeds 2.0 Object Library
('\"l:rs"lc:n:ll-.CJ,Lc:l:IV Microsoft Forms 2.0 Object Library

L I I fur o - - - - -

< : > ||« 3]
0 object(s). 62.834Mb free. 0 bytes used (0 bytes selected)
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Loading a Type Library

You can load a library shown in the tree view pane by selecting Load from its
context menu.

In either case, a message box will appear asking you to confirm. The operation to
load a Type Library may take a few moments to complete.

Notice that if the selected Library references any other libraries, they too will be
loaded. For example, loading the Microsoft Excel 12.0 Object Library brings in the
Microsoft Office 12.0 Object Library and the Microsoft Visual Basic for
Applications Extensibility 5.3 Library too. It also contains references to a general
library called the OLE Automation Type Library, so this is also loaded.

When you ) SAVE your workspace, all of the Type Libraries that you have loaded
will be saved with it. Note that type library information can take up a considerable
amount of workspace.
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Browsing Loaded Libraries

If you have already loaded any Type Libraries into the workspace, using the
Workspace Explorer or as a result of creating one or more OLEClient objects, you
can select and open the Loaded Libraries folder.

The picture below illustrates the effect of having loaded the Microsoft Excel 12.0
Object Library.

BN CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools

PR XQE| | [0 EE| e

Workspace Tree Contents of Loaded Libraries
----- =¥ ~ || Name Loaded CLSID
=8 ESE s OLE Automation Yes {00020%
=-3 Typelibs
; Unk T Y 2FC63B
Bs{il Loaded Libraries n newn YpES- - es - { |
\‘ﬂl Microsoft Excel 12.0 Microsoft Office 12.0 Object Library iBDO
ﬂfil Microsoft Office 12.0 Micresoft Visual Basi... Yes {0002E19
ﬁil Microsoft Visual Basi Microsoft Excel 12.0 ... Yes {000208
i --sfiIOLE Automation
@-#%1 Registered Libraries w
L4 > < >
0 object(s). 62.84Mb free. 0 bytes used (0 bytes selected)

Notice that any external references to other libraries causes these to be brought in
too.

If you select a loaded Type Library, summary information is displayed in the list
view pane.

If you open a loaded Type Library, four sub-folders appear named Object CoClasses,
Objects, Enums and Event Sets respectively.
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Object CoClasses

A Type Library describes a number of objects. Typically, all of the objects have
properties and methods, but only some of them, perhaps just a few, generate events.
Objects which generate events are represented by CoClasses, each of which has a
pointer to the object itself and a pointer to an event set.

For example, the Microsoft Excel 12.0 Object Library contains seven CoClasses
named Application, Chart, Global etc as shown below.

B CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools

TEBXQE| | OE@EE| el

Workspace Tree Contents of Loaded Libraries
----- En# A || Name CLSID
=@ ?SE s Application {00024500-0000-(
2403 Typelibs ) Chart {00020821-0000-0
=-41 Loaded Libraries
; Eiﬂfil Microsoft Excel 12.0 Global {00020812-0000-(
! G4 0bject CoClasses OLEObject {00020818-0000-0
2% Objects QueryTable {59191DA1-EA4T-1
a{:l Enums Workbook {00020819-0000-(
P -0 Event Sets v || Horksheet {00020820-0000-(
< > < >

0 object(s). 62.84Mb free. 0 bytes used (0 bytes selected)
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Opening the Application folder you can see that the Application CoClass comprises
the Application object coupled with the AppEvents event set as shown below.

(% CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools
| mBEXqQE o EEEE LA

Workspace Tree

Contents of Loaded Libraries

..... # A I
-5 Ose Name Application
I:—]‘ﬁil Typelibs CLSID {00024%500-0000-00
B-#'l Loaded Libraries HelpString
|_=_|s{il Microsoft Excel 12.0 Object Library HelpFile C:\Program Files

B4l Object CoClasses HelpID 0x00020001

L—"_Is{il Application

EHH:I Event Sets

s{:l AppEvents

EH!CI Interfaces

ﬁ:l _Application

m-4% Chart

@45 Global

@45 OLEObject

[]--ﬁ:l QueryTable

@451 Wor kbook

-3 Worksheet W
> < >

|1 object(s). 60.16Mb free. 20536 bytes used (0 bytes selected) 4

L4

The specific methods, properties and events supported by the CoClass object can be
examined by opening the appropriate sub-folder. The same information for these and

other objects is also accessible from the Objects and Event Sets folders as discussed
below.
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Objects

The Objects folder contains several sub-folders each of which represents a named
object defined in the library.

Each object folder contains two sub-folders named Methods and Properties. Selecting
one of these causes the list of Methods or Properties to be displayed in the list view
pane. The picture below shows the Methods exposed by the Microsoft Excel 12.0
Range object.

ploring [Loaded Libraries]

File Edit Options View Tools

TR XAQHE| | EBEEE| e
Workspace Tree Contents of Loaded Libraries
-4 Points 1| Name Result 2
@41 Protection Activate VT_VARIANT
SE EEE:;:EE;:E:S AddComment Comment
-4 QueryTables AdvancedFilter VT_VARIANT
2-4% Range ApplyNames VT_VARIANT
I Met hods ApplyOutlineStyles VT_VARIANT
s{il Properties AutoComplete YT_BSTR
E]--s{il Ranges AutoFill VT_VARIANT
-4 RecentFile Autofilter VT_VARIANT
EJ"“‘%‘ RecentFiles AutoFit VT_VARIANT
i) Rectangle AutoFormat VT_VARIANT
i) Rectangles ¥l Autadutiine VT VARTANT ¥
£ > £ >

0 ohject(s). 62.51Mb free. 0 bytes used (0 bytes selected)
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If you open the Methods or Properties subfolder, you can display more detailed
information about individual Methods and Properties. For example, the following
picture shows information about the SaveAs method exposed by the Microsoft Excel
12.0 Worksheet object.

ploring [Loaded Libraries]

File Edit Options View Tools

TR XQE| | EE@maE 4 slelal
Workspace Tree Contents of Loaded Libraries
- PrintOut

2 - -

s{:l PrintPreview Name SaveAs
-3 Protect Help Stri

e rin
-1 Rectangles P 9
3% ResetAllPageBreaks HelpID 0x00010785
N Sovehs) DispID 0x00000785
3% Scenarios
% Scrol lBars Result VT_VOID
-3 Select
-3 SetBackgroundPicture Arguments:

2
s{:l ShowAllData Filename VT_BSTR [in]
+#) ShowDataform FileFormat VT_VARIANT [Optionall,[in]
-1 Spinners _ _

" Password VT_VARIANT [Optional],[in]
-3 TextBoxes i ! !
L Unprotect WriteResPassword VT_VARIANT [Optional],[in]
%) XmlDataQuery ReadOnlyRecomm... VT_WVARIANT [Optional],[in]
| ¥mlMapQuery CreateBackup YT_VARIANT [Optional],[in]
W Properties AddToMru VT_VARIANT [Optional],[in]
boveAverage TextCodepage VT_VARIANT [Optional],[in]
ction TextVisuallayout VT_VARIANT [Optional],[in]
ctions Local VT_VARIANT [Optional],[in]
£

0 ohject(s). 62.51Mb free.

0 bytes used (0 bytes selected)

This tells you that the SaveAs method takes up to 10 parameters of which the first,
Filename, is mandatory and is of data type VT BSTR (a character string). Note that
[in] indicates that the parameter is an input parameter.
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Incidentally, the optional Fileformat parameter is an example of a parameter whose
value must be one of a list of Enumerated Constants. Even without looking at the
documentation, the possible values can be deduced by browsing the Fnums folder,
with the results shown below.

B CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools

FBRXQE| | EEEE| 4 e

Workspace Tree Contents of Loaded Libraries
%1 XlEnableCancelKey || Name Value »
-] -
st :
n yleCap
LCSY [+]
41 X1ErrorBarDirection *
40 XLErrorBarInclude x1C5¥Mac 22
-3 XLErrorBarType xLC5VM5DO0S 24
a{il ¥lErrarChecks » lCSVWindows 23
4050 XLFileAccess xLDBF2 7
WLl LFileFormat % LDBF3 g
- XLFiLLWith «LDBF4 11
a{;l %LFilterAction < LDIF 9
....Hit:jL;frﬁll;;Dates[nPer'lod L:LE:-:::ELE 16
-8 indLookIn
LE l2Fartast 27
851 XIFixedFormatQuality xrExCE arees
-39 XlFixedFormatType xlExceld 29
-3 ¥XlFormatConditionOper: xlExcelk 33
3 XLFormatCenditionType ®lExceld 39
&% XLFormatFi LterTypes xlExcel? 39
-85 X1 FormControl % |Excel@795 43
-8 XLFormulalabel « || xLExcel4Workbook 35 y
TP T i oA e |
£ > £ >
0 object(s). 62.51Mb free, 0 bytes used (0 bytes selected)

You can therefore deduce that the following expression, executed in the namespace
associated with the currently active worksheet, will save the sheet in comma-
separated format (CSV) in a file called mysheet.csv:

SaveAs 'MYSHEET.CSV' xLCSV
or

SaveAs 'MYSHEET.CSV' 6
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Event Sets

The Event Sets folder contains several sub-folders each of which represents a named
set of events generated by the objects defined in the library.

If you open one of these event sets, the names of the events it contains are displayed
in the tree view pane. If you then select one of the events, its details are displayed in
the list view pane as shown below.

B CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools

TERXQE| » DEEE] 40

Workspace Tree Contents of Loaded Libraries
..... B # A
w-EOse Name SheetActivate

[—]sﬁl Typelibs

: Help 5tri
-4l Loaded Libraries elp ring

54 Microsoft Excel 12.0 Obj, | HelpID 0x00010619
G146 Object CoClasses DispID 0x00000619
w48 Objects
-4 Enums Result VT_VOID
Bﬁil Event Sets

E“ﬁil AppEvents Arguments:
=40 Events Sh VT_DISPATCH

Lg% AfterCalculate
4%l NewMorkbook

Wil SheetActivate
4" SheetBeforeDoub

i aiil SheetBeforeRighw
< 5 | < >

0 object(s). 62.51Mb free. 0 bytes used (0 bytes selected)

This example shows that when it fires, the SheetActivate event invokes your
callback function with a single argument named S% whose datatype is VT _
DISPATCH (in practice, a Worksheet object).
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Enums

The Enums folder will typically contain several sub-folders each of which represents
anamed set of enumerated constants.

If you select one of these sets, the names and values of the constants it contains are
displayed in the list view pane as shown below.

B CLEAR WS Exploring [Loaded Libraries]

File Edit Options View Tools

TBXQE| | EEEE| e

Workspace Tree Contents of Loaded Libraries
""" e # * || Name Value *
&-E OSE x| 24HourClock 33

E—:l--ﬁ:l Typelibs

Elﬂiil Loaded Libraries xlsDigityears 43
Elﬁil Microsoft Excel 12.0 Obji xlAlternateArraySepar... 16
&-#% Object CoClasses xlColumnSeparator 1%
w-3% Objects ®*lCountryCode 1
-4 Enums x| CountrySetting 2
3’1 Constants xlCurrencyBefore 37
-1 XLAboveBelow x| CurrencyCode 25
Bi;l XlActi ?"Tﬂ?e Il ¥l CyrrencyDigits 27
e e reneentingteros 10
4% XLArabicModes xlCurrencyMinus5Sign 38

i XlArrangeStyle wll * LCurrencyNegative 28 v

< > (IH ) T o >

0 object(s). 62.51Mb free. 0 bytes used (0 bytes selected)
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Browsing .NET Classes

Microsoft supplies a tool for browsing .NET Class libraries called TLDASM.EXEL

As a convenience, the Dyalog APL Workspace Explorer has been extended to
perform a similar task as TLDASM so that you can gain access to the information
within the context of the APL environment.

The information that describes .NET classes, which is known as its Metadata, is part
of'the definition of the class and is stored with it. This Metadata corresponds to Type
Information in COM, which is typically stored in a separate Type Library.

To gain information about one or more .NET Classes, open the Workspace Explorer,
right click the Metadata folder, and choose Load.

B CLEAR WS Explering []

File Edit Opticns View Tools

TBRXQE| | EEEE e

Workspace Tree
o it
OsE
'ﬁil Typelibs There is no viewable content for the selected item

Jﬁt MetaData

0 object(s). 48.79Mb free. 0 bytes used (0 bytes sele

1 ILDASM.EXE can be found in the NET SDK and is distributed with Visual Studio
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This brings up the Browse .NET Assembly dialog box as shown below. Navigate to
the .NET assembly of your choice, and click Open.

BN Browse NET Assembly

“

Organize +

v <« Frameworktd

MNew folder

Media
medias
Microsoft. MET
assembly
authman
Framewaork
Frameworkfd
Managed DirectX
Migraticn
MiracastView
ModemLogs
OCR

* Panther

Performance

N

LU 4

» v4.0.30319

Name

Micresoft. Windows. ApplicationServer.Ap...

MrncAspExt.dll
mscordacwhs.dll
mscordbi.dll
mscoreei.dll
mescoreeis.dll
mscorlib.dll
mscorpe.dll
mscorpehost.dll
mscorre.dll
mscorsecimpl.dll
mscarsn.dll
mscorsve.dll

ngentasklauncher.dll
THoa .

v O

File name: | mscorlib.dll

Search v4.0.30319 =

=~ [ @
Date modified ~
30/10/2015 09:19
30/10/2015 0
24/03/2016 04:20
24/03/2016 04:20

30/10/2015 0819

30/10/2015 09:19
24/03/2016 04:20

30/10¢2015 09:19

30/10/2015 09:19

30/10/2015 0%:19

30/10/2015 0%:19

30/10/2015 0819

30/10/2015

30/10/2015 09:19

v| .NET Assemblies (*.dll) v

Cancel
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The .NET Classes provided with the NET Framework are typically located in
C:\WINDOWS\Microsoft.NET\Framework64\V4.0.30319 (on a 64-bit
computer). The last named folder is the Version number.

The most commonly used classes of the .NET Namespace System are stored in this
directory in an Assembly named mscorlib.d11,along with a number of other
fundamental NET Namespaces.

The result of opening this Assembly is illustrated in the following screen shot. The
somewhat complex tree structure that is shown in the Workspace Explorer merely
reflects the structure of the Metadata itself.

BN CLEAR WS Exploring []

File Edit Options View Tools
TRXQE | EEEE|H6elal

Workspace Tree

t &ilTypeLibs
BM MetaData
E|Ji'?t Loaded Metadata
BJ&‘T mscorlib
E|Jﬁ'r Modules
&}ﬁﬁ C:\Windows\Microsoft .NET\Framework6&4\vk.0.30319 mscorlib.dlLlL
Jiégt [Unnamed]
Microsoft.Wind2
Jift Microsoft.Win32.5afeHandles

.Collections
.Collections.Concurrent
.Collections.Generic
.Collections.0ObjectMadel
.Configuration.Assemblies
.Deployment.Internal
.Deployment.Internal.Isolation
.Diagnostics
.Diagnestics.CodeAnalysis
.Diagnostics.Contracts
.Diagnostics.Contracts.Internal
.Diagnestics.S5ymbolStore
.Diagnostics.Tracing
.Globalization

LI0 ']

0 object(s). 48.79Mb free. 0 bytes used (0 bytes selected)
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Opening the System/ Classes sub-folder causes the Explorer to display the list of
classes contained in the .NET Namespace System as shown in the picture below.

B CLEAR WS Exploring []

File Edit Options Wiew Tools
7 B X Q|

Workspace Tree

| EEE S| 4l elal

<

O-fiét System

Tt System.

: Tt System

Tt System

JE"[‘ System

_ ComObject

._AppDomain
Tt System.
Tt System.
Tt System.
.Action™2
.Action™3
LAction™h
.Action™B
.Action™é
LAction™7
.Action™8
.ActivationContext

AccessViolationException
Action
Action™i

.Activator
.Aggregatebxception
.AppContext

-AppDomain
.AppDomain+CAPTCASearcher
Tt System.

AppDomain+EvidenceCollection

.AppDomain+NamespaceResolverForIntrospection
' Tt System.
Tt System.
Tt System.

AppDomainlnitializer
AppDomainlnitializerInfosltemInfo
AppDomainManager

.AppDomainSetup

0 object(s). 42.79Mb free.

0 bytes used (0 bytes selected)
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The Constructors folder shows you the list of all of the valid constructors and their
parameter sets with which you may create a new instance of the Class by calling
New. The constructors are those named .ctor; you may ignore the one named .cctor,
(the class constructor) and any labelled as Private.

For example, you can deduce that DateT ime . New may be called with three
numeric (Int32) parameters, or six numeric (Int32) parameters, and so forth. There
are in fact seven different ways that you can create an instance ofa DateTime.

Y CLEAR WS Exploring []

File Edit Options View Tools
TBRXQE| | EEEE|Halsln

Workspace Tree

[ER e System.DateTime "

Base Class

&t Constructors

.Jét (Private)Void .cctor()

LBt (Private)Void .ctor(Inté4%, System.DateTimeKind, Boolean)

Bt (Private)Void .ctor(System.Runtime.Serialization.Serialization
Bt (Private)Void .ctor (ULnté4)

LBt Void .ctor(Int32, Int32, Int32)

Xt Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32)

.J#t Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32)
.t Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, Sy
-5t Yoid .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int3d2, Sy
LBt Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, Sy
Hét Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, System.Da
Tt Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, System.Gl
LTt Void .ctor(Int32, Int32, Int32, System.Globalization.Calendar)
.Jét Void .ctor(Inté4)

Bt Void .ctor(Inté4, System.DateTimeKind)

-5t Fields

-5t Methods

[]--J@T Properties W
< >
0 object(s). 48.79Mb free. 0 bytes used (0 bytes selected)

For example, the following statement may be used to create a new instance of
DateTime (09:30 in the moming on 30th April 2001):

mydt<[NEW DateTime (2001 4 30 9 30 0)

mydt
30/04/2001 09:30:00
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The Properties folder provides a list of the properties supported by the Class. It
shows the name of the property followed by its data type. For example, the
DayOfYear property is defined to be of type Int32.

BN CLEAR WS Exploring []

File Edit Options View Tools
TBRXQE | EDE@EE| 46 el
Workspace Tree
Ji'?t Base Class
Ji‘ar Constructors
w5t Fields
-5t Methods
E|Ji'?t Properties
~J#t (Private)InternalKind : System.UIntéb
Jift (Private)InternalTicks : System.Intéb
-Jét Date = System.DateTime
Tt Day : System.Int3?
Tt DayOfWeek : System.DayOfWeek
it DayOfY¥ear @ System.Int3dz
Tt Hour : System.Int3z2
LJEt Kind s System.DateTimeKind
~J#t Millisecond : System.Intd?2
Jift Minute : System.Intd?2
.Jé&t Month : System.Int32
Tt Now s System.DateTime
.J&t Second : System.Intd?2
dift Ticks : System.Intél
Tt TimeOfDay : System.TimeSpan
Tt Today : System.DateTime
J#t UtcNow : System.DateTime

it Year : System.Int3? ha
P >

0 object(s). 48.79Mb free. 0 bytes used (0 bytes selected)

You can query a property by direct reference:

mydt.DayOfWeek
Monday



Chapter 1: The APL Environment 96

Notice too that the data types of some properties are not simple data types, but

Classes in their own right. For example, the data type of the Now property is itself
System.DateTime. This means that when you reference the Now property, you
get back an object that represents an instance ofthe System.DateTime object:

mydt.Now
07/11/2001 11:30:48
aTs
2001 11 7 11 30 48 O

The Methods folder lists the methods supported by the Class. The Explorer shows the
data type of the result of the method, followed by the name of the method and the
types of its arguments. For example, the IsLeapYear method takes an Int32
parameter (year) and returns a Boolean result.

mydt.IsLeapYear 2000

BT CLEAR WS Exploring []

File Edit Options View Tools
TBRXQE| | EE@EE| el

Workspace Tree

-Jét Boolean Equals{System.DateTime) "
..Jét Boolean Equals(System.DateTime, System.
..Jift Boolean Equals{System.0Object)

.5t Boolean IsDaylightSavingTime()

W dBoolean IsLeapYear(Int32)

..Jét Boolean np_EquaLity{System.DateTime, Sy
..Jift Boolean ap_GreaterThan{System.DateTime,
..Jét Boolean up_GreaterThanﬂrEquaL{System.Da
..Jét Boolean np_InequaLity{System.DateTime,
..Jét Boolean np_LessThan{System.DateTime, Sy
..Jift Boolean cp_LessThanﬂrEquaL{System.DateT
..Jét Boolean TryParse(System.5tring, System.
..Jét Boolean TryParse(System.5tring, System.
..Jét Boolean TryParseExact(System.S5tring, Sy
..Jift Boolean TryParseExact(System.5tring, Sy
-.Jiét Double ToOADate() v
£ >

0 object(s). 48.79Mb free. 0 bytes used (0 bytes selected)
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Many of the reported objects are listed as Private, which means they are inaccessible
to users of the class — you are not able to call them or inspect their value. For more

information about classes, see Language Reference Guide: Object Oriented

Programming.

BY CLEAR WS Explering []

File

T B X QE

Options  View Tools

Workspace Tree

£

BN (Private)Yoid Finalize()

.Jé&t (Private)Yoid System.Runtime.Serializat
-1t Boolean
Tt Boolean
..Jét Boolean
It Boolean
-1t Boolean
Tt Boolean
..Jét Boolean
It Boolean
-1t Boolean
Tt Boolean
..Jét Boolean
It Boolean
-1t Boolean
Tt Boolean
..Jét Boolean
-5t Double ToOADate()
Tt Int3z Eumpare{ﬁystem.DatETime, System.D .,

| EEEE| 46 el el

Equals(System.DateTime)
Equals(System.DateTime, System.
Equals{System.0Object)
IsDaylightSavingTime()
IslLeapYear(Int32)
ap_EquaLity{System.DateTime, Sy
up_GreaterThan{System.DatETimE,
np_GreaterThanDrEquaL{System.Da
ap_InequaLity{System.DatETimE,
ap_LessThan{System.DatETimE, Sy
up_LessThanDrEquaL{System.DatET
TryParse(System.5tring, System.
TryParse(System.S5tring, System.
TryParseExact(System.5tring, Sy
TryParseExact(System.5tring, Sy

>

0 object(s). 48.79Mb free.

0 bytes used (0 bytes selected)
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Find Objects Tool

The Find Objects tool is a modeless dialog box that may be toggled on and off by the
system action [WSSearch]. In a default Session, this is attached to a Menultem in
the Tools menu and a Button on the session toolbar. This tool allows you to search
the active workspace for objects that satisfy various criteria.

The first page allows you to specify the name of the object which you wish to find
and the namespace(s) in the workspace that are to be searched for it.

= Find Objects

File Edit View Columns Search

X B B @ B #4 o = o
Delete Props Large Small List  Details | MName Size Date Type
Mame/Location Modified Advanced
Mamed: | | Stop
Y ariahlesz Functions Operatars MNamespaces Mew Search
Look i | | Close
Ihclude sub-namespaces Include Session namespace

You type the name of the object you wish to find into the field labelled Named. To
locate all objects beginning with a particular string, enter the string followed by a 'x'
character. For example, if you enter the string FOO*, the system will locate all objects
whose name begins with FOO.

Four check boxes are provided for you to specify the types of objects you wish to
locate. For example, if you clear Variables, Operators and Namespaces, the system
will only search for functions.
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You can restrict the search to a particular namespace by typing its name into the field
labelled Look in. Y ou can also restrict the search by clearing the Include sub-
namespaces and Include Session namespace check boxes. Clearing the former
restricts the search to the root namespace or to the namespace that you have specified
in Look in, and does not search within any sub-namespaces contained therein.
Clearing the latter causes the system to ignore [JSE in its search.

The second page, labelled Modified, allows you to search for objects that have been
modified by a particular user or at a certain time

= Find Objects

File Edit View Columns Search

X @ | B 8 @ 3|88 s W
Delete Props Large Small List Details | Mame Size Date Type

Mame/Location Modfied = Advanced

Modified Objects

Stop
Modified by | |
New Search
() Any date ew Sea
(®) between |D?‘£D4£2EI1 E | Close
and |0?30532ms |

() during the previous 1 > | months]

() during the previous q = day(s]

To make the search dependent upon modification, you must check the Modified
Objects check box.

To locate objects modified by a particular user, enter the user name in the field
labelled Modified by. Otherwise leave this blank.

To find objects which have been modified at a certain time or within a specified
period of time, check the appropriate radio button and enter the appropriate dates or
time spans.
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The third page, labelled Advanced, allows you to search for objects that contain a
particular text string.

= Find Objects

File Edit View Columns Search

X ®| 8 8 @ 3| 8 &8 = 8
Delete Props Large Small List  Details | MName Size Date Type

Mame/Location Modfied Advanced

Containing Text: | ™ | Stop

[JMatch Case [ tatch Whale \Waord Mew Search
[JUse Reqular Expressions [ Az Symbal Reference Close
[J5ize between 0 i

If you wish to search for objects containing a particular character string, type the
string into the field labelled Containing Text.

Match Case specifies whether or not the text search is case sensitive.

Use Regular Expressions specifies whether or not regular expressions are applicable.
For example, if you enter FOO* into the field labelled Containing Text and check
this box, the system will find objects that contain any text string starting with the 3
characters FOO. If this box is not checked, the system will find objects that contain
the 4 characters FOOx*. Text searches are performed using PCRE. If the Use Regular
Expressions box is checked, the full range of regular expressions provided by PCRE
are available for use. See Language Reference Guide: Appendix A.

Match Whole Word specifies whether or not the search is restricted to entire words.

As Symbol Reference specifies whether or not the search is restricted to APL symbols.
If so, matching text in comments and other strings is ignored.

If you wish to restrict the search to find only objects whose size is within a given
range, check the box labelled Size is between and enter values into the fields
provided.
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When you press the Find Now button, the system searches for objects that satisfy all
ofthe criteria that you have specified on all 3 pages of the dialog box and displays
themin a ListView. The example below illustrates the result of searching the
workspace for all objects containing references to the symbol Speak.

= Find Objects

File Edit View Columns Search

@ B @ B8 # o =l ol

Delete Props Large Small List Details| Mame Size Date Type

Mame/Location Modfied Advanced
Containing Text: | peak ~ | Stop
[JMatch Caze [1Match whale ‘ward MNew Search
[[]Use Regular Expressions  [+] Az Symbol Reference Close

[ %ize between | 0 1]

Name Location Type Description 5
Esird # Class Namespace 14.0
EdDomesticParrot # Class Namespace 46.
Edparrot # Class Namespace 29.8
< >

3 ohject(s) found in Local Scope

You may change the way in which the objects are displayed in the ListView using
the View menu or the tool buttons, in the same manner as for objects displayed in the
Workspace Explorer. You may also edit, delete and rename objects in the same way.
Furthermore, objects can be copied or moved by dragging from the ListView in the
Search tool to the TreeView in the Explorer.

If you wish to specify a completely new set of criteria, press the New Search button.
This will reset all of the various controls on the 3 pages of the dialog box to their
default values.
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Object Properties Dialog Box

The Object Properties dialog box displays detailed information for an APL object. It
is displayed by executing the system action [Ob jProps ]. In a default Session, this
is provided in the Tools menu, the Session popup menu and from the Explorer. An
example (for a function) is shown below.

Properties Tab

The Properties tab displays general information about the object. For a function, this
includes an extract from its header line, when it was last modified, and by whom.

ZH #.CENTRE - Properties

Properties  Value = Monitor

a CENTRE

Type Function
Dezcription

Location  #

Size 1.727Kb (1768 bytes)

Modified 04 Mowvemnber 1993 14:35

By Diyadic:
Locked External
Shared Exported

Cancel
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Value Tab

For a variable, the Values tab displays the value of the variable. For a function, it
displays its canonical representation.

= #.CENTRE - Properties

Propetties  Value  Monitor

¥ TEXT+W CENTRE TEXT;SPCS:FORE:BACK A Centre TE!
[1] TEXT=( (" 14pTEXT) ,WItTEXT A Stretch t
[2] SPCS~TEXT="' °* A Identify
[3] FORE++/A\S5PCS A Number of
[%] BACK++/a\®5SPCS A -
[5] TEXT-([0.5=FORE-BACK )$TEXT A Rotate ea
v
£ >




Chapter 1: The APL Environment 104

Monitor Tab

The Monitor tab applies only to a function and displays the result of JMONITOR.
The Reset button resets JIMONITOR for the lines on which it is currently set. The Set
All Lines button sets JMONITOR to monitor all the lines in the function. The Clear
All Lines switches JMONITOR off.

= #.CENTRE - Properties

Propetties  Value  Monitor

Line Mumber Count CPU time (ms) Elapsed time (ms)
0 48288 203 228
1 48288 7 57
2 48288 10 32
3 48288 0 20
4 48288 32 28
5 48288 E) 38
Reszet Set All Lines Clear All Lines

Cancel
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COM Properties Tab

The COM Properties tab applies only to a function in an OLEServer or
ActiveXControl namespace. The tab is used to define arguments and data types for
an exported Method or Property. For further information, see Interface Guide.

= #.Loan.CalcPayments - Properties

Properties  Value Monitor COM Properties

Param Mame Type b odifier Optional
Result WT_Ra w | T _ARRAT

Loardmt WT_I4 - - [l
Lentdax WT_I4 w~ e ]
Lertdin YT 14 e e ]
[rithd & YyT_14 w ~ [
Inthin [T 3] v v O

Help | | ID| |

(®) Method () Prop Get () Prop Set | |

Exparted

Cancel
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Net Properties Tab

The Net Properties tab applies only to a function in a NetType namespace. The tab is
used to define arguments and data types for an exported Method or Property. For

further information, see .NET Interface Guide. .

= # APLClasses.[Primitives].IndexGen - Properties

Propeties  Value Monitor NET Properties

Faram Mame Type b odifier Optional
Result Int32[] e e
Murmber [rt32 w ~ [

(®) Method ()wieb Method () Prop Get () Prop Set |

Public [ 5tatic [ *irtual [ Constructor
[ Protected

Cancel
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The Editor
Invoking the Editor

The editor may be invoked in several ways. From the session, you can use the system
command ) ED or the system function [JED, specifying the names(s) of the object(s) to
be edited. You can also type the name of the object and then press Shift+Enter (ED),
click the Edit tool on the tool bar, or select Edit from the Action menu. If you invoke
the editor when the cursor is positioned on the empty input line, with a suspended
function in the State Indicator, the editor is invoked on the suspended function and
the cursor is positioned on the line at which it is suspended. This is termed naked
edit. These ways of invoking the editor apply only in the session window

&) File Edit Syntax Window Refactor View - 5 X
= A & g”search... x V|+p “ @ s fal

[0] I{F:_E}BUILD_SESSION LANG ;0BT ;MSG;0I0;OML ;OLD ; NEW;FN;MB p A&
[1] A Build the session object and save if desired

[2] :If O=[NC'NoPrompt’' ¢ NoPrompt<0 ¢ :EndIf

[3] :If O=0ONC'FILE' ® FILE+"" ¢ :EndIf

[%]

[5] OWX-OSE.OWX-1 o OML OI0~1 ¢ OPATH-'#.Trans'

[&] OPW+122 A allows room for Status Bar

[7] LANG+upCase,LANG A translation assumes uppercase

[8] UNICODE-80=0DR" '

[9]

[10] ("Unknown language, pick one of',sTrans.CODES)OSIGNAL( »
[11]

[12] :If GUI+-'Windows ' '=7t0I0=[0WG'APLYERSION'

[13] T 'Ose'OWS 'Coord’ 'ScaledPixel’

[1&] tEndIf

[15]

[1a] A Expunge MenuBar(s), StatusBar(s), ToolBar(s), TipFielp¥
£ >
Function Pos: 0/182,1

In addition, there is a general point-and-edit facility which works in edit and trace
windows too. Simply position the input cursor over a name and double-click the left
mouse button. Alternatively, you can press Shift+Enter or select Edit from the File
menu. The name can appear in the Session, in an Edit window, or in a Trace window;
the effect is the same. Note that, in the Session, typing a name and pressing
Shift+Enter is actually a special case of point-and-edit. Note also that a naked edit
can be invoked by double-clicking the left mouse button in the empty input line.



Chapter 1: The APL Environment 108

The type of a new object defaults to function/operator unless the object is shadowed,
in which case it defaults to a variable (vector of character vectors). You can however
specify the type of a new object explicitly using ) ED or JED. For example, typing
")ED eLIST -MAT"ina CLEAR WS would create Edit windows for a vector of
character vectors named LIST and a character matrix called MAT. See ) ED or [JED for
details.

If the name is not already being edited, it is assigned a new edit window. If you edit a
name which is already being edited, the system focuses on the existing edit window
rather than opening a new one. Edit windows are displayed using the colour
combination associated with the type of the object being edited.
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Window Management (Standard)

Unless Classic Dyalog mode is selected (Options/Configure/Trace/Edit), the Editor
is a Multiple Document Interface (MDI) window that may be a stand-alone window,
or be docked in the Session window. Each of the objects being edited is displayed in
a separate sub-window. Individual edit windows are managed using standard MDI
facilities.

i
File Edit Syntax Window Refactor View

&) BUILD_SESSION EXEER
ﬂ & ﬂ||59arch,,. w v|-)p < da T |

[o] ! {FILE}BUILD_SESSION LANG;OBI:;MSG:OIO:OMM A
[1] { A Build the session object and save if d
[2] :If O=0NC'NoPrompt’ ¢ NoPrompt+0 ¢ :Endp
[3] :If O=[ONC'FILE' & FILE='" & :EndIf

[5] - BUILD_MB_FIL
E?% ﬂ &l °||Search... x V|".D o Aa Ral
[&] [0l ME BUILD_MB_FILE LANG ~
< [1] dcs ™s

[2]
[3] ‘file'0WC'Menu’ (LANG TranslateString'&Fip
[%]
[5] 'file.clear 'OWC'Menultem' (LANG Translate p
[&] "file.clear 'OWS 'Event’ 'Select’ '[wsclea)
[7] "file.clear 'OWS 'Hint ' (LANG TranslateStripw
< b3

Function Po...

The first edit sub-window window is created at the position specified by the edit
first_y and edit_first x parameters which are specified in terms of the size of a
character in the current font relative to the top-left corner of the main Editor window.
Subsequent ones are staggered according to the values of the edit_offset_y and edit
offset_x parameters.

The initial size of an edit window is specified by the edit_rows and edit_cols
parameters.
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By default, the Session has the Editor docked along the right edge of the Session
window. When you edit a function, the Editor window automatically springs into
view as illustrated below.

File Edit View Windows Session Log Action Options Tools Threads Help
ws 13 i—li-..JH"f \ Object @@ @EE‘SE ‘Too\,o r }—3@| Edm@ﬁj ‘9 Q‘| Session - [APL3g5 Uricode | 162]
AT S x| x
- - [}
[BEEER0ER0E] |||fM \ \ [ L[]l QF<[0fal¥] [a]ele]v[[] | | [HRED "\@\ (oDl [+l a
supported Langusges. (Note that the order of the contents of this varisble ~l
is important and should not be sltered)
For example, to redefine the session with an Italian look try
BUILD_SESSION 'IT'
n Windows to mske the changes permanent, you should save your session when
prompted or via the menu item Session/Seve or Save es...
n all platforms (including Windows) you can can call the function SaveSession:
en empty argument uses the current value of 'OSE'DWG'File’., and 2 non empty is
used as the file name to be written to.
Remember that it is best not te overwrite the session file in the Dyalog
installation directory, and that you will probably need to run with root or
edministrator permisssions should you wish to do so.
n non-Windows platforms, if you use other than the default session file
location, you should set the SESSION_FILE environment variable.
You can also reset SALT here by doing
BootSALT
Dyalog 2017
Version 3.08
vl 5
£
Debugger aox | <
Ready. .. Ins NUM
CurObj: 8:1 0OpQ:0 OTRAP  [OSI:0 QIO:1 [ML:0

Fie Edit Syntac Window Refactor View
W g S G WY Ohet @ @ N AM ‘Tﬂo\ P = 8 | Bt g ) 9 @ | Session o [APLBUNod:  ~ [ 16[Z]

g

-|=] - 1rit
OEE ol l l ‘ ‘l 0 ) BUILD_SESSION =]
~ = —
For example, to redefine the session with an Itali : i= A4 °|_ l ma B

o] § {FILE)BUILD_SESSION LANG;0E1:MSG;0I0:0 M A

A Build the session object and save if P

1 IF UZDNC‘NaPrnmpL‘ © NoPrompt+0 & :En )
INC'FILE' ¢ FILE='"' ¢ :EndIf

BULLD_SESSION "IT"

n Windows to make the changes permanent, you shou
prompted or via the menu item Session/Save or Save

n all platforms (including Windows) you can can c 2 ='
en empty argument uses the current value of ‘[SE'[ Q[searen. % o[ S E o m
lused s the file neme to be written to.
: Mi BUILD_MB_FILE LANG
Ocs M8

Remember that it is best not to overwrite the sess
installation directory, and that you will probably

edministrator permisssions should you wish to do s file'MC Menu' (LANG TranslateString'&File’)

“file.clear 'INC'Menultem' (LANG TranslateStri »
“file.clear'INS'Event’ 'Select’ '[wsclear]
‘file.clear 'OWS'Hint'(LANG TranslateString'C »

n non-Windows platforms, if you use other than th
location, you should set the SESSION_FILE environm

‘file.load'OWC 'Menultem' (LANG TranslateStrin »
‘file.load'OWS'Event’ ‘Select’ '[wsload]’
‘file.load 'OWS'Hint ' (LANG TranslateString'Lo »

[You can also reset SALT here by doing

BootSALT

"file.copy '[MC'MenuItem' (LANG TranslateStrin »

"file.copy'[MS'Event’ 'Select’ '[wscopy]l’

“file.copy DWS'Hint' (LANG TranslateString'Co bw
>

Dyalog 2017
Version 3.08
Jed BUILD_SESSION BUILD_MB_FILE

a 5 Function Pos: 0/72..,

Editor

1 90 x
Ready... Ins NUM

CurObj: translation (Undefined) g:1 OpQ:0 OTRAP [OSI:0 DOIO:1 [OML:0
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You can resize the Editor pane to view more or less of the Session itself, by dragging

its title bar.

Using the buttons in the title bar, you can instantly maximise the Editor pane to
allow you to concentrate on editing, or minimise it to reveal the entire Session. In
either case, the restore button quickly restores the 2-pane layout.

The picture below shows the effect of maximising the Editor. The BUILD_SESSION

edit window is itself maximised within the Editor too.

) File Edit Syntax Window Refactor View - a x
WS ig Yl Obet@m A @BV Tool O ) IS & | Edit (P57 9D | Session 1612
D) ce— LT T
)
()] {FILE}BUILD_SESSION LANG;OBJ;MSG;[IO;[ML;OLD;NEW;FN;MB;S81;582;TB;58;5BH;tools;dyalogskin;ok;JPATH; fontjbmsUNLp A
[11 A Build the session object and save if desired
[21 +If 0=ONC'NoPrompt’ ¢ NoPrompt+0 ¢ :EndIf
[3] :If 0=0ONC'FILE' o FILE+'' e :EndIf
[4]
[5] Owx-0Se.OWx~1 o OML OIO~1 e OPATH='#.Trans'
[6] OPW-122 A allows room for Status Bar
(71 LANG-upGase,LANG @ translation assumes uppercase
[a] UNICODE+80=[DR' *
[91
[10] ('Unknown language, pick ene of ',sTrans.CODES)SIGNAL(Trans.CODESeScLANG) 411
[11]
[12] :L[f GUI+'Windows '=7t0I0=0WG'APLVERSION"
S l[13] T ‘Ose'[WS‘Coord' ‘ScaledPixel’
Sl1e] :EndIf
2 |[18]
16l A Expunge MenuBar(s), StatusBar(s), ToolBar(s), TipField(s), OSE.WSDoc and [SE.NumEd
[17]1 08J-0WN '[ISE *
Sres] 087+ ( (0BT OWG"e'Type')e'MenuBar’ ‘StatusBar’ 'ToolBar' 'TipField’' ‘Menu’ ‘CoolBar’)/f0BT
rie] ~'0SE.WSDoc' '[SE.NumEd'
- |f20] DExt08J
s re1] ‘OsE'OWS'Event’ 0 0
[22]
S rzal ask<{NoPromptv~GUI:1
Sl2s] 'MsgBtni'=2o00DQ'MSG'OWC 'MsgBox' 'BUILD_SESSION'w('Style’' 'Query')('Event’ 'ALL' 1)
©lres]
2261
= (271 T 1If O< BJ-(SE.ONL 2 3 5 9
C 740
£\« >
£ Function Last saved by: johnd: 05/04/2017 Pos: 7/182,23
Ready... Ins NUM
CurObj: translation (Undefined) 8:1 OpQ:0 OTRAP [OSI:0 DOIO:1 [OML:0

Note that when the Editor has the focus, the Editor menubar is displayed in place of

the Session menubar.
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Window Management (Classic Dyalog mode)

If Classic Dyalog mode is selected (Options/Configure/Trace/Edit) each Edit
window is a top-level window created as a child of the Session window. This means
that normally Edit windows appear on top of the Session. However, if the
SessionOnTop parameter is set, the Session window, when given the focus, will
appear on top of Edit windows.

When the first Edit window is opened, its position is determined as follows:

« If the ClassicModeSavePosition parameter is set, the first Edit window is
displayed at the position that was previously occupied by the most recently
saved Edit window.

o Ifnot, the first edit window is created at the position specified by the edit_
first_y and edit_first x parameters which are specified in terms of the size
of a character in the current font relative to the top-left corner of the screen.

The initial size of an edit window is specified by the edit_rows and edit_cols
parameters.

File Edit Syntax Refactor View

i= A & ﬂ| Search... X wl % % Aa Aal ¥
[C] {FILE}BUILD_SESSION LANG:OBJ:MSG:0OI0:0OML: » &
[1] A Build the session object and save if des p
[2] :If O0=0ONC'NoPrompt' ¢ NePrompt+0( ¢ :EndIf
[3] :If O=[ONC'FILE' ¢ FILE+'' @ :EndIf

[4]

[5] OWX-+0SE.OWE+~1 ¢ OML OI0+1 ¢ [OPATH+"#.Tran p
[&] OPW=-122 B allows room for Status Bar

[7] LANG+upCase ,LANG A translation assumes up p
[8] UMICODE--8O=0DR" W
£ >
Function Posz 0.

Subsequent ones are staggered according to the values of the edit_offset_y and edit_
offset_x parameters.
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&)
File Edit Syntax Refactor View
= ©
[0] File Edit Syntax Refactor View
[1]§E A & ﬂ||iea"-:h... ¥ v % Aa Aal Jk
[2]
[3][0] BUILD_TC LANG:X:IL;TB:S ~
[4][1] f Build Toel Control
[5702] IL~'[0SE.cbtop.il =, "nhi
[61[3] TB+'[Ise.cbtop.bandtbl. tb
[710%] TE OWC'Toolcontrel ' ('Divider’ 0)("'ShowCa p
[8]05] :With T8
< NMlal OWS'Imagelist'IL W
Funl * >

| Function Poz...

Moving around an edit window

You can move around in the edit window using the scrollbar, the cursor keys, and the
PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the
beginning of the top-line in the object and Ctrl+End moves the cursor to the end of
the last line in the object. Home (LL) and End (RL) move the cursor to the beginning
and end respectively of the line containing the cursor.

Closing an edit window

Closing an edit window from its System Menu has the same effect as choosing Exit
from the File Menu; namely that it fixes the object in the workspace and then closes
the edit window.

Minimising an edit window

Minimising an edit window causes it to be displayed as a Dyalog APL Edit icon,
with the name of the object underneath. The edit window can be restored in the
normal way, or by an attempt to re-edit the same name.

Selecting Text

You may select text in an Editor window by clicking the left or right mouse button
over any character, dragging out a highlighed area, and then releasing the mouse
button. When using the left button, moving up or down one line extends the
selection from the beginning of that line, so the selection may be ragged. The right
button selects a rectangularr box.
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Editor ToolBar

= A & @ |[search... x v|% % @ s m &[0 1

In the table below, the first image shows the appearance of the toolbutton with
Native Look and Feel enabled; the second with it disabled.

Button Description

i= ] Toggles Line numbers on/off

Toggle line numbers

H A Inserts a comment symbol to the left
of the selection in each of the
selected lines.

Comment selected text

o o Removes the comment symbol (if
present) from the left-most column
of the selection in each of the
selected lines.

Uncomment selected text

0 X Saves changes and closes the

Save changes and return current edit window

Enter search text and click one of
the following two buttons

Search... "

| [

Search Box
"j:. af Locates the next occurrence of the

search text
Search for Next Match

"'J:. a0 Locates the previous occurrence of
. the search

Search for Previous Match

Determines whether or not the

Search hidden text search examines collapsed blocks



Chapter 1: The APL Environment 115

Button
."jul aﬂl.

Match case

Aal all
Match whole word

S

Use Regular Expressions
it *m

Refactor text as method

i *F
Refactor text as field

1 *p
Refactor text as property

Description
Specifies whether or not the search

is case-sensitive

Specifies whether or not the search
matches a whole word

Specifies whether or not the search
uses PCRE regular expressions

Inserts a Method template for the
selected name

Inserts a Field template for the
selected name

Inserts a Property template for the
selected name
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The File Menu

Fix

Fix script
Open File...
Save

Save As,.,

Always ask on close

Edit Shift+Enter
Print...

Print Setup...

Properties

Exit (and Fix) E=c

Exit (and fix script)
Exit and discard changes Shift+Esc

The File menu illustrated above is displayed when editing a simple object and
provides the following options.

Item Description

Fixes the object in the workspace, but leaves the edit
window open. Edit history is also preserved. If the

Fix data has changed and the confirm_fix parameter is set,
you will be prompted to confirm.

Fix whole script (Disabled unless editing a script)

Open File Allows you to edit a Dyalog script file or an arbitrary
text file.

Save Saves the file being edited.

Save As Renames and saves the file being edited.

Always ask on close |Toggles the value of the confirm_fix parameter.

Opens an Edit window on the name under the cursor

Edit (Disabled when there is no such name).

Print Prints the current contents of the edit window
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Item Description

Print Setup Displays the Print Configuration dialog box

Displays the Object Properties dialog box for the

Properties .
p current object

Fixes the object in the workspace and closes the edit
Exit (and Fix) window. If the data has changed and the confirm exit
parameter is set, you will be prompted to confirm

Exit (and fix script) | (Disabled unless editing a script)

Closes the edit window, but does not fix the object in

Exit and discard the workspace. If the data has changed and the
changes confirm_abort parameter is set, you will be prompted
to confirm.

The File Menu (editing a script)

Fix whole script

Fix only functions

Open File...
Save
Save As,.,

Always ask on close

Edit Shift+Enter
Print...

Print Setup...

Properties

Exit and fix whole script Esc
Exit and fix cnly functions

Exit and discard changes Shift+Esc
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Fix whole script Fixes the entire script

Fix only functions Fixes only the functions in the script.

Exit fix whol . . . . .
xit and fix whole Fixes the entire script, and exits the Editor.

script
Exit and fix only Fixes only the functions in the script and exits the
functions Editor.

Editing Scripts

Suppose that you have a Class that manages a list of items in a shared Field, so
somewhere in the script would appear a line such as:-

:Field shared public List<«®

You run your application for a bit, and L i st, which was initially empty, gets
updated as new instances of the Class are created. You then edit the Class to add a
new function, or fix a bug. In this instance, when you exit the editor you may not
want L1ist to be reset back to the empty vector although you do want the new
version of the function(s) in the Class to be fixed.

Nevertheless whenever you edit the Class when it is not suspended, you probably
always want the entire script to be re-fixed, and L i s t re-initialised.

The options in the File menu shown above provide for these alternatives.

In addition, the Configuration Dialog (see Installation & Configuration Guide:
Configuration Dialog: Trace/Edit Tab) allows you to define the behaviour of the
keystrokes <EP> and <S1> for both the suspended case and the non-suspended case.
This association will be displayed against the appropriate action according to the
state of the script you are editing.
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The Edit Menu

The Edit menu provides a means to execute those commands that are concerned with
editing text. The Edit menu and the actions it provides are described below.

Reforrmat Mum divide
Reformat Scripts Automatically

Undo Control+ Shift+Back
Redo Control+ Shift+Enter
Select All

Cut Shift+Delete
Copy Control+Insert
Paste Shift+Insert

Paste Unicode
Paste Mon-Unicode

Clear Delete

Open Line
Delete Line Control+Delete
Goto Line

Find...
Replace...

Highlight All Matches

Comment Selected Lines

Uncomment Selected Lines

Toggle Local Mame Control+Up
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Item

Description

Reformat

Reformats the function body in the edit window,
indenting control structures as appropriate.

Reformat Scripts

If checked, the Editor will automatically reformat a

Automatically Dyalog script when it loads it.
Undoes the last change made to the object. Repeated
Undo use of this command sequentially undoes each change
made since the edit window was opened.
Re-applies the previous undone change. Repeated use
Redo of this command sequentially restores every undone
change.
Select All Se.lects and highlights the entire contents of the Edit
window.
Copies the selected text to the clipboard and removes
Cut ) .
it from the object.
Copy Copies the selected text to the clipboard.
Paste Copies the text in the clipboard into the object at the

current location of the input cursor.

Paste Unicode

Same as Paste, but gets the Unicode text from the
clipboard and converts to [JAV

Paste Non-Unicode

Same as Paste, but gets the ANSI text from the
clipboard and converts to [JAV.

Clear

Deletes the selection or the character under the cursor.
Has no effect on the clipboard

Open Line

Inserts a blank line immediately below the current one.

Delete Line

Deletes the current line.

Prompts for a line number, then positions the cursor on

Goto Line that line.
Find Displays the Find dialog box.
Replace Displays the Replace dialog box.
If checked, all strings in the object being edited that
Highlight All match the search string are highlighted. The
Matches highlightedted items change dynamically as the search

string is entered or changed.
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Item Description

Comment selected | Adds a comment symbol to the beginning of all
lines selected lines.

Uncomment selected | Removes a comment symbol from the beginning of all
lines selected lines.

Adds or removes the name under the cursor to/from the

Toggle Local name function header line.

The Find and Replace items are used to display the Find dialog box and the
Find/Replace dialog box respectively. These boxes are used to perform search and
replace operations and are described later in this Chapter.

Once displayed, each of the two dialog boxes remains on the screen until it is either
closed or replaced by the other. This is convenient if the same operations are to be
performed over and over again, and/or in several windows. Find and Find/Replace
operations are effective in the window that previously had the focus.

The Syntax Menu
Mothing
v APL
J50M
KWL

The Syntax menu illustrated above provides options to specify how the data
displayed in the Editor window is to be syntax coloured. For workspace objects, the
default is APL for functions and operators, and Nothing for variables.

Item Syntax Colour as
Nothing Variable

APL Function

JSON JSON array

XML XML array
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The Window Menu

The Window menu provides a means to control the display of the various edit
windows. The Window menu and the actions it provides are described below.

Close All Windows
Cascade

Tile Vertically

Tile Horizontally

Arrange lcons

Language Bar
Debugger
Editor

Item

Description

Close All Windows

Closes all the edit windows. If Confirm on Edit
Window Closed is checked, you will be prompted to
confirm for any objects that you have changed.

Cascade

Arranges the edit windows in overlapping fashion.

Tile Vertically

Arranges the edit windows tiled one above the other.

Tile Horizontally

Arranges the edit windows tiled alongside one
another.

Arrange Icons

Arranges any minimised edit windows.

Editor

Allows you to Select the edit window corresponding
to the named object.
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The Refactor Menu

Add text as Field
Add text as Property
Add text as Method

The Refactor menu illustrated above applies only when editing a Class and provides

the following options. In each case, the user must highlight a name in the Edit
window, and then select one of these options to insert the appropriate template for

that name into the body ofthe Class.

Item Description

Add text as Field Inserts a Field template for the selected name.

Add text as Property [Inserts a Property template for the selected name.

Add text as Method [Inserts a Method template for the selected text name.

The View Menu
Trace
~ Stop
Monitor

" Line Mumbers

Function Line Mumbers

Tree View

Compiler Errors

" Cutlining
Expand All Qutlines
Collapse All Outlines
Expand all Qutlines below here

Mum -
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The View menu, illustrated above, provides the following actions.

Item Description
Trace Displays a column to the left of the function that
displays OTRACE settings
Sto Displays a column to the left of the function that
P displays [JSTOP settings
Monitor Displays a column to the left of the function that

displays [JMONITOR settings

Line Numbers

Toggles the display of line numbers on/off.

Function Line
Numbers

Toggles the display of line numbers on individual
functions on/off. This option is only enabled when
editing a Class, Namespace script or Interface.

Tree View

Toggles the display of the treeview in the left-hand
pane.

Compiler Errors

If enabled, the Editor identifies which lines of code
would not compile. These are identified by a red
vertical line to the left. Hovering over the red bar
gives you a pop-up telling you what the compiler
didn't like about that line of the function.

Outlining Tums outlining on and off.
Expand All Outlines | Expands all outlines.
Collapse All .
Outlines Collapses all outlines

Expand all Outlines
below here

Expands all outlines below the level of the current
line.

Function Line Numbers

The Function Line Numbers option in the Editor menu provides an additional level

of line-numbering. If selected, line numbers are displayed independently on each
individual function (or operator) in the Class. This option is only enabled when you

are editing a Class, Namespace script or Interface, and is disabled for all other types

of object.

Note that function line-numbering and general line-numbering are independent

options and it is possible to have the entire Class numbered (from [0] to the number

oflines in the Class) in addition to having line-numbering on each individual

function.
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Using the Editor

Creating a New Function

Type the name of your function and invoke the editor. To do this you may press
Shift+Enter, or select Edit from the Action menu, or double-click the left button on
your mouse, or click the Edit tool in the tool bar. A new window will appear on the
screen with the name you have chosen displayed in the top border. The name is also
inserted in the function header and the cursor positioned to the right. The new
window is automatically given the input focus.

Line-Numbers on/off

Try changing the line numbers setting by clicking on the Line Numbers option in the
Options menu. Note that line-numbering on/off is effective for all edit windows.

Adding Lines

If the keyboard is in /nsert mode, pressing Enter at the end of a line opens you a new
blank line under the current one and positions the cursor there ready for input. You
can also open a new blank line by pressing Ctrl+Shift+Insert (OP).

Ifthe cursor is at the end of the last line in the function, pressing Enter adds another
line even if the keyboard is in Replace mode.

Indenting Text

Dyalog APL allows you to insert leading spaces in lines of a function and (unless the
AutoFormat parameter is set) preserves these spaces between editing sessions.
Embedded spaces are however discarded. You can enter spaces using the space bar or
the Tab key. Pressing Tab inserts spaces up to the next tab stop corresponding to the
value of the TabStops parameter. If the AutoIndent parameter is set, new lines are
automatically indented the same amount as the preceding line.

Reformatting

The RD command (which by default is mapped to Keypad-Slash) reformats a
function according to your AutoFormat and TabStops settings. See Installation &
Configuration Guide: Configuration Dialog: Trace/Edit Tab.

Deleting Lines

To delete a block of lines, select them by dragging the mouse or using the keyboard
and then press Delete or select Clear from the Edit menu. A quick way to delete the
current line without selecting it first is to press Ctrl+Delete (DK) or select Delete
Line from the Edit menu.
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Copying Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Ctrl+Insert or select Copy from the Edit menu. This action copies the selection
to the clipboard. Now position the input cursor where you wish to make the copy
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to duplicate a ragged block of text.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

Moving Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Shift+Delete or select Cut from the Edit menu. This action copies the selection
to the clipboard and removes it. Now position the input cursor at the new location
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to move a ragged block of text.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse
button. When the drag-and-drop pointer appears, drag the cursor to a new
location.

3. Release the mouse button to drop the text into place.

Joining and Splitting Lines

To join a line to the previous one: select Insert mode; position the cursor on the first
character in the line; press Bksp.

To split a line: select Insert mode; position the cursor at the place you want it split;
press Retumn.

Toggling Localisation

The TL command (which by default is mapped to Ctrl+Up) toggles the localisation
of'the name under the cursor. If the name is currently global, pressing Ctrl+Up causes
the name to be added to the list of locals in the function header. If the name is already
localised, pressing Ctrl+Alt+] removes it from the header.
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Aligning Comments

When you press the <AC> key, or select Align Comments in the Editor's context
menu, the alignment of the comments in every line in the function will be changed so
that the left-most comment (Lamp) symbol is in the same column as the cursor, except
that:

o Comment symbols that are preceded only by white space, i.e. comments in
lines that contain no code, are ignored and are not adjusted in any way.

o Comment symbols that lie between the first column and the first tab stop
will remain in or be moved to the first column. For information on setting
tab stops, see Installation & Configuration Guide: Configuration Dialog
(Edit/Trace Tab).

o Comment symbols will not move further left than the end of the statement.

When a comment is re-aligned, text to the right of the left-most comment symbol
(including spaces and other comment symbols) will remain fixed in relation to that
symbol.

Note that there is no keystroke associated with this command by default; the user
must define one. See Installation & Configuration Guide: Configuration Dialog
(Keyboard Shortcuts Tab).

White Space in Source Code

Settings that impact the automatic reformatting of code can cause changes to
whitespace — this can be interpreted as changes to the source code. This means that:

« opening a scripted object in the Edit window can cause the source of that
object to change (when closing an Edit window, you might be prompted to
save a function even though you have not made any changes to it).

« viewing an object can change its file timestamp; source code management
systems can subsequently report changes due to the changed file timestamp.

« source code changes resulting from reformatting will be evident in the
results of system functions such as JAT, OSRC, [OCR, (VR and [INR.
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Outlining

When you are editing a function, outlining identifies the blocks of code within

control structures, and allows you to collapse and expand these blocks so that you

can focus your attention on particular parts of the code

The picture below shows the result of opening the function JSE.cbtop.TB_

POPUP.

)ed OSE.cbtop.TB_POPUP

s Editor - [O5E.cbtop. TB_POPUP]

_ﬁ File Edit Syntax Window Refactor View - &
i=| O @ @ ||Search... v an

[a] {FLAG}TB_POPUP MSG;:TC

[1] AR Popup menu on Session ToolControl

[2] E :If O=[NC'FLAG'

[3] ] :If (2=5=M5G) R Right mouse button ?

[4] '"popup.captions 'OWS'Checked'

[5] 'popup.list'OWS'Checked'('FlatlList's )

[&] "popup.multiline'OWs'Checked’

[7] 0pQ' popup’

[8] I :End

[9] :Else

[10] TC+"bandtb1.tk' ‘bandtb2.tb' 'bandtb3.tb' 'bandtb4.tb'
[11] =] :Select FLAG

[12] :Case 1

[13] A

[1%] TC OWS"<'ShowCaptions'

[15] :Case 2

[186] «~{1+'FlatList's )="FlatList' 'FlatButtons'
[17] TC OWS"<='Style’

[18] :Case 3

[19] —

[20] TC OWS"='MultiLine’

[21]

[22] L :End

(2311 [ :tnd

Function Pos: 3/24.6

Notice that the various control structure blocks are delineated by a treeview diagram.
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e When you hover the mouse pointer over one of the boxes that mark the start
of a block, the line marking the extent of that block becomes highlighted,
as shown above.

« Ifyou click on a [l box, the corresponding section collapses, so that only
the first line of the block is displayed, as shown below.

o Ifyou click on a ! box, the corresponding section is expanded.

sm Editor - [OSE.cbtop. TB_POPUP]

_ﬁ File Edit Syntax Window Refactor View - &8 X
i= @ @ € ||Search... w| F % ah

[a] {FLAG}TB_POPUP MSG;TC

[1] A Popup menu on Session ToolContral

[2] ] :If 0=[NC'FLAG’

[3] ]| iLf (2=5=M5G) B Right mouse button 4

[9] :Else

[10] TC+~'bandtbi.tb' 'bandtb2.tb' 'bandtb3.tb' 'bandtbi.tbh'
[11] [ :Select FLAG

[12] iCase 1

[13] -

[1&] TC OWS"<'ShowCaptions'

[15] :Case 2

[16] ~{1+'Flatlist'=s )="FlatList' 'FlatButtons'
[17] TC OWS7='Style’

[18] :Case 3

[19] -

[20] TC OWS"='Multiline’

[21]

[22] | tEnd

[23] L :End

Function Pos: 3/24,6
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Sections

Functions and scripted objects (classes, namespaces etc.) can be subdivided into
Sections with : Section and : EndSect ion statements. Both statements may be
followed by an optional and arbitrary name or description. The purpose is to split the
function up into sections that you can open and close in the Editor, thereby aiding
readability and code management. Sections have no effect on the execution of the
code, but must follow the nesting rules of other control structures.

The following picture illustrates the use of sections in a function called
DumpWindow. The function is divided into 5 sections named Comments, Init,
NAs, MakeBitmapand CopyToClipBoard.

The first picture shows the function with all sections closed.

.m Editor - [DumpWindow]

ED File Edit Syntax Window Refactor View - 8 X
=G ﬁ‘[ ﬁ| Search... w| % ah
[0] DumpWindow ref;[I0;0ML

[1] :Section Comments

iSection Init

:Section NAs

:5ection MakeBitmap
:5ection CopyToClipBoard

,_,
i
=]
—_
HEHEEE

Function
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The next picture shows the effect of opening the Comments section. Notice how this
is delineated by the statements:

:Section Comments

:EndSection Comments

A Editor - [DumpWindow]

ﬁ File Edit Syntax Window Refactor View - 8 X
i= @ ‘ﬁ QHSearch... w|® % ah

[o] DumpWindew ref;OI0;0ML

[1] :Section Comments

[2] A eg DumpWindow f & note unquoted name

[3] f Note only the visible part of the window is dumped

[4] f you may need to set 'OnTop' to ensure total window visibility
[5] iEndSection

[8] :Section Init

[10] :Section MNAs

[25] :Section MakeBitmap

[37] :5ection CopyToClipBoard

< > |
Function Pos: 0/44.1

And with the Init section opened too:

A Editor - [DumpWindow]

ﬂ File Edit Syntax Window Refactor View - 8 %
=0 @ QHSearch... vl H g an

[o] DumpWindew ref :0I0;0ML

[1] [ :5ection Comments

[2] A eg DumpWindew f A note unquoted name

[3] A Note only the visible part of the windew is dumped

[4] A you may need to set ‘OnTop' to ensure total window visibility
[5] | :EndSection

[&] [ :S5ection Init

[7] OML OI0~0

[8] OSHADOWt (' ref " )~3%" "~Z74[REFS=0SI

[9] | :EndSection

[10] :Section NAs

[25] :Section MakeBitmap

[37] :Section CopyToClipBoard

£ >

Function Pos: 0/44,1
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Finally, with all the sections opened:

Jm Editor - [DumpWindow]

ﬂ File Edit Syntax Window Refactor View - 8 X
= 0 ﬁf QHSearch... v % % ak

[o] DumpWindew ref:;OI0:;0OML

[1] [E :Section Comments

[2] A eg DumpWindew f A note unguoted name

[3] A Note only the visible part of the window is dumped

[4] f you may need to set ‘OnTop' to ensure total window visibility
[5] | :EndSection

[e] [E] :Section Init

[7] OML 0OI0+0

[&] OSHADOWt (' ref ' )~2" '~2"4REFS=05I

[9] | :EndSection

[10] [E] :Section NAs

[11] ONA'FP wuser32|GetWindowDC P [
[12] ONA'U% user32|GetWindowRect P ={U% U% U4 U4} 3
[13] ONA'U% user32|ReleaseDC = [
[1%] [ONA'U% user32|0OpenClipboard P [
[15] ONA'U% user32|EmptyClipboard [
[1a] ONA'P  user3d?|SetClipboardData Us P [
[17] ONA'U% user32|CloseClipboard 3
[18] ONa'P gdi32|CreateCompatibleDC P »
[19] ONA'F gdid2|CreateCompatibleBitmap P U4 U [
[20] Oma'e gdi32[SelectObject PP [
[21] ONA'U% gdi32|DeleteDC P *
[22] ONA'U+ gdi3d2|Deletelbject P »
[23] ONA'U+ gdi32lBitBLL PoUs Uk U U P UL U4 U
[2%] | :EndSection

[25] ] :Section MakeBitmap

[2a] hwnd+ref .[IWG'Handle"

[27] hdc+GetWindowDC hwnd

[28] sze+—— /%7 2pi-GetWindowRect hwnd{(%p0)

[29] mdc+~CreateCompatibleDC hde

[30] hbm+~CreateCompatibleBitmap hdc, sze

[31] old+~SelectObject mdc hbm

[32] jnk-~BitBlt mdc 0 0,sze,hde 0 0 13369676 & SRCCRY

[33] jnk+SelectObject mde old

[3%] jnk-ReleaseDC hdec 0

[35] jnk+DeleteDC mdc

[36] | :EndSection

[37] [ :Section CopyToClipBoard

[38] jnk=OpenClipboard 0

[39] ijnk-EmptyClipboard

[40] jnk+5etClipboardData 2 hbm a 2 = CF_BITMAP

[41] jnk+CloseClipboard

[42] jnk+DeleteObject hbm

[4+3] |l :EndSection

£ >.

Function Pos: 0/44,1
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Editing Classes

The picture below shows the result of opening the ComponentF i Le class. Notice
how each function is delineated separately and that each function is individually
line-numbered.

)ed ComponentFile

v Editor - [ComponentFile]

ﬁFiIe Edit Syntax Window Refactor View - 8 X
= @ A Q|[search. .. v[% s a1 e 1
El--JS:I#.ComponentFiLe :Class ComponentFile ~
%1 [Constructors] & :Field Private Instance tie
# [Fields] & tField Private instance temp+~0 B T
3% [Methods ] )
P | [Properties] Qio=i o Omi-t
[o] = v Open filename
[1] A Open Named File
[2] :Implements Censtructor
[3] tAccess Public Instance
[%]
[5] [ :Trap O
[&] tiesfilename OFSTIE O
[71] :Else
[&] OFUNTIE filename [OFCREATE O »
[9] tie~filename OFSTIE O 3
[10] L :EndTrap
[11] L v
[o] = v OpenTemp:[USING:z
[1] A Default: Open temporary file
[2] :Implements Constructor
[3] tAccess Public Instance
[%]
[®] OUSING-""
[&] +System.I0.Path.GetTempFileName
[7] z ONERASE z [ONTIE O & Erase the »
[8] tiez OFCREATE 0
[9] temp=1
[10] L v
[0] v Close
[1] :Implements Destructer
[2] :If tiee[JFNUMS
[3] :If temp ¢ Name [FERASE tie
[%] tElse o [FUNTIE tie
[5] tEndIf
[6] :EndIf
[71 v v
< >

Class Pos: 4/113,4
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The outlining feature really comes into its own when editing classes because you can
collapse and expand whole functions. The picture below shows the effect of
collapsing all but the Append method.

. Editor - [ComponentFile]

_ﬁFiIe Edit Syntax Window Refactor View -8 X
= @ @ @ |[search... v[% % @an| e
9--1.::'#.ComponentF"|Le :Class ComponentFile
#1 [Constructors] & :Field Private Instance tie
a1 [Fields] & :Field Private instance temp+~0 A Tw
%1 [Methods]
io+-1 @ L=1
-3 [Properties] fio Um
v Open filename
v OpenTemp:[USING:z
v Cleose
A -—— Instance Methods ---
[a] v r+Append data
[1] tAccess Public Instance
[2] r+datz [OFAPPEND tie
[3] v
v Rename nzme
v Replace(comp data)
A --- Instance Properties ---
:Property Name
:Property Count
:Property Access
:Property Numbered Compone®
R --- Shared Members
v Delete filestie
:EndClass A Class ComponentFile
£ >

Class Pos: 4/113,4



Chapter 1: The APL Environment 135

When you edit a class, a separate treeview is optionally displayed in the left pane to
make it easy to navigate within the class. When you click on a name in the treeview,
the editor automatically scrolls the appropriate section into view (if necessary) and
positions the edit cursor at its start. The picture below illustrates the result of opening
the [Methods] section and then clicking on Rename.

. Editor - [ComponentFile]

_ﬁFiIe Edit Syntax Window Refactor View -8 X
= @ @ @ |[search... V% % Eaal et
9--1;:'#.Componentl-'ﬂe [0] v Close A~
-2%1 [Constructors] [|[1] :Implements Destructer
o3 [Fields] [2] :If tieclFNUMS
P [3] :If temp ¢ Name [FERASE tie
Method
80 [Methods] [4] :Else o OFUNTIE tie
[5] :EndIf
[6] :EndIf
[71 v
A -—-—- Instance Methods ---
-3 [Properties]
[a] =] v r+Append data
[1] :Access Public Inmstance
[21 redztz OFAPPEND tie
[3] L v
(o] Bl v Rename name]
[1] :Access Public Inmstance
[2] name [OFRENAME tie
[3] L v
[a] =] v Replace(comp data)
[1] :Access Public Inmstance
[2] data OFREPLACE tie,comp
[3] L v
A ——- Instance Properties --—-
:Property Name
tAccess Public Instance
[a] v r+get
[1] :TF tiecOFNUMS o r~[FNAMES[O®
[2] :Else & r="" & :EndIf
[3] v
:EndProperty
:Property Count
:Access Public Instance
[0] v reGet _ v
L4 >

Class Pos: 47/113,0
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Sections within Scripts

Scripts can also be subdivided into Sections using : Sectionand :EndSection

statements. As with single functions, the purpose is only to split the script up into
sections that you can open and close in the Editor. Sections have no effect on the

execution of the code.

The following picture illustrates a Class named actuarial which, for editing

purposes, has been sub-divided into five separate Sections named Main,

MenuHandlers,Validation,Utilities and OldCode. In this picture, all

the Sections are closed.

‘A Editor - [actuarial]

B File Edit Syntax Window View - x
i= @ B @ ||Search... v % aA| % 11
o0 #.actuarial :Class actuarial: Page

2.4 [Sections]

; T Main

T MenuHandlers
OldCode

i
B outilities
N

e

Validation

|

HEEHEA

:Using System
tUsing System
:Using System
:Using System
tUsing System
tAccess Publi

:Section

:Section
:Section
:Section
:Section

:EndClass

.Heb.UI system.web.dll
.Web.UI.HtmlControls
.Web.UL.WebkControls
.Data,system.data.dll
c

Main

MenuHandlers
Validation
Utilities
0OldCode

Class

Pos: 0/1500,0
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The next picture shows the effect of opening just the Ma i n section.

.m Editor - [actuarial]

_ﬁFile Edit Syntax Window Refactor View -
%E[ﬁ]ﬁfQHSearch... w| % "pa,t\|‘i}+g*|‘_]
=0 #. actuarial :Class actuarial: Page
-4 [Sections] :Using System
E‘T Main :Using System.Heo.UE,systirn.weo.dl.L
Bﬁil [Methods] tUsing System.Web.UL.HtmlControls

:Using System.Web.UI.WebControls
:Using System.Data,system.data.dll
tAccess Public

:Sectionm Main

[+H1]

[j---T MenuHandlers v Page_Load; INT;AGE;DUR; TERM; TABM
[j---? OldCode 7 CALC_FSLTAB_RESULTS(obi ev)si;»
D...T Utilities v CALC_FSL_RESULTS(obj ev):X;CHAm
D'"T Validation :EndSection
:Section MenuHandlers
tSection Validation
:Section Utilities
:Section OldCode
tEndClass
< >4 >
Modified Class Pos: 146/1497,3

Notice that this section is delimited by the two statements:

:Section Main

:EndSection Main
In this picture the 3 functions within the Ma i n section are temporarily closed.
Similarly, the section called Val idation is delimited by:

:Section Validation

:EndSection Validation
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Editor - [actuarial]

ﬂu File Edit Syntax Window Refactor View - & x

éEﬁﬁQHSearch... v| % "pa,p.|"“*‘o‘|‘_]

20 #.actuarial :Class actuarial: Page ~
25" [Sections] tUsing System

ﬁm? Main tUsing System.Web.UI system.web.dll
"? MenuHandlers :Using System.Web.UIL.HtmlControls
:Using System.Web.UI.WebControls
:Using System.Data,system.data.dll
tAccess Public

-8 0ldCode
0-F Utilities
-

[ Validation :Section Main
=33 [Methods] :Section MenuHandlers
----- {Z) VALIDATE_AGE E
----- VALIDATE_DUR
_____ E% ?ﬁLIDhTE_DURl [o] = ¥ YALIDATE_AGE(source args) A Val &
- [1] thccess Public
""" a VALIDATE_INT [21] :Signature VALIDATE_AGE Object »
..... ) VALIDATE_INT! (3] o Trep 0
P
----- £ VALIDATE_INTZ ||14] AGE-Convert.ToInt32 =rgs.Va b
..... ) VALIDATE_INTY ||[5] (Else
..... &) vALTDATE_MPC1 [ [[6] args.IsValid=0
..... ) VALIDATE_TERM ||[7] :Return
..... VALIDATE_TERM1 [ [[8] L :EndTrap
a - [9] args.lsValid-(10=AGE)~80=zAGE
[10] L v
[o] = ¥ YALIDATE_DUR(source args);DT A ®
[1] thccess Public
[2] :Signature VALIDATE_DUR Object w
[3] = :If 2=GET_RUN_OPTION
[4] DT~1
[5] :Else
[&] DT+=+f10 1=(TA TB).
[7] | {EndIf y
< > |

Maodified Class Pos: 198/1498,0



Chapter 1: The APL Environment 139

Find and Replace Dialogs

The Find and Find/Replace dialog boxes are used to locate and modify text in an
Edit window.

Find / Replace 4

Search Far: | w | | Fird Mest |
R eplace With: | w | Replace
Replace All
[]Match Casze [] Match whole ward
. Lndo
[]Use Regular Expressions Wwirap Search
Autobdove Ll
Direction
Up (® Down
Enter the text string that you want to find. Note that the
text from the last 10 searches is available from the drop-
Search For down list. If appropriate, the search text is copied from the

Find Objects tool. This makes it easy to first search for
functions containing a particular string, and then to locate
the same string in the functions.

Enter the text string that you want to use as a replacement.
Replace With [ Note that the text from the last 10 replacements is available
from the drop-down list.

Match Case Check this box if you want the search to be case-sensitive.

Match Whole | Check this box if you want the search to only match only
Word whole words.

Use Regular

; Check this box if you want to use Regular Expressions.
Expressions

If checked, the Find or Find/Replace dialog box will
AutoMove automatically position itself so as not to obscure a matched
search string in the edit window.

Direction Select Up or Down to control the direction of search.
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Using Find and Replace

Find and Replace work on the concept of a current search string and a current
replace string which are entered using the Find and Find/Replace Dialog boxes.
These boxes also contain buttons for performing search/replace operations.

Suppose that you want to search through a function for references to the string
"Adam". It is probably best to work from the start of the function, so first position the
cursor there (by pressing Ctrl+Home). Then select Find from the Edit menu. The Find
Dialog box will appear on your screen with the input cursor positioned in the edit
box awaiting your input. Type "Adam" and click the Find Next button (or press
Return), and the cursor will locate the first occurrence. Clicking Find Next again will
locate the second occurrence. You can change the direction of the search by selecting
Up instead of Down. You could search another function for "Adam" by opening a
new Edit window for it and clicking Find Next. Y ou do not have to redefine the
search string.

Now let us suppose that you wish to replace all occurrences of "Adam" with
"Amanda". First select Replace from the Edit menu. This will cause the Find Dialog
box to be replaced by the Find/Replace Dialog box. Enter the string "Amanda" into
the box labelled Replace With, then click Replace All. All occurrences of "Adam" in
the current Edit window are changed to "Amanda". To repeat the same global change
in another function, simply open an edit window and click Replace All again. If
instead you only want to change particular instances of "Adam" to "Amanda" you
may use Find Next to locate the ones you want, and then Replace to make each
individual alteration.

Text searches are performed using PCRE. If the Use Regular Expressions box is
checked, the full range of regular expressions provided by PCRE are available for
use. See Language Reference Guide: Appendix A.

Saving and Quitting

To save the function and terminate the edit, press Esc (EP) or select Exit from the File
menu. The new version of the function replaces the previous one (if any) and the edit
window is destroyed.

Alternatively, you can select Fix from the File menu. This fixes the new version of
the function in the workspace, but leaves the edit window open. Note that the history
is also retained, so you can subsequently undo some changes and fix the function
again.

To abandon the edit, press Shift+Esc (QT) or select Abort from the File menu. This
destroys the edit window but does not fix the function. The previous version (if any)
is unchanged.
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Editing Scripts and Text Files

The Editor may also be used to edit Dyalog script files (. dyalog files) and general
text files.

There are two ways to choose the file to be edited. If the file exists, you can select it
from the Open source file dialog by clicking File/Edit Text File from the Session
menu bar.

Altematively, type ) ED followed by the pathname to the file. To identify the name
given as a file, it must either contain a slash character ("\" or /") or be preceded by
one.

Examples
JED c:\Dyalogl5.0\myscript.dyalog
JED c:\Dyalogl5.0\pete.txt
JED /x.txt A x.txt in current directory
Jed / x.txt a ditto
Jed / y Ay in current directory
Ifthe named file does not exist, you will be asked whether or not you want to create

it:

Dyalog APL/W-64

The specified file does not exist

Do you want to create it?

[l Do not ask this question again

If you edit a Dyalog script file, the editor will treat it as such and provide the same
formatting and syntax colouring as if it were a script in the workspace.

Otherwise, the file will be edited as if it were a character vector with embedded new-
lines.

When you exit the editor with Exit and fix, you will be offered a number of
alternatives depending upon the type of file, as shown below.
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' —> Save as text in the workspace
: Create text variable in the workspace, and update the
file

— Only save file to disk

This won't affect the contents of the workspace

—> Discard changes

L1 Savethis response for all files with a ".bt" extension Cancel

Saving a Text file.

Note that if you choose Save as text in the workspace, information about the file and
the text variable associated with it is retained in the workspace. This information
may be obtained using 5176I and 51771I. See Language Reference Guide: List
Loaded Files and List Loaded File Objects.
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chmiserverywebcamwebcam.dyalog

o Save file content

' —> Fix as code in the workspace
: Create objects in the workspace, and update the file

—> Save as text in the workspace
Create text variable in the workspace, and update the file

—> Only save file to disk

This won't affect the contents of the workspace

—> Discard changes

[l Save this response for all files with a ".dyalog” Cancel
extension

Saving a Script file.

Note that if you choose Fix as code in the workspace or Save as text in the
workspace, information about the file and the text variable associated with it is
retained in the workspace. This information may be obtained using 51761 and

51771. See Language Reference Guide: List Loaded Files and List Loaded File
Objects.
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Fix as code in the workspace

If you choose this option, the file will be updated and the script will also be fixed in
the workspace. Note that if the script refers to a base class or other external elements,
it cannot be fixed unless these elements are also present in the workspace.

Save as text in the workspace

If you choose this option, the file will be updated and the contents of the file will
also be saved to a variable in the workspace. First you will see the following warning
dialog, which may be disabled subsequently by checking Do not ask this question
again.

Saving as text will not update the file on subsequent
edits of the variable

[l Do not ask this question again

Then you will be prompted to supply its name, which may be a new name or the
name of an existing variable:

Save in Workspace

Mame of variable to save az

Only save file to disk

If you choose this option, the file will be updated but nothing will be changed in the
workspace.

Discard changes

If you choose this option, all changes will be discarded and nothing saved.
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The Tracer

The Tracer is a visual debugging aid that allows you to step through an application
line by line. During a Trace you can track the path taken through your code, display
variables in edit windows and watch them change, skip forwards and backwards in a
function. You can cutback the stack to a calling function and use the Session and
Editor to experiment with and correct your code. The Tracer may be invoked in
several ways as discussed below.

Tracing an expression

Firstly, you may explicitly trace an expression that executes one or more defined
functions or operators by typing the expression then pressing Ctrl+Enter (TC) or by
selecting Trace from the Action menu. This lets you step through the execution of an
expression from the beginning.

In the same way as when you execute a statement by pressing Enter, the expression is
(ifnecessary) copied down to the input line and then executed. However, if the
expression includes a reference to an unlocked defined function or operator,
execution halts at its first line and a Trace window containing the suspended
function or operator is displayed on the screen. The cursor is positioned to the left of
the first line which is highlighted.

Naked Trace

The second way to invoke the Tracer is when you have a suspended function in the
State Indicator and you press Ctrl+Enter (TC) on the empty input line. This is termed
naked trace. The same thing can be achieved by selecting Trace from the Action
menu on the Session Window.

The effect of naked trace is to open the Tracer and to position the cursor on the
currently suspended line. It is exactly as if you had traced to that point from the Input
Line expression whose execution caused the suspension.

Automatic Trace

The third way to invoke the Tracer is to have the system do it automatically for you
whenever an error occurs. This is achieved by setting the Show trace stack on error
option in the Trace/Edit tab of the Configuration dialog (Trace_on_error
parameter). When an error occurs, the system will automatically deploy the Tracer.
Note that this means that when an error occurs, the Trace window will then receive
the input focus and not the Session window.



Chapter 1: The APL Environment 146

Tracer Options

From Version 10.1 onwards, the Tracer is designed to be docked in the Session
window.

In previous versions of Dyalog APL, the Tracer was implemented as a stack of
separate windows (one per function on the calling stack) or as a single, but still
separate, window.

You can disable the standard behaviour by selecting Classic Dyalog mode from the
Trace/Edit tab of the Configuration dialog box.

Ifyou do so, you may then choose to have the Tracer operate in multiple windows or
in a single window.

These alternatives are discussed later in this Chapter.
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The Trace Window

The Tracer is implemented as a single dockable window that displays the function
that is currently being executed. There are two subsidiary information windows
which are also fully dockable. The first of these (SIStack) displays the current
function calling stack; the second (Threads) displays a list of running threads.

In the default Session files, the Tracer is docked along the bottom edge of the Session
window. When you invoke the Tracer, it springs up as illustrated below. In this
example, the function being traced is [JSE . UCMD, which is invoked by typing a user-
command, in this case Jdisplay.

0SE)- Dyalog APL/W-64

Tools  View

WS % ol ol Wl % | Object [T g1 @@ # FE[A | Tool P 571 1= @ | Edit 7 & 9 Q| Session 1602

Language Bar X X
=Ts CECENE me | O

] EElofel ] (MRl sl e FREEDRE (el o[lollels) 12 |-[%] [DOEB[rle3| (olal-lulelvlal &g

Dyalog APL/W-64 Version 15.0.27293 ~

Serial Ne : 000042
Unicode Edition
Beta relesse
Sun May B8 13:54:45 2016
lclear ws

ldisplay 113

v

Debugger _ox
66O COD QP E| Search... MEIES aA|nsg_um«v % [UCMD[1]*n User Command Processor.
o
] r—{THISJUCMD Input;dcl;insnmasrlbsursnotQ ~
[11 [ User Command Processor. The resplt may be assigned to a global variasble
[2] R Most of the implementation is in OSE.SALTUtils.Spice; this function only® :
[3] # "assignment syntex”, i.e. Jvername-ucmd end  J0-ucmd -
[+] =
[5] rib={(+/a\"' '"=w)iw} ¢ =(pin=rlb Input)i0 =
[6] z
(71 :If 0=[NC'THIS' o THIS-DIO=DORSI © :EndIf A record calling environment =
(8] ol s
ral 8 luar+Mmd arcented- cee if it makes ceance if nrecaen + No cnarac allauad ] =
3 s
g 2[% £
Function Pos: 1/2933 P >||w
Ready... Ins NUM
CurObj: result (Undefined) 8:1 ObQ:0  OTRAP [SI:t DOI0:1  [OML:1

In the default layout, the Sistack window is displayed alongside the main Tracer
window, although this can be hidden or made to appear as a separate floating
window, as required.
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Trace Tools

The Tracer may be controlled from the keyboard, or by using the Trace Tools which
are arranged along the title bar of the Debugger window. Note that the button names
are solely for reference purposes in the description that follows.

Key o
Button Name Code Keystroke Description
» | =+| Exec ER Enter Execute expression
L!- T
Trace TC Ctrl+Enter Trace expression
o P
Py Back BK Ctrl+Shift+Bksp Go back one line
N Fwd FD Ctrl+Shift+Enter Skip current line
elp Continue BH Stop on next line of
N calling function
u > Restart RM ~{LC Continue execution of this
thread
ﬂ [> Restart all Continue execution of all
threads
= Edit ED Shift+Enter Edit name
ab | 2=
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Key

Button Name Code Keystroke Description
o |x Exit EP Esc Quit this function
" T Intr Ctrl+Pause Interrupt
# ﬂ Reset CB Cl.ear tr.ace/ stop/monitor for
this object
= [ LN Toggle line numbers
* i Search for next match
{-,P i Search for previous match
Search hidden text
An o al Match case
Aal afl Match whole word
O Use Regular Expressions

Using the Trace Tools, you can single-step through the function or operator by
clicking the Exec and/or Trace buttons. If you click Exec the current line of the
function or operator is executed and the system halts at the next line. If you click
Trace, the current line is executed but any defined functions or operators referenced
on that line are themselves traced. After execution of the line the system again halts
at the next one. Using the keyboard, the same effect can be achieved by pressing
Enter or Ctrl+Enter.

The illustration below shows the state of execution having clicked Exec 16 times to
reach [JSE.UCMD[17].
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Tools  View

WS % ol ol Wl % | Object [T g1 @@ # FE[A | Tool P 57 1= @ | Edit 7 & 9 Q| Session 1602

Language Bar X X
- - = ol o a
] EEf ool l7] (L[] [lsl<Plel=le] (t[¢[==[o}als] :[lelélols] [T [-[¢] [COEB[]s[3] [e]a-ulolvle] Y
Dyalog APL/W-64 Version 15.0.27293 ~
iSerial No : 000042 E
Unicode Edition
Beta release
ISun May 8 13:54:45 2016
lclear ws
ldisplay 113
v
Debugger - O _oOx
[ O« > 4 x_| Search... v % % ah | [SE.uck « || X | UCMD[17 J#ur~(del,“dclsnotQxpnma )0
a
[10] notOe 'O~ #nma<(~" enms)/nma~(dvA@eN( = =in)ev\ine' " }/in ~| 4
[11] del+"*"e4p[ISTACK A were we at Desk Calculatorw
[12] :If notQa(1<pnma)>0 2 9e~THIS.ONC ~1d4nma A is the assignment legal?
[13] ur~'+ assignment syntax error' ¢ ur OSIGNAL dcl+2 o [-ur ¢ =
[14] tEndIf
[15] +(pin-(pnma) +in) 40 A Jv- is the same as ]
[16]
[17] [Gr=(del, %de=notl=pnma)OSE . SALTUES [s.5pice in
[18] {0:: ¢ ¢ wlsignal 100'},' ° A reset ODM =
[19] :If (0 2e510|0DR ur)aleppur z
[20] sAndIf (2tur)=(0UCS 8),'=" A error signature p
[21] ur OSIGNAL dcl#9i1 o Deféur © ~0 a signal error only if calles ||
[22] (EndIf ®
[23] &
[24] ~(1=pnma)p0 & Jecmd discard result M
[25] { {E1 :If Oepnma o reur Aano ‘=" return result by » | G _
- T e e e = S B 5
< 2i || = 5
Function Pos: 17/29,0 “ e Bl s
Ready... Ins NUM
CurObj: result (Undefined) g:1 OpQ:0 OTRAP [OsI:tf DOI0:1 [OML:1

Execution Reached JSE .UCMD[17]

The next illustration shows the result of clicking Trace at this point. This caused the
system to trace into JSE . SaltUtils.Spice, the function called from
OSE.uCMD[17].

Notice how each function call on the stack is represented by an item in the Sistack
window.
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Tools  View

WS % ol ol Wl % | Object [T g1 @@ # FE[A | Tool P 57 1= @ | Edit 7 & 9 Q| Session 1602

Language Bar X X
- - o a
E| [+[-[=[=]=[s[@lo[[2] [HFIL]]e[=I-] [F=[s<]=[z]=[#] [1]s]<[=[n]a]¥] zlelelsls] [F[=[].Ts[s| FOER[s]s| [o]a~|ulalv] o
Dyalog APL/W-6% Version 15.0.27293 ~
Serial No : 0000%2
Unicode Edition
Beta releese
Sun May B 13:54:45 2016
lclear ws
ldisplay 113
v
S ——— SO e _Ox
66 OO0 0 ™G n P iSseerch... ~|% % M aa||OSE.SAL «|| X |Spice[1]+a Called by the UCMD pro
a - = %,
[8] rl<bflist[sclname cMinlen] A reduced L1k A|(, UEMD[17] ur=(del,“delsnotQxpnma)l
(91 +0t¥exactvppos+Mhere b\rl[:1]een A find an ex»
[10] pos~Where bA((r1[:2][pn)t"rl[;1])e=n A try on all»
[11] sEndIf
[12] v
[0] v {(R}{rgn}Spice msg:arg:c:cmd;com:cs:details;DMX:helpshelpfor:izmon®
[1] [ Celled by the UCHMD progrem. This progrem cen also be used directly*
[2] (rgn ASN)=2t{6111 @ rgn}0 A Ls the result used (1) or simply disp* |l
[3] ASN=(modeBit 5)vUCauto<ASN @ In this version we disregard "Allow Sk |3
[4] z
[51 A Put = stop before the call if requested -
[6] cmd#¥+—"2%stop==DEBUG*' -'="2fcmdrrtb msg hd
[71 +If D<i=+/a\'?'=cmd={(']'=1tw)4u}rib cmd [
[8] cmd-emd[1i],' ‘,rlb id4cmd A ensure only one space -
(91 :EndIf A accept zcmd vg _
= e e ! - - @ 5
< >[] g 5
Function Pos: 164/1942,0 ¢ >||w
Ready... Ins NUM
CurObj: result (Undefined} g:1 ObQ:0 OTRAP [0SI:2 DOI0:1 | OML:3

Execution Reached JSE . SALTUtils.Spice [1]
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The illustration below shows the state of execution having traced deeper into the
system.

File Edit View Windows Session Leg Action Options Tools Threads Help

Ws % @l gl Wl Gy | Object (1 4 @ 3
Language Bar w:isniae
[Lelefele] 2] [Pl [=
Dyalog APL/W-64 Version 15.0.27293
ISerial No : 000042
Unicode Edition
[Beta release
|Sun May B8 13:54:45 2016
lclear ws

ldisplay 113

}si
[SE.SALT.Load[1]*
[ISE.SALTUtils.Spice[146]
[0SE.UCMD[17]

Tl £ 1= @ 6 @ 8 D @ sein
t)4]=|=|0[&[%] |t]efun/e|~ [5e!

elefa] [']

m a
|<[+] DOBE[=ls[s| [o[p[-Julslvls| 3
~ -

v
DebugQer o S B e 0 P O P -0Ox
66.CO Q00 %O v P iz|seerch... ~]% % B aa|[0sE.sAL o|| X [Load[1]x:Access Shared Public

r151 e 7| 0| sp1cel146] R+BS.spe+0 c DSE.SALT.

— 1 = B )

[16] e T =i e cllassas UCMD[17] ur+(del,*dclsnotQxpnma)l
[17] emd='"",class, " -noname',{OFAVERSION)/' -version=',AVERSION

[18] ref—#.ONEW(Load cmd),hesargs/cargs

[19] L v

[o0] El v {ref)}~{la}load fneme;allpsthsicicnamesext;file;files:fix;ifnamesfol ¥
(1] [ tAccess Shared Public
[2] & This function returns either o ref/name after defining the object in tr /=
(3] 8 or a VTV if the source was requested or several fns were defined or a » || 3
[4] El :If 1sHelp fneme z
[5] ref+'Load [pathlscriptfile’ '' 'Load a class in the workspace' -
[6] ref,~'' 'Modifiers:' il
71 ref,~c'-target=Namespace Specifies target namespace for Lk |[F
[8] ‘-disperse[=nami.nam2] Disperse elements in the target » -
[9] =" —key= Key to use to decode file' vl _
" N N - 3 =3
< >[5 H
Function Pos: 165/1482,0 “c > || W
Ready... Ins  NUM

CurObj: result (Undefined) 81 | OpQ:0 OTRAP [SI:3 [0I0:1 [DML:2

Execution reached four levels deep

At this stage, the State Indicator is as follows:

)SI
OSE.SALT.Load[1]x
OSE.SALTUtils.Spice[146]
OSE.UCMD[17]
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Controlling Execution

The point of execution may be moved by clicking the Back and Fwd buttons in the
Trace Tools window or, using the keyboard, by pressing Ctrl+Shift+Bksp and
Ctrl+Shift+Enter. Notice however that these buttons do not themselves change the
State Indicator or the display in the SIStack window. This happens only when you
restart execution from the new point.

You can cut back the stack by clicking the <EP> button in the Trace Tools window.
This causes execution to be suspended at the start of the line which was previously
traced. The same effect can be achieved using the keyboard by pressing Esc. It can
also be done by selecting Exit from the File menu on the Trace Window or by
selecting Close from its system menu.

The <RM> button removes the Trace window and resumes execution. The same is
achieved by the expression ~[JLC.

The <BH> button continues execution until the current function has run to
completion and control has returned to the calling function. It leaves the Trace
window displayed and allows you to watch execution progress.

Using the Session and the Editor

Whilst using the Tracer you can skip to the Session or to any Edit window and back
again. While it is docked, you may resize the Tracer pane by dragging its title bar,
and you may use the buttons provided to maximise, minimise and restore the Tracer
pane within the Session window.

Unless you move it, the cursor is positioned to the left of the suspended line in the
top Trace window.

Depending where the cursor is in the tracer window, pressing Shift+Enter (ED) or
selecting Edit from the File menu may cause an edit window to open. If the cursor is
in the first column of the Trace window, or on whitespace, the Editor is opened on
function or operator on top of the stack. If the cursor in on a name, the Editor is
opened on the name under the cursor (point-and-edit). With the cursor in any other
location, no action is undertaken.

When you finish editing, the window reverts to a trace window with the new
definition of the function or operator displayed.

You may also open a new edit window from within the Tracer using point-and-edit.

You can copy text from a trace window to the session for editing and execution or for
experimentation.

It is possible to skip from the Tracer to the Session and then re-invoke the Tracer on a
different expression.
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Setting Break-Points

Break-points are defined by JSTOP and may be toggled on and offin an Edit or
Trace window by clicking in the appropriate column. The example below illustrates
a function with a JSTOP break-point set on line [5].

.« Editor - [BUILD_SESSION]

ﬁ File Edit Syntax Window Refactor View - 8 X
= O ﬁf QHEearch... v % % an

[o] {FILE}BUILD_SESSION LANG;0BJ:MSG:[OIO:(OML:OLDsNEW;FN:MB:SB1;5B2:TB;SB:5Bm A
[1] A Build the session object and save if desired

[2] :If 0=[NC'NoPrompt® ¢ NoPrompt+0 ¢ :EndIf

[3] :If O=[NC'FILE' & FILE+'' ¢ :EndIf

[%]

[5] L ] OWX-{SE.OWX~1 o OML OIO~1 ¢ [OPATH-'#.Trans’

[6] OPW=122 p allows room for Status Bar

[7] LA upCase,LANG A translation assumes uppercase
[8] UNICODE-BO0=0DR"' '

[9]
[10] ( 'Unknown language, pick one of',sTrans.CODES)[SIGNAL(Trans.CODESe~cLAN®
[11]

[14]
[15] +EndTrap

[16] "
L4 >

Function Pos=: 0/183,1

[12] :Trap GUI-0O
[13] '0SE'OWS 'Coord"' 'ScaledPixel’

OSTOP break-points set or cleared in an Edit window are not established until the
function is fixed. JSTOP break-points set or cleared in a Trace window are
established immediately.

Clearing All Break-Points

You can clear all break-points by pressing the above button in the Trace Tools
window. This in fact resets JSTOP for all functions in the workspace.
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The Classic mode Tracer

If you select Classic Dyalog mode from the Trace/Edit tab in the Configuration
dialog box, the Tracer behaves in the same way as in Dyalog APL Version 8.2.
However, the Tracer is not dockable in the Session.

If you select the Classic mode Tracer, you may choose between multiple trace
windows or a single trace window using the Single Trace Window option.

Multiple Trace Windows

The following behaviour is obtained by deselecting the Single Trace Window
option.

« Each function on the SI stack is represented by a separate trace window.
The top window contains the function that is currently executing, other
windows display functions further up the stack, in the order in which they
were called.

o When you press Ctrl+Enter or click the Trace button on a line that calls
another function, a new trace window appears on top of the stack and
displays the newly called function.

o When a function exits, its trace window disappears and the focus moves to
the previous trace window. When the last function in a traced suspension
exits, the last trace window disappears.

o Ifyou click the Quit this function button in the Trace Tools window, or
press Escape, or close the trace window by clicking on its [X] button or
typing Alt-F4, the top trace window disappears and the focus moves to the
previous trace window

o Ifyou close any of the trace windows further down the stack, the stack will
be cut back to the corresponding point, i.e. to the line of code that called
the function whose trace window you closed.

o The <RM> button removes all the trace windows and resumes execution.
The same is achieved by the expression »[JLC. The <CS> button also
continues execution, but leaves the trace windows displayed and allows
you to watch their progress.

o If you minimise any of the trace windows, the entire stack is minimised to a
single icon, from which it may be restored.

Note that a maximum of 50 Trace windows may be displayed.
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Single Trace Window

The following behaviour is obtained by selecting the Single Trace Window option.

The trace window contains a combo box whose drop-down displays the
contents of the SI stack. This box is not provided if there are multiple trace
windows.

The trace window is re-used when tracing into, or returning from, a called
function. This means that there is never more than one trace window
present.

When the last function in a traced suspension exits, the trace window
disappears.

If you click the Quit this function button in the Trace Tools window, or
press Escape, the current function is removed from the stack and the trace
window reused to display the calling function if there is one.

Closing the trace window by clicking on its [X] button or typing Alt-F4
removes the window and clears the current suspension. It is equivalent to
typing naked branch (=) in the session window.

If you move or resize the trace window, APL remembers its position, so that
it reappears in the same position when next used.
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The Threads Tool

The Threads Tool is used to monitor and debug multi-threaded applications. To
display the Threads Tool, select Show Threads Tool from the Session Threads menu,
or Threads from the Session pop-up menu.

. Threads

Tid Location State Flags Treg
Tid:0 {(Rumn) «RUN[&3] OTGET ... Session Normal

Tid:1 (GUI) SHOW[22] ODQ'F' oo Paused

Tid:2 (Lift 1} GOTO[10] OOL 0.2 QDL Paused

Tid:3 (Lift 2} GOTo[10] ODL 0.2 doL Paused

Tid:1% (Lady 1%) PERSON[7] OTGE... OTGE... Paused 31
Tid:20 (Lady 20) PERSON[7] OTGE... [OTGE... Paused 42
Tid:21 (Man 21) PERSON[7] OTGE... [OTGE... Paused 22
:Tid:23 (Man 23) PERSON[4] Lift... [OTGE... Paused 2

€ >

“Ox

Token Paool

1001.5

The above picture illustrates a situation using the 11 ft . dws workspace after
executing the function RUN. The Pause on Error option was enabled and a Stop was
seton RUN[63]. When RUN suspended at this point, all other threads (1-8) were
automatically Paused. Note that all other threads happen to be Paused in the middle
of calls to system functions

The columns of the Threads Tool display the following information.

Column

Description

Tid

The Thread ID (OTID) and name (OTNAME) if set

Location

The currently executing line of function code

State

Indicates what the thread is doing. (see below)

Flags

Normal or Paused.

Treq

The Thread Requirements (OTREQ)
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Thread States
State Description
Pending Not yet running
Initializing Not yet running

Defined function

Between lines of a defined function

Dfn

Between lines of a dfn

Indicates that the thread is suspended and is able to

Suspended accept input from the Session window.
. Indicates that Session window is connected to this
Session
thread.
Indicates that the thread has no SI stack and the Session
(no stack) is connected to another thread. This state can only occur
for Thread 0.
Exiting About to be terminated
:Hold Waiting fora :Hold token
:EndHold Waiting for a : Hold token
doL Executing DL
0oQ Executing [IDQ
ONA Waiting for a DLL (0NA) call to return.
OTGET Executing OTGET, waiting for a token
OTGET

(Ready to continue)

Executing TGET, having got a token

OTSYNC

Waiting for another thread to terminate

Awaiting request

Indicates a thread that is associated with a NET system
thread, but is currently unused

Called NET

Waiting for a call to .NET to return.
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Paused/Normal

In addition to the thread state as described above, a thread may be Paused or Normal
as shown in the Flags column. A Paused thread is one that has temporarily been
removed from the list of threads that are being scheduled by the thread scheduler. A
Paused thread is effectively frozen.

Threads Tool Pop-Up Menu

Switch to
Interrupt

Ignare Interrupts

Refresh Mow
Auto Refresh

" Pause Threads on Error

~  Paused
Pause All

Resume All

Restart All
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Selecting this item causes APL to attempt to suspend (if

Switch to necessary) and switch to the selected thread, connecting
it to the Session and Debugger windows.
Causes a (STRONG) interrupt in the selected thread the
Interrupt next time it is scheduled, essentially it allows you to

target an interrupt at a specific thread.

Ignore Interrupts

Allows you to specify that the selected thread should
ignore weak interrupts.

Refresh Now

Refreshes the Threads Tool display to show the current
position and state of each thread.

Auto Refresh

Selecting this item causes the Threads Tool to be
updated continuously, so that it shows the latest
position and state of each thread.

Pause Threads on
Error

If this item is checked, APL automatically Pauses all
other threads when a thread suspends due to an error or
an interrupt.

This item toggles a thread between being Paused and

Paused Normal. It Pauses a Normal thread and resumes a
Paused thread.

Pause All This item causes all threads to be Paused.

Resume All This item resumes all threads.

Restart All This item resumes all Paused threads, restarts all

suspended threads, and closes the Debugger.
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Debugging Threads

The Debugger provides a tabbed interface that allows you to easily switch between
suspended threads for debugging purposes. To keep things simple for non-threaded
applications, Tabs are only displayed if there is a thread suspended that is other than
Thread 0. The following picture shows the Debugger open on a multi-threaded
application (LIFT.DWS) when only Thread 0 is suspended. This has been achieved
by setting a stop on RUN[63]

/& C:\Program Files\Dyalog\Dyalog APL-64 15.0 Unicode\ws) vs - Dyalog APL/W-64

File Edit View Windows Session Log Action Options Tools Threads Help

Ws 5 @l gl Ml %y | Object (1 5] @ 2 FEIR | Tool P 5= @ |Edit @ & 9D Q| Session 18]

Language Bar x | X

=T m = | O
[ (EEel[efgfel 2] [VrLLfrl] [l<[-[el=le] [[of215] [o]¢[=I-[0fafe] [[e]ulr]e] o[slelele] ?| [DOBBll| |oln-julalvls & g
Unicode Edition ~
Beta releese
Sun May B 16:16:21 2016
clear ws
C:\Program Files\Dyalog\Dyslog APL-6% 15.0 Unicode\ws\lift.dws seved Thu Apr 28 17:23:52 2016
Lift simulation designed to illustrate multi-threading
lend thread synchronisation, using the Token Pool.
To run it:

RUN 20 a Simulste 20 arrivals

RUN 20 A Simulate 20 arrivals

RUN[63]
v
Debugger —-Oox
66QOC00 %O n Pis|searcn .. ~|% % M an ||RUN[63] || % [RUN[63]+OTGET 2pJabDane a Wa
u]
[56] OTGET GUIReady P
[57] F.LIFTL F.LIFT2 LIFT&"cFLOORS CAPACITY a Start Lift threads
[58] tFor I tIn 1N R Start <N> people threads
[59] PERSON&FLOORS =
[60] ObL 0.2x210 # Simulate random(ish) arrival =
[61] tEndFor 3
[62] OTPUT Al LDone R Tell Lifts "that’s it" s
[63] i@ [OTGET 2pJobDone R Wait until Lifts have finished delivering men ~
[64] DTKILL OTNUMS R Zsp any threads JlE
] .
2 5
g >[ )= S
Function Pos: 63/65,0 @l > W
Ready... Ins NUM

CurObj: RUN (Function) g:8 OpQ:0 QOTRAP [sI:1 [O10:1 [OML:0
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In the next picture, the user has chosen to display the Threads Tool and then dock it
between the Session and Debugger windows. Note that only one thread, thread 0
(Run)is suspended. All the other threads are Paused (because Pause on Error is
enabled).

,® CAProgram

File Edit View Windows Session Leg Action Options Tools Threads Help

WS ol Wl %y [ Obet (D A1 @ SBR[ Tood £ SIS Bt D A9 Q| session

Language Bar [ . O T
- o a
] [ lofgfel 7] [IFILL: 1¢[<=[0fafe] [:lefulelel Llslelelel] [ 1os] DOBE[lel| [o[e-fulalvlz] ]
~
RUN 20 @ Simulate 20 arrivals
RUN[&3]
v
Threads - S S8 5 S R R R e T~ Ox
Tid Location State Flags Treg
Tid:0 (Run) =RUN[63] OTGET 2pJobDene A Wait until Lifts have... Session Normal
Tid:t (GUT) sHOW[22] ODQ'F* janle} Paused
Tid:2 (Lift 1) GOTO[10] ODL 0.2 oL Paused
Tid:3 (Lift 2) GOTO[10] ODL 0.2 oL Paused
Tid:1% (Lady 1%)  PERSON[7] OTGET Lift REACHED MYFLOOR & Wait for Li... [TGET (Ready to cont... Paused 31
Tid:20 (Lady 20)  PERSON[7] OTGET Lift REACHED MYFLOOR & Wait for Li... [TGET (Ready to cont... Paused 42
Tid:24 (Man 21) PERSON[7] OTGET Lift REACHED MYFLOOR A Weit for Li... OTGET (Ready to cont... Paused 22
iTid:23 (Man 23) PERSON[4] Lift-0TGET GoingUp A Wait for Li... OTGET (Ready to cont... Paused 2
DebugQer o S B e 0 P O P -0Ox
66 QOO0 %O n P is|[search... ~]% % M aa |[rUN[63] || X [RUN[E3T-OTGET 2oTobDone A Wa
a
[56] OTGET GUIReady |y
[57] F.LIFTY F.LIFT2 LIFTR"=FLOORS CAPACITY a Start Lift threads
[58] :For I :In N A Start <N> people threads :
[59] PERSONEFLOORS. =
[60] ODL 0.2x210 A Simulate random(ish) arrival ©
[61] :EndFor e
[62] OTPUT Al lDone A Tell Lifts "that’s it" “
[63] @ [OTGET 2pJobDone A Wait until Lifts have finished delivering men v|[g L
< B - > || 2
P} 5
Function Pos: 63/65,0 vl >||w
Ready... Ins NUM

CurObj: RUN (Function) g:8 OpQ:0 OTRAP  [SI:f DOIO:1 [OML:0
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The user then uses the context menu to Switch To Thread 6 (whose name is Lady 6)
which was Paused on PERSON[ 7] in the middle of a[JTGET. The act of switching
to this thread caused it to be suspended at the beginning of its current line PERSON
[7] and the Debugger now displays two Tabs to represent the two suspended
threads. Note that both the thread id and the thread name are displayed on the Tabs.

JB C:\Program Files\Dyalog\Dyalog APL 12.1 Unicodewsilift - Dyalog APL/W =]
File Edit View ‘Windows Session Log Action Options Tools Threads Help

wi D EORE Y obiex BB Y V bh b2 @ = Tool @G R G Ede ¥ Ca  Session [ |APL3ES Unicode | w|[ 1B

Language Bar i =11 ﬁ
([P EReERITE (L] =R [0 [=[oo[=] [-[el#l=[s] [FLLL] O[] [lallldel] [f] & | =
MYFLOOR =
"
M
Threads Zlalx|
Tid Location State Flags | Treq
0 Run  +RUN[63] OTGET 2plobDone A Wai... Suspended Paused
1: BUI sHOW[22] ODQ'F' ooa Paused
2: Lift 1 GOTO[10] ODL 0.2 ooL Paused
3: Lift 2 GoTO[107 ODL 0.2 ooL Paused
S: Man 5 PERSONL7] DOTBET Lift REACHED MYFLO... OTGET (Ready to continue) Paused b1
6: Lady & =PERSON[7] DTBET Lift REACHED MYFLO... Session Normal
7t Man 7 PERSON[] Lift+OTGET Goingllp .. DOTGET (Ready to continue) Paused 2
8: Lady 8 PERSON[4] Lift<OTGET Goingllp ... OTGET (Ready to continue) Paussd 2
Debugger ~=lolx|
0: Run| 6 Lady 6 ﬂ PERSON[T1+OTGET Lift REACHED MYFL
o
STUMW PP PEXNRAE ~| 0% 8 | PERSONI71+OTEE |~ | 1
I31 ARRIVE W Arrive at 11Ft shaft || &
41 Lift«OTGET Goingllp A Wait for 1ift door to be open/fres z
[s] Lift BETIN MYFLOOR<?FLOORS A Get inta the Lift, tell the 1ift where 17 » ||| §
161 MYFLOOR OTPUT Lift.ID+ManIn A Clear the Lift door For next person pri
[71 OTGET Lift REAGHED MYFLOOR A Wait for ITft to reach my Floor =
181 Lift GETOUT HVFLOOR A De-Lift =
[31 OTRUT Lift.I1D+ManOut A Tell Lift I’m out, thread ends V|| =
< 2 |8 g
= 2
Function Last saved by: Dyslog: 02 My 2004 13:28 Posi 7/10,0 7 e 51| &
Ready... Ins  NUM
CurObj: MYFLOOR (Variable) 2:8 | O0Q:0 [OTRAP | Osl:2  OI0:1  OML:0

Note also that the Session window is connected to the thread indicated by the
selected Tab. In this case, typing MYF LOOR into the Session window displays the
value of'the local variable MYFLOOR in Thread 6 (Lady 6).
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You can use the Tabs to switch between the suspended threads, so clicking the Tab
labelled 0 : Run causes the display to change to the picture shown below. The
Session is now connected to Thread 0 (Run), so the value of [JLC is 63.

JB C:\Program Files\Dyalog\Dyalog APL 12.1 Unicodewsilift - Dyalog APL/W =]
File Edit View ‘Windows Session Log Action Options Tools Threads Help

wi D EORE Y obiex BB Y V bh b2 @ = Tool @G R G Ede ¥ Ca  Session [ |APL3ES Unicode | w|[ 1B

Language Bar i =11 ﬁ
[LLELeERrT) O] =R (=[] [e[2[]=]-] [[Tel#lel] PEELL] ool [olnflelele] [o] &) @
[\ -~
63
M
Threads Zlalx|
Tid Location State Flags | Treg
0: Run +RUNL63] OTGET ZpJobbane A Wai... Session Narmal
1: BUI SHOW[22] O0Q'F' oo Paused
2: Lift 1 GOTO[10] ODL 0.2 onL Paused
3: Lift 2 GOTO[10] ODL 0.2 onL Paused
S: Man 5 PERSON[7] OTGET Lift REACHED MYFLO... OTGET (Ready to continue) Faused b1
6: Lady 6 +PERSON[7] OTGET Lift REACHED MYFLO... Suspended Normal
7t Man 7 PERSON[L] Lift<OTGET Goinglp ... OTGET (Ready to continue) Paused 2
8: Lady & PERSON[4] Lift<OTRET GaingUp ... OTGET (Ready to continue) Paused 2
Debugger =lol=l
0: Run|g: Lady 6 ﬂ RUN(631+OTGET 2pTobDone A Wy
o
STUMW PP PEXNRAE ~| 0% 8 [RunLes]-OTGeT |~ | 1
[56] OTGET GUIReady ~
1571 F.LIFT! F.LIFTZ LIFT&"=FLOORS CAPACITY m Start Lift threads =
[58] iFor 1 iln N A Start <N> people threads &z
[59] PERSON&FLOORS P
[60] 0oL 0.2x710 A Simulate random(ish) arrival =
[61] tEndFor || =
[62] OTPUT AllDane A Tell Lifts "that’s it" v | =
<] 2 || 8 g
2 2
Function Last saved by: Dyalog: 09 July 2004 08:36 Pos: 63/65,0 o ¢ 5 i
Ready. .. Ins  NUM

CurObj: MYFLOOR (Variablel &8 gpg:o  OTRAP  [OST1:1  Q0OI0:1  [OML:0




Chapter 1: The APL Environment

165

The Event Viewer

The Event Viewer can be used to monitor events on Dyalog APL GUI objects. To

display the Event Viewer, select Event Viewer from the Session Tools menu.

You can choose:

« which types of events you want to monitor
« which objects you want to monitor

Spy Columns Select Options

ObjectName
F

T EEEEE R
M m

Object
Form
Form
Form
Form
Form
Form
Form
Form
Form
Form
Form
Form
Form
Form
Form

Farm

Eventhame
GotFocus
Mouselp
Mouselp
MouseDbLClick
Mouselp
Configure
Configure
Configure
Configure
Configure
Configure
Configure
Configure
Configure
Configure

Canfinure

Event

Parameters

26.
32.
32.
32.
61.
61.
61.
61.
61.
61.
61.
61.
61.
61.
_LR1LTOAL

Al

1437912 32.426303...
.82766. ..
.82766...
.82766. ..
51041...
45833...
40625. ..
35%16...
30208. ..
25 28...
19791. ..
14583...
14583. ..
09375...
9375 .

35293961
35293961
35293961
QuLLL275
4444275
SLLLE2TS
85185242
75925827
75925827
66666794
57407379
48147964
43147964

Action

BoE oW R OB OB R R R R R OO OO O

FOO
FOO
FoO
FoO
FoO
FoO
FoO
FOO
FoO
FOO

-FOO

ThreadID

oo oco0o0O0O0CO0O0CO000 O

NQed

oo oco0o0O0O0CO0O0CO000 O

EventlD
317
318
319

2016
2016
2016
2016
2016
2016
2016
2016
2016
2016
2016
2016
2016
2016
2016
2016

L T I R I )

e ®mE P ®Em®E 0O 0 E

Timestamp
31 947

35 17
35 106
35 196

37 107

37 375

In the example illustrated above, the user has chosen to monitor events on a Form

# . F. Furthermore, the user has chosen to monitor GotFocus, LostFocus, MouseUp,

MouseDblIClick and Configure events. Notice that there is a callback #. FOO
attached to the Configure event.
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The Spy Menu
Clear
Copy
e Al

When Placed in Object's Queue

Current Queue State

~*  Enable Logging

Cloze

The Spy menu, illustrated above, provides the following options and actions.

Item Description
Clear Clears all of the event information that is currently
displayed in the Event Viewer.
Copy Copies the highlighted rows to the clipboard.
In this mode all the events are displayed in the Event
All Viewer as they occur, whether or not there is an action

associated with them.

When Placed in
Object's Queue

In this mode only events that have associated actions

are displayed in the event viewer. Note that KeyPress
events are always queued and therefore always appear,
even if there is no associated action.

Current Queue State

In this mode the Event Viewer displays a snapshot of
the internal event queue. Only those events that are
currently in the interal APL event queue waiting to
be processed are displayed.

Enable Logging

This item switches event logging on and off.

Close

Closes the Event Viewer
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The Columns Menu

ObjectMame
ObjectType
EventMame
EventMumber
Parameters
Action
ThreadID
MNCed

EventlD

L L T T L S N

Tirnestarnp

The Columns menu allows you to choose which information is displayed for the
events you are monitoring.

Item Description

If checked, this item displays the name of the object

ObjectName on which the event occurred.

If checked, this item displays the #ype of the object on

ObjectType which the event occurred.

If checked, this item displays the name of the event

Event N
vent IName that occurred.

If checked, this item displays the event number of the

Event Number
event that occurred.

If checked, this item displays the parameters for the
Parameters event that occurred. These are the items that would be
passed in the argument to a callback function.

If checked, this item displays the action associated
Action with the event, for example the name of a callback
function, or an expression to be executed.

If checked, this item displays the thread id of the

Thread ID thread in which the event occurred

If checked, this item displays 0 or 1 according to
NQed whether or not the event occurred naturally or was
generated programmatically by [NQ.
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Item Description
Event ID If checked, this item displays the event id of the event
© that occurred. This id is used internally.
TimeStamp If checked, this item displays the time stamp of the
event that occurred.
The Select Menu
Select All

Select Matching Events
Select All Events on this Object
Select All Events of this Type
The Select menu allows you to highlight certain events in the Event Viewer. For

example, if you are monitoring TCP/IP events on a number of TCPSockets, you can
highlight just the events for a particular socket.

Item Description

Select All Highlights all the events.

Highlights all the events that have the same Object
and Event Name (or Event Number) as the currently
selected event.

Select Matching
Events

Select All Events on |Highlights all the events that have the same Object as
This Object the currently selected event.

Highlights all the events that have the same Event
Name (or Event Number) as the currently selected
event

Select All Events of
this Type

These items are also available from the pop-up menu that appears when you press the
right mouse button over an event displayed in the Event Viewer window.
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The Options Menu

Always on Top
~  Lse APL Font

Settings...

The Options menu allows you to choose which information is displayed for the
events you are monitoring.

Item Description

If checked, this item causes the Event Viewer window
Always on Top to be displayed above all other windows (including
other application windows).

If checked, this item causes the information displayed
in the Event Viewer window to be displayed using the
Use APL font APL font (the same font as is used in the Session
window). If not, the system uses the appropriate
Windows font.

Settings... Displays the Event Viewer Options Dialog Box.
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Options Dialog Box

The Event Viewer Options dialog box allows you to select the objects and events
that you wish to monitor.

Event Viewer Options

Options
Ewents to view:

[ User defined events

Obijects to view:

Find Taok @

Select From List...

Name D ~ M ame:
MouzeDawn 1 Type:
Mouselp 2
[ MouseMave 3 ThreadlD:
[ MouseClick 4
MouseDbIClick 5 Hardle:
[ touseEnter 3
[ MouselLeave 7 [ Parent Object
[ Mousetwheel 8
[ DragOver 1 [ child Objects
[ Draghrop 1
[] DragStart 12 [ Same Thread
[ DragListtove 15
[ DragListCopy 16 [] &l Objects
1 kel har 19 hd

et Check Selected Check Al Clear Al L] Obiects of Type el oIty

B event(s] of 300 selected

Canesl
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Events to view

The list box shows all the events that are support by the Dyalog APL GUI and allows
you to select which events are to be monitored. User defined events may be selected
by checking the User defined events box. Only those events that are selected will be
reported. You can sort the events by name or by event number by clicking the
appropriate column header.

Objects to view

Item Description

This tool allows you to choose a single specific
Dyalog APL GUI object that you want to monitor. To
use it, drag the Find Tool and move it over your
Dyalog APL GUI objects. As you drag it, the
individual objects are highlighted and their details
displayed in the Name, Type, Thread ID and Handle
fields. Drop the Find Tool on the object of your
choice.

Find Tool
Select from List

Clicking the Select from List button brings up a
dialog box that displays the entire Dyalog APL GUI
structure as a tree view. You can choose a single
object by selecting it.

Enables event reporting on the selected object's

Parent Object . .
) immediate parent.

Enables event reporting on the all selected object's

Child Objects descendants (at any level).

Enables event reporting on all the objects in the same

Same Thread thread as the selected object.

Enables event reporting on all Dyalog APL GUI

All Objects objects.

Activates the adjoining Select button and disables all
other Object selection mechanisms.

Objects of Type
Select from List Clicking the Select from List button brings up a
dialog box that allows you to choose which types of
Dyalog APL GUI objects you want to monitor.
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The Session Object

Purpose: The Session object [JSE is a special system object that represents
the session window and acts as a parent for the session menus, tool
bar(s) and status bar.

Children Form, MenuBar, Menu, MsgBox, Font, FileBox, Printer, Bitmap,
Icon, Cursor, Clipboard, Locator, Timer, Metafile, ToolBar,
StatusBar, TipField, TabBar, ImageList, PropertySheet, OLEClient,
TCPSocket, CoolBar, ToolControl, BrowseBox

Properties  Type, Caption, Posn, Size, File, Coord, State, Event, FontObyj,
YRange, XRange, Data, TextSize, Handle, HintObj, TipObyj,
CurObj, CurPos, CurSpace, Log, Input, Popup, RadiusMode,
MethodList, ChildList, EventList, PropList

Methods ChooseFont, FileRead, FileWrite

Events Close, Create, FontOK, FontCancel, WorkspaceLoaded,
SessionPrint

Description

There is one (and only one) object of type Session and it is called JSE. You may use
OWG, OWS and [OWN to perform operations on [JSE, but you cannot expunge it with
OE X nor can you recreate it using OWC. You may however expunge all its children.
This will result in a bare session with no menu bar, tool bar or status bar.

[SE is loaded from a session file when APL starts. The name of the session file is
specified by the session_file parameter. If no session file is defined, JSE will have no
children and the session will be devoid of menu bar, tool bar and status bar
components.

You may use all of the standard GUI system functions to build or configure the
components of the Session to your own requirements. Y ou may also control the
Session by changing certain of its properties.

Note that the Session reports a Create event when APL is first started, and a
WorkspaceLoaded event when a workspace is loaded or on a clear ws.

The Session also reports a SessionPrint event when certain types of output are about
to be displayed. This may be used to alter the normal default display.
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Read-Only Properties
The following properties of [JSE are read-only and may not be set using [JWS:
Type A character vector containing 'Session'
. A character vector containing the current caption in the title bar
Caption . .
of the Session window.
TextSize Reports the bounding rectangle for a text string. For a full
description, see TextSize in Object Reference.
A character vector containing the name of the current object.
CurObj This is the name under or immediately to the left of the input

cursor.

A 2-clement integer vector containing the position of the input
cursor (row and column number) in the session log. This is JI0
CurPos dependent. If IO is 1, and the cursor is positioned on the
character at the beginning of the first (top) line in the log,
CurPos is (1 1). IFQIO0 is 0, its value would be (0 0).

A character vector which identifies the namespace from which
the current expression was executed. If the system is not

CurSpace executing code, CurSpace is the current space and is equivalent
to the result of ' '[ONS ' '.
Handle The window handle of the Session window.

A vector of character vectors containing the most recent set of
Log lines (input statements and results) that are recorded in the
session log. The first element contains the top line in the log.

A vector of character vectors containing the most recent set of
Input input statements (lines that you have executed) contained in the
input history buffer.

A vector of character vectors containing the types of object that

ChildList .

can be created as a child of [JSE.
MethodList A vector of chgracter yectors containing the names of the

methods associated with [JSE.

. A vector of character vectors containing the names of the events

EventList

generated by [JSE

. A vector of character vectors containing the names of the

PropList

properties associated with [JSE.
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Read/Write Properties

The following properties of JSE may be changed using OWS:

Coord | Specifies the co-ordinate system for the session window.

May be used to associate arbitrary data with the session object

Data [SE.

You may use this property to attach an expression or callback
function to the Create event or to user-defined events. A callback
attached to the Create event can be used to initialise the Session
when APL starts.

Event

The full pathname of the session file that is associated with the
File current session. This is the file name used when you save or load
the session by invoking the FileRead or FileWrite method.

Specifies the APL font. In general, the FontObj property may
specify a font in terms of its face name, size, and so forth or it may
specify the name of a Font object. For applications, the latter
method is recommended as it will result in better management of
font resources. However, in the case of the Session object, it is
recommended that the former method be used.

FontObj

Specifies the name of the object in which hints are displayed.
Unless you specify HintObj individually for session components,
this object will be used to display the hints associated with all of
the menu items, buttons, and so forth in the session. The object
named by this property is also used to display the message
"Ready..." when APL is waiting for input.

HintObj

A character vector that specifies the name of a popup menu to be
Popup |displayed when you click the right mouse button in a Session
window.

A 2-element numeric vector containing the position of the top-left
corner of the session window relative to the top-left comer of the

Posn screen. This is reported and set in units specified by the Coord
property.
Size A 2-element numeric vector containing the height and width of the

session window expressed in units specified by the Coord property.
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An integer that specifies the window state (0=normal, 1=minimised,
2=maximised). You may wish to use this property to minimise and
State later restore the session under program control. If you save your
session with State set to 2, your APL session will start off
maximised.

Specifies the name of the object in which tips are displayed. Unless
you specify TipObj individually for session components, this object
will be used to display the tips associated with all of the menu
items, buttons, and so forth in the session.

TipObj

XRange | See Object Reference

YRange | See Object Reference
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Special Properties

The following properties of [JSE are used intemally by Dyalog tools such as SALT.
They are not intended nor supported for general use and are not reported by PropList.

StatusWindow

This read-only property returns a reference to the Status
Window. The expression:

(OSE.OWG'StatusWindow' )OWG'Text ' returns the
(read-only) contents of the status window.

This read-only property returns a reference to the Editor
Editor Window. The Editor generates the special events Fix,
AfterFix and Format.

Special Events

The following special events are generated by [JSE or its child objects. They are used
internally by Dyalog tools such as SALT. They are not intended nor supported for

general use.

AfterFix

This event is reported by the Editor after it has
successfully fixed a new object, or a new version of an
object, in the workspace.

Fix

This event is reported by the Editor when the user
attempts to fix an object.

Format

This event is reported by the Editor when the user
attempts to format an object.

SessionPrint

This event is reported when a value is about to be
displayed in the Session window. The default display of
the value may be intercepted by a callback function and
displayed differently. This event is used by the Jbox
and ]Jrows user commands.

WorkspaceLoaded

This event is generated when a workspace is loaded or
upon )CLEAR.




Chapter 1: The APL Environment 177

AfterFix

Event 822

Applies To: Editor

Description

If enabled, this event is reported immediately after the Editor has successfully fixed a
new object, or a new version of an object, in the workspace.

Y ou may not nullify or modify the event with a 0-returning callback, nor may you
generate the event using [ONQ, or call it as a method. However, returning 0 from a
callback will cause the Edit window to remain open if the user action was Fix and
Exit (EP).

The event message reported as the result of 0DQ, or supplied as the right argument to
your callback function, is a 6-element vector as follows :

[1] [Object |refto the Editor object
[2] |Event "AfterFix"' or 822

the contents of the Edit window, as a vector of character
[3] |Contents

vectors
[4] |Space ref to the namespace in which the object will be fixed
[5] Old a c.haracter Ve?ctor containing the on'g%nal name of the
Name object when it was opened by the Editor
[6] New a character vector containing the name of the object which

Name was fixed. This is empty if the object is a variable.
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Fix

Event 820

Applies To: Editor

Description

If enabled, this event is reported when the user attempts to fix an object from the
Editor window. It is reported immediately, before the user's action is processed in any
way by the Editor.

The default action is to check whether the object has changed. If not, no further
action takes place. If the object has changed, the system validates the contents of the
Edit window, and either displays an error dialog or fixes a new version of the object
in the workspace. If the user action was to fix and exit (EP), the Edit window is
closed unless the validation failed.

If the callback function returns 0, the default action is aborted in its entirety (not even
the validation takes place) and the Edit window remains open.

Y ou may not generate the event using ONQ, or call it as a method.

The event message reported as the result of [IDQ, or supplied as the right argument to
your callback function, is a 6-element vector as follows :

[1] [Object ref to the Editor object
[2] |Event '"Fix' or 820

the contents of the Edit window, as a vector of character
[3] |Contents

vectors
[4] |Space ref to the namespace in which the object will be fixed
(5] Old a character vector containing the original name of the
Name object when it was opened by the Editor
[6] New a character vector containing the new name of the object.
Name This is empty if the object is a variable.

For objects whose names are part of the content of the Edit window, this event is not
reported if the name is missing or invalid. Instead the system will display an error
dialog box.
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Format

Event 821

Applies To: Editor

Description

If enabled, this event is reported when the user attempts to format an object in the
Editor window.

If the callback function returns 0, the contents of the Edit window are not
reformatted.

You may not generate the event using [NQ, or call it as a method.

The event message reported as the result of JDQ, or supplied as the right argument to
your callback function, is a 6-element vector as follows :

[1] |Object |refto the Editor object

[2] |Event '"Format' or 821

the contents of the Edit window, as a vector of character
[3] [Contents

vectors
[4] |[Space ref to the namespace in which the object will be fixed
[5] Old a c.haracter Vf?CtOI' containing the orig%nal name of the
Name object when it was opened by the Editor
[6] New a character vector containing the new name of the object.

Name This is empty if the object is a variable.
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SessionPrint Event 526

Applies To: Session

Description

Ifenabled, this event is reported when a value is about to be displayed in the Session.
It is generated by the display of a variable or the result of a function including system
variables and functions. Error messages and output from system commands do not
generate this event.

The event message reported as the result of JDQ, or supplied as the right argument to
your callback function, is a 2-element vector as follows :

[1] |Object ref or character vector

[2] |Event 'SessionPrint' or 526

The attachment of a callback function intercepts and annuls the normal display of
any value.

Note that this event may be extended in future; in particular the number of elements
in the event message may be increased, and the event may be generated by some
system commands. Y ou should therefore allow for such extensions in any code
which refers to SessionPrint.

When the event is generated, the left argument of the callback function contains the
value which was about to be displayed. The callback function may display this or
any other value, using default output or by assignment to [1. If so, this output will be
processed normally, without generating a subsequent SessionPrint event. If the
callback fails to explicitly display anything, nothing will appear in the Session.

Example

OVR'OSE.TimeStamp'

V VAL TimeStamp EV
[1] 0TS VAL

v

'OSE'OWS'Event' 'SessionPrint' '0OSE.TimeStamp'

2
2014 9 18 16 20 38 318 2

OA
2014 9 18 16 20 44 668 ABCDEFGHIJKLMNOPQRSTUVWXYZ
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The result (if any) of the callback function is ignored.

You may not disable the event (by setting its action to ~ 1), nor generate the event
using [NQ, nor call it as a method.

WorkspaceLoaded Event 525

Applies To: Session

Description

Ifenabled, this event is reported when a workspace is loaded orona clear ws.
Y ou may not nullify or modify the event with a 0-returning callback, nor may you
generate the event using ONQ, or call it as a method.

The event message reported as the result of JDQ, or supplied as the right argument to
your callback function, is a 2-element vector as follows :

[1] [Object ref or character vector

[2] |Event 'WorkspacelLoaded' or 525

This event is fired immediately after a workspace has been loaded and before the
execution of L X.

The callback function you attach should be defined in (JSE.
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Configuring the Session

As supplied, your default session will have a menu bar, a tool bar and a status bar.
There are many ways in which you may configure this set-up, including the
following:

You may select a different APL font or character size.

Y ou may alter the appearance of the menus by changing the Caption properties of the
various Menu and Menultem objects. For example, you may prefer the menus to
appear in your own language.

You may alter the structure of the menus. For example, you may wish to create a
Search menu directly on the menu bar rather than having Find and Replace as part of
the Edit menu.

You may add new Menu and Menultem objects to the menu bar, or new Button
objects to the tool bar, that execute APL functions or expressions for you. You can
store the code inside the [JSE namespace so that it is remains available when you
switch from one workspace to another.

You may add other objects to the tool bar to allow you to provide input for your
functions or to display output. For example, you may display a Combo object that
offers you a selection of names applicable to a particular task.

Y ou may add additional toolbars.

Y ou may remove objects too; for example, you can remove fields from the StatusBar
or even delete it entirely. Indeed, you may dispense with the menu bar and/or tool bar
as well.

This section illustrates how you can configure your session using worked examples.
The examples are by no means exhaustive, but are designed to demonstrate the
principles. Please note that the structure and names of the objects used in these
examples may not be identical to your default session as supplied. Before you
attempt to change your session, please check the structure and the object names using
OWN and OWG. The supplied session was created using the function BUILD _
SESSION in the workspace BUILDSE. If you wish to make substantial changes to
your session, you may find it most convenient to edit the functions in this workspace,
re-run BUILD SESSION, and then save it.

Please note that these examples assume that Expose Session Properties is enabled.
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Changing the Font

The APL session font is defined by the Font property of JSE. To change the font
permanently, you should select a different Font and/or size of Font using the combo
and spinner boxes on the Session toolbar, and save your Session.

Classic Edition is distributed with bitmap fonts suitable for use on your screen, and
TrueType fonts for your printer. You can use the TrueType font on the screen, but it
is less attractive than the bitmap fonts at low resolutions. The bitmap fonts come in
two sizes (16 x 8 and 22 x 11) and two weights (normal and bold). You may select
other sizes, so long as the height is a multiple of 16 or 22. The scaling is performed
automatically by Windows.

Changing Menu Appearance

The name of the Session MenuBar is ISE . mb'. To simplify the specification of
object names, we will first change space to the MenuBar itself:

)CS [OSE.mb
0OSE.mb

The names of the Menu objects owned by the MenuBar are given by the expression:

‘Menu' [OWN "'
file edit view windows session Llog action options
tools threads help

The current caption on the file menu is:

file.Caption
&File

To change the Caption to Workspace:
file.Caption«'Workspace'
To change the colour of the New option in the File menu to red:

file.clear.FCol«255 0 O
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Reorganising the Menu Structure

This example shows how you may alter the structure of the session menus by adding
a Search menu to the menu bar to provide access to the Find and Find/Replace
dialog boxes and removing these options from the Edit menu.

To simplify the process, we will first change space into the MenuBar object itself:

)CS [SE.mb
(SE.mb

Then we can begin by adding the Search menu. You can specify where the new
menu is to be added using its Posn property. In this case, Search will be added at
position 3 (after Edif).

'search'[JWC 'Menu' '&Search' 3

Next we will remove the Find and Replace Menultem objects from the Edit menu.
Their names can be obtained from [JWN:

‘MenuItem'0WN'edit'
edit.prev edit.next wedit.clear edit.copy edit.paste
edit.find edit.replace

It is worth noting that these Menultems perform their actions because their Event
property is set to execute the system operations [Find] and [Replace]
respectively when they are selected.

edit.find.Event
Select [Find]

edit.replace.Event
Select [Replace]

The following statement removes them from the Edit menu:
OEX"'edit.find' 'edit.replace'’
and the following statements add them to the Search menu:

'search.find' OWC 'Menultem' '&Find'
('Event' 'Select' '[Find]')
‘search.replace' [OWC 'Menultem' '&Replace’
('Event' 'Select' '[Replacel]')
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Adding your own Menultem

This example shows how you can add a menu item that executes an APL expression.
In this case we will do something very simple; namely add a Time option to the
Tools menu which will execute (JTS. Notice that the statement also defines a Hint.
This will be displayed when you select the option, prior to releasing the mouse
button to action it.

Once again, we will start by changing space into the Tools menu itself

)CS [JSE.mb.tools
OSE.mb.tools

Then we will define a new Menultem to perform the action we require:

"ts'[OWC'Menultem' '&Time'
('Event' 'Select' '#[TS'")
('Hint' 'Display Timestamp')

The ¢ symbol is very important and distinguishes an expression to be executed
immediately, as in this case, from a callback function. The resulting Tools menu now
appears as follows:

Explorer...
Search...
Status...

~  AutoStatus

Event Viewer
Properties...
Time

A customised Tools menu

Selecting Time produces the following output in the session:

2007 12 10 17 10 2 O
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Adding your own Tool Button

This example shows how you can add a button to the session tool bar that executes
an APL function called XREF.

XREF analyses the function whose name is under the cursor, listing the names of the
other functions that it calls in a Form.

vV XREF;REFS;FN
[1] :If O<pFN<«'JSE'(OWG'CurObj’
[2] :AndIf 3=[INC FN

[3] REFS*DREFS('DSE'DWG'CurSpace'),'.',FN
[4] REFS<«(4REFS)~"" '
[5] REFS<«(3.1=[OJNC REFS)/REFS
[6] REFS<«REFS~cFN
[7] :If O<pREFS
[8] "F'OWC'Form' ('Functions called by ',FN)
[9] F.FontObj<«[JSE.FontObj
[10] 'F.L'OWC'List'REFS(0 0)(100 100)
[11] tEndIf
[12] tEndIf
\'

XREF [ 1] gets the value of the CurObj property of JSE which reports the name
under the cursor.

XREF [ 3] prefixes this name by its pathname which comes from the CurSpace
property which reports the user's current namespace.

To make this function available from a Session tool button, we need to do a number
of things. Firstly, we must install the function in JSE so that it is always there,
regardless of the current active workspace. This is easily achieved using the Explorer
or[INS.

'OSe’ [ONS 'XREF'

Next we will add a new button to the tool bar in the Tools CoolBand. Ideally we
would use a suitable bitmap, but to simplify the example, we will use a standard text
button:

)CS OSE.cbtop.bandtb3.tb
OSE.cbtop.bandtb3.tb

'xref' [OWC 'Button' 'XREF'
'xref' [WS 'Event' 'Select' '¢[SE.XREF'

Tool P g i= XREF

Adding a tool button

All that remains is to save the new Session.
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User Commands

Dyalog APL includes a mechanism to define User Commands.

User commands are developer tools, written in APL, which can be executed without
having to explicitly copy code into your workspace and/or save it in every
workspace in which you want to use it.

A User Command is a name prefixed by a closing square bracket, which may be
niladic or take an argument. A User Command executes APL code that is typically
stored somewhere outside the current active workspace.

By default, the existing SPICE command processor is hooked up to the user
command mechanism, and a number of new SPICE commands have been added. For
example:

ldisplay 'hello' (5'world")

g
hello| ‘w
o

£ 0 ~—9

-€

The implementation of User Commands is very simple: Ifa line of input begins with
a closing square bracket (]), and there exists a function by the name [JSE . UCMD,
then the interpreter will call that function, passing the input line (without the
bracket) as the right argument.

To add a user command, drop a new Spice command file in the folder SALT\Spice.
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File Explorer Integration
Unicode Edition Only

You can browse the contents of workspaces and Dyalog script files using the
preview pane of Windows File Explorer. The following example show what you see
in the preview pane when you select the supplied workspace ddb . dws.

B B - | C:\Program Files\Dyalog\Dyalog APL-64 15.0 Unicode\ws

File Home Share View
« © 4 || > ThisPC > OS(C) » ProgramFiles » Dyalog » Dyalog APL-6415.0 Unicode > ws
Dyalog A MName ~ Narme Description
[Fns/Ops]
Dyalog APL-64 14.1 BB aplsenvicedws arg] Bxamples 4404 char
Dyalog APL-6415.0 b hnid.d adb ReadMe 20184 char
areehmd.ans RefCard 3031 char
aplfmt & arachnid.ico seipts b Nemespace
apltrans 5 atfin.dws disp
Base @) avu.dws display
&) bubbles.bmp import
help
B buildse.dws scripts Namespace
PublicCACerts B coledus rest
SALT S caleuttr.wmf time
Semples 8 corsbmp
Setup [&] ch2.avi
Syncfusion S conga.dws
TestCertificates 5 cpro.dws
e B deomreg.dws
i B db.dws
! B dfns.dws
ofsrc B display.dws .
UnicodelME ¥ i < 3 ¢

36items  1item selected 267 KB

~ &

Size
2711Kb
39.52Kb
6.023Kb
63.91Kb
15.72Kb
7.039Kb
14.37Kb
33.62Kb
13.27Kb
4.352Kb

Search ws

Modified on

17/03/2005 1%:04
12/03/2005 12:22
18/01/2008 16:40

04/05/2005 10:37
02/11/2001 18:24

(]
ry

Modified by

Dyaleg
Dyaleg
Dyaleg

Dyalog
Dyadic

When you move the cursor to the next workspace in the list, dfns . dws, the preview
pane is immediately updated to show its contents.

C:\Program Files\Dyalog\Dyalog APL-64 15.0 Unicode\ws

v
« » ThisPC > 0S(C:) » Program Files » Dyalog » Dyalog APL-6415.0 Unicode » ws
Dyalog A MName ~ Name
[Fns/Ops]
Dyalog APL-64 14.1 B aplservice.dws notes Ehtﬂ‘ﬁsky
u
Dyalog APL-6415.0 B arachnid.dws scripts NormRand
aplfmt sk arachnid.ico UndoRedo
apltrans 1 atfin.dws X
Base @ avu.dws K
help 5] bubblesbmp acc
B buildse.dws adic
PublicCACerts B colcd st
cole.dws
SALT S caleuttr.wmf alrem
Samples & carsbmp a:’ﬂl‘“
Setup 2] ch2avi ave
alvals
Syncfusion £ congadws i
TestCertificates B cpro.dws and
- [ deomreg.dws apportion
5 ddb.dws ary
b B dfns.dws ascan
wsre B display.dws v ascana
UnicodellE ¥ i P

56items  1item selected 4.88 MB

~ O

Description

Search ws

Size
1.875Kb
5.367Kb
1.984Kb
4.977Kb
4.289Kb

1.23Kb

2422Kb

r

Modified on ~
16/06/2015 14:07
07/10/2015 15:53
28/07/201415:15
20/05/2014 16:44
21/02/2013 11:13
20/05/2014 16:38
16/05/2005 11:35
29/06/2010 08:54
26/08/2005 16:19
26/08/2005 16:29
26/08/2005 16:22
26/08/2005 16:20
26/08/2005 16:23
29/11/2009 13:29
31/10/2009 09:18
16/06/2015 14:11
06/08/2014 11:39
22/05/2013 08:20
22/05/2013 08:20

>

v
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If you open the Fns/Ops node and click on a function name, the function is
displayed. The next picture shows the function assign.

B B - | C:\Program Files\Dyalog\Dyalog APL-64 15.0 Unicode\ws

File Home Share View - @
« © 4 | > ThisPC > 0S(C:) » ProgramFiles > Dyalog » Dyalog APL-64 150 Unicode > ws v & | serchws £
Dyalog A Name . A v [Fns/Ops] ~ assign={OML~1 a kA
fk
Dyalog APL-6414.1 5 aplservice.dws e stepO—{step! (&l \bpu)tw} aw
Dyalog APL-64 15.0 hnid,ch g
B erechrid dus e stept-{step2t{+u)-L/u} B
aplfmt % arachnid.ico alext
apltrans 15 atfin.dws “:'E’” step2={ Ak
alrems stars+{ 6 »
Base B avudes alval ~lewta e
help 5 bubblesbmg alvals next-e\eku o
B buildse.dws ambiv mask—(rows next)vcols next s
PublicCACerts 5 coteus nd , {avnext)v wsmask s
SALT i A
] coleuitramt apportion zeros+{w+0 stars wju=0 o
Samples & carsbmp a stepd w zeros a v
Setup ch2avi :ZE::E }
Syncfusion S conga.dws pr— .
TestCertificates B cpro.dus at A
e S deomreg.dws attrib a e
b BB ddb.dws avl : .
! B dfns.dws ‘:"Y
ofsic B display.cws . b:?:& .
= PR A .
UnicadelME vl 5 o 9 G >

36items  1item selected 4.88 MB

You can also browse Dyalog script files. The following picture shows what you see
when you select the fileUtils.dyalog file.

| § B - | C:\Program Files\Dyalog\Dyalog APL-64 15.0 Unicode\SALT\tooks\code

File Home Share View - @
« © A ||« OS(C) > ProgramFiles » Dyalog > Dyalog APL-6415.0 Unicode > SALT > tools > code v & | Searchcode »
Dyalog APL-64 141 A Name - :Namespace fileUtils A V1.08 ~
n This namespace contains various file uiilities. Some requik
Dyalog APL-6415.0 | A+SF.dyalog R 2015 05 19 Adam: dywfté domain note, replExpr properly retw
aplfmt (3 apUtils.ciyal n 2015 06 22 Adam: Fixed confusing comment fypo
| aplutitsylog R 2015 10 31 DanB: filesIn was returning more files than nec®
apltrans _| bigstring.dyalog n 2015 12 13 DanB: changed dywtss to FileTStoQTs
Base 7 callingTree.dyalog
7 codecov.dyalo: i -
el yalog Oio+Oml+1
PublicCACerts 3 compare.dyalog BigEndian=-/53 [dr 256
| fileUtils.dyalog
SALT 7 lstsUtils.dyalog [o] ¥ Chars+ReadFile nameinidisignature;nums;szib
core A iUttt [1] A Read ANSI or Unicode character File
ﬂ’"“‘ tils.dyalog [21 sz+[INSIZE nid-name ONTIE 0O
lib 7] partScan.dyslog [3] signature~[JNREAD nid 83 3 0
spice ] Regex.dyalog [&] :IF signature="17 "69 “65 A UTF-&7
) ettt ayal [5] nums~{INREAD nid 83 sz
study i textltils.dyalog L6l Chars+'UTF-B'0UCS 256lnums A Signed ints
tools ] Windows.dyalog [7] tElself v/b-(2tsi ure)a.=2 2p71 "2 "2 R Unicode (UTw
[al ~{.6(2,% w)pu}¥(4/b)ONREAD nid 83 sz 2
code ol Chars='UTF-1¢ '0UCS(2%16) 1163 ODR C
deta [10] :Else n ANST or UTF-8
[11] Chars+{11::0UCS w ¢ 'UTF-8'0UCS w}256I0NREAD nid 8w
Inet [12] +EndIf v
Foad P
special vl 3

13items  1item selected 20.6 KB

Note that you may only view workspace objects and scripts in the preview pane, it is
not possible to edit them in the preview pane.
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Editing Dyalog Scripts

You may edit a script file from File Explorer by first selecting the script file and then
choosing Edit from the File Explorer context menu.

\Program Files\Dyslog\Dyalog APL-64

Home  Share  View

e v [« tools > code v o

Search code »
Dyalog A Name .
Dyalag APL-64 141 Unicode

7 A+SF.dyalog
Dyalog APL-64 15.0 Unicode.

7 aplUtils.dyalog

aplfmt 7 bigstring dyalog
apltrans 7 callingTree.dyalog
Base 7 codecov.dyalog
help ij‘ compare.dyalog
| ileUtil.dyalog

€= [l listsUtils.dyalog
E ) miscUtits.cyalog
= > | partScan.dyalog
CRESHA > [ Regecdyaiog

Scan with Windows Defender... [l textUtils.dyalog

Convert with FLV Converter [ Windows.dyaleg

123 Play with FLV Player
Open with.
¥ Norton Intemet Security >
# TortoiseSVN >
Restore previous versions
Send to >
Cut
Copy
Create shorteut.
G Delete
% Rename

Properties

g

v >
T3items 1 item selected 20.5KE [E=

This brings up the standard Dyalog Editor, in a stand-alone window, just as it would
appear ifundocked from the Session, as shown in the next picture.

File Edit Syntax Refactor View

= A A Q[search. .. T s ®Eaalt e

- #. [Nemespace].C
[Dfns]
[Methods]

:Namespace fileUtils A Vi.08

~
This namespace contains varfous file utilities. Some reguire .Net.
2015 05 19 Adam:

a
a
R 2015 08 22 Adam:
n
a

2015 10 31 DanB: filesIn was returning more files than necessary and removed folders from resulf
2015 12 13 DanB: changed dywtss to FileTStoQTS

Oio-Oml-1

dywFEt domain note, replExpr properly returns number of changes (nof files), fileRename »
Fixed confusing comment typo

BigEndian—/83 Odr 256

ol v Chars=ReadFile name;nidssignaturesnumsiszib
[t1 & Read ANSI or Unicode character file

[2] sz+INSIZE nidename ONTIE 0

[3] signature-[INREAD nid 83 3 0

[+1 +If signature=—17 ~69 ~65 A UTF-87

(51 nums=NREAD nid 83 sz

6] c

=+'UTF-8'0UCS 256|nums A Signed ints

(71 :ElseIf v/b=(2tsignature}a.=2 2p71 ~2 "2 A Unicode (UTF-16)

(5] s={.9(2, w)pw}¥(~/6)ONREAD nid 83 sz 2

91 Chars+'UTF-16'0UCS(2%16) 163 DR C

[10] :Else & ANSI or UTF-8

[11] Chars={11::0U€S w o 'UTF-8'0UCS w}256I0NREAD nid 83 sz O

[12] :EndIf

[13] ONUNTIE nid

[1%] v

o1 v {format}WriteFile(name chars);nid;signature;nums;typ

(11 R Write ANSI or Unicode character file

(2] 8 format = ANSI, UTF-8 or UTF-16

[31 DOSIGNAL(=10|typ~[DR chars)/=('EN' 11)('Message' 'Does not work in Classic APL')

(41 :If 0=[NC'format’

(51 format='ANSI' 'ANSI' 'UTF-16'2%80 82ityp

(61 :Else

(71 formate'ANSL' 'UTF-8' 'UTF-16' "UTF-8' 'UTF-16' '?'>%'ANSI' 'UTFB' 'UTF16' 'UTF-8' 'UTF-16'tefor

(51 OSIGNAL(format='2')/c("'EN' 11)('Message’ ‘Invalid file translation format')

(o1 +EndIf

[10] :Trap 22

[11] nid+name ONCREATE 0 v
< 2| € >
Namespace

Pos: 0/430,0
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Index

NET Classes
exploring 90

A

ActiveXControl object 63
aedit User Command 35
AfterFix 177
aligning comments 127
APL fonts 183
Array Editor 35,58
assemblies

exploring 90
auto_pw parameter 28
AutoComplete 26

B
Browse .NET Assembly dialog box 91

C

chart wizard 58
class constructor 94
Classes
browsing 74
Classic Dyalog mode 146
multiple trace windows 155
single trace window 156
Classic Edition 43,61
ClassicMode parameter 112
ClassicModeSavePosition parameter 112
CloseAll system operation 44
collapsing outlines 124,129, 134
compiler errors 124
configuring the session 182

Constructors folder 94

context menu 24

Create (session event) 172
CurObj (session property) 5,173
CurPos (session property) 173
Current Object 5

CurSpace (session property) 173

D

Debugging Threads 161
default wx parameter 49
deleting lines 25
Docking 19

E

edit_cols parameter 109,112
edit_first x parameter 109,112
edit_first y parameter 109,112
edit offset x parameter 109,112
edit offset y parameter 109,112
edit_rows parameter 109, 112
editor

class treeview 124,135

collapsing outlines 124

compiler errors 124

edit menu 119

editing classes 133

expanding outlines 124

filemenu 116

function line numbers 124

invoking 107

outlining 124,128

refactor menu 123

sections 136

selecting text 113

syntax menu 121

toolbar 114

using 125

view menu 123

windows menu 122
Editor

aligning comments 127
endsection statement 130, 136
Enums 89
Event (session property) 174
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Event Sets 88
Events

AfterFix 177

Fix 178

Format 179

SessionPrint 180

WorkspaceLoaded 181
executing expressions 27
execution (tracing) 153
expanding outlines 124,129, 134

F

File (session property) 174
file explorer integration 188
find and replace dialogs 139
Find Objects Tool 98

Fix 178

Font (session property) 174
Format 179

function line numbers 124

H

Handle (session property) 173
HintObj (session property) 174

I

ILDASM 90

IME Configuration 7

Input (session property) 173
input codes 12

input line 25

interrupt 6

K

keyboard shortcuts 2,10

L

language bar 26
line numbers 124-125
Log (session property) 173

M

Metadata 90,92
Methods folder 96
mouse

using in session 4

N

NET classes 90
Net Metadata 79
New method 94

(0]

Object CoClasses 83
Object Properties
COM Properties tab 105
Monitor tab 104
Net Properties tab 106
Properties tab 102
Value tab 103
Objects 85
OLEClient object 79, 82
OLEServer object 63
outlining 124,128

P

page width 28

Popup (session property) 174
Posn (session property) 174
private 94

Properties folder 95
PropertyExposeRoot parameter 49
PropertyExposeSE parameter 49

S

section statement 130, 136
selecting text 113
session
configuring 3,182
deleting lines 25
file menu 39
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help menu 51

options menu 48

popup menu 53

session menu 45

status bar 61

status field styles 61

threads menu 50

tools menu 49

value tips 29
session action menu 46
session colour scheme 16
session log 18,25
session log menu 46
session menubar 39

action menu 46

edit menu 42

file Menu 39

help menu 51

log menu 46

options menu 48

session menu 45

threads menu 50

tools menu 49

view menu 44

windows menu 44
session object 3, 18,45
session statusfields 62
session toolbars 56

edit tools 59

object tools 58

session tools 60

tools tools 59

workspace tools 57
session_file parameter 4, 18,172
SessionOnTop parameter 112
SessionPrint 172, 180
Show trace stack on error 145
Size (session property) 174
SPICE 187
State (session property) 175
Status window 19, 63
system operations 4,45, 184

T

Threads Tool 157
TipObj (session property) 175

trace tools 148
Trace on_error parameter 145
tracer
automatic trace 145
break-points 154
Classic Dyalog mode 146
controlling execution 153
invoking 145
naked trace 145
tracing an expression 145
treeview 124,135
Type Libraries 71,79

U

underscored characters 10

Unicode Edition 61

User Commands 187
aedit 35

v

value tips 29

view menu
editor 123
session) 44

Visual Styles 56

W

white space 127
WorkspaceLoaded 172,181
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